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Introduction 

Cityworks Designer is the software program used to configure Cityworks for an organization. Extensive 
customization allows the organization to integrate Cityworks into the organization’s usual workflow process. 

The administrative roles of Cityworks generally fall into two categories—establishing and maintaining the 

Cityworks database structure (Cityworks database administrator) and overseeing Cityworks, including 
configuring the Cityworks database (Cityworks domain administrator).  

Preliminary setup is performed by the Cityworks database administrator and consists of creating the database 

and setting up the security and ODBC connection. Cityworks Database Manager is used to build the Cityworks 
database structure and update the database for new versions of Cityworks.  

Once the preliminary setup is complete, the Cityworks database administrator uses the Cityworks Designer 

application to set up the domains and domain administrators. The remaining setup is completed by these 
Cityworks domain administrators. The Cityworks Designer Guide details the use of Cityworks Designer and 

the Cityworks Data Template to configure and customize Cityworks for the organization.  

One person can serve as both a database administrator and domain administrator. In this case, the login 
gives them full access to all Designer functions, except for the Storeroom functions which must be accessed 

as a domain administrator. However, this login cannot be a Cityworks user because all Cityworks users must 

belong to a user group. Once the login is placed into a group, the superuser can no longer serve as the 
Cityworks database administrator.  

Layout Manager, accessed directly in Cityworks and used to customize the Cityworks forms, is also 

discussed in this guide since it is only available to Cityworks domain administrators as well as information on 
customizing print or email templates.  

The Cityworks domain administrator plays an integral role in the success of Cityworks as an asset 

management solution (AMS) for each domain. Taking the time up front to set up the full functionality of the 
software enables the users to quickly and efficiently use the software to benefit the organization in tracking 

their calls, assets, and the work done. 

Designer Functions 

The functions displayed in Cityworks Designer are specific to the user and are determined by the login. All 

available functions for the login are listed in the directory on the left pane. If a function is not listed, it is not 

available for the login or must be accessed by some additional selections. For example, Asset Setup 
functions are only available when connected to the geodatabase.  

Because Cityworks is customizable, many of the functions have lists that are set up in other windows. This 

may require moving from one function to another to populate the desired fields. Tips for moving between 
functions are added for your convenience.  

The functions are discussed in this manual in the order they are listed in the directory found on the left pane 

of Designer. A different order may be used for adding the information depending on how the organization is 
setting up Cityworks. Many of the functions rely on Codes and Preferences which are found under the 

Others category which is listed last in the directory. Moving between functions is facilitated by the directory 

always being visible and, once a group is opened, requires only a click to open any of the listed functions. 
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Only one function, Employees, may be accessed by both Cityworks database administrators and Cityworks 

domain administrators. Employee groups serve two functions in Cityworks: first, to set security, and second, 
to group employees into common classifications, such as by crew, job title, labor rates, etc. Employees may 

be set up by the Cityworks database administrator (under Administration > Employees) or by the 
Cityworks domain administrator(s) (under Cityworks Setup > Employees).  

Using Designer for the First Time 

Logins must be set up for the Cityworks database administrator, Cityworks domain administrators, and any 
desired superusers (logins with access to both functions). The user accounts, including logins and passwords, 

are set up with the database, not in Designer.  

NOTE: Cityworks superusers cannot be a member of any domain group and cannot use the end software. 
End users must belong to a group with specified rights. 

To use Designer the first time, it must be accessed by logging in as azteca. Using this login, the 

administrator defines the domains and one or more domain administrators for each domain.  

IMPORTANT: Once domains are set up, the Cityworks domain administrator must go in to Others > 
Preferences and click Save to activate the preference for using ArcGIS as the data model. This option, Use 
ArcGIS Data Model, is #21 in the list. By default, the value is set to Y.  

 

1. Open Designer.exe from the file location or desktop shortcut. The default location is: C:\Program 
Files\Cityworks\Designer.exe.  

2. When the Cityworks login screen opens, select the Cityworks Database from the dropdown list.  

 

NOTE: Click on the Version Information link to view the version of Designer that you’re running.  
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3. Enter azteca for the User ID and the assigned Password (systems is the default password). 

NOTE: The logins and passwords for Cityworks database administrators are defined in the RDBMS. 

4. If desired, select the Save Password and/or Access Geodatabase checkboxes. For more information 
on the Access Geodatabase option, see Geodatabase Tool.   

NOTE: To access the Asset Setup functions, the Access Geodatabase box must be checked. Accessing 
the geodatabase requires an Esri license. The rest of the configuration can be done without accessing the 
geodatabase. 

5. Click OK. 

Basic Functionality 

Because many windows have the same functionality, this section explains the main features found in 
Designer. Detailed explanations of each function are found in the subsequent sections.  

The title bar lists these items separated by hyphens. 

 Name of the program (Cityworks Designer) 

 Name of the current database to which Designer is connected 

 Login of the current user (User ID) 

 Active Designer function 

If connected to the geodatabase, the title bar also lists the geodatabase and Esri license type in parenthesis. 

  

Tools 

There are three main tools on the Designer toolbar: Login, the Geodatabase tool and Exit.  

Login  

The Login tool opens the Cityworks login screen for selecting another database or logging in as another 
user.  

NOTE: Clicking Login cannot be cancelled. The user must log in again, even if the same login is used.  
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Geodatabase Tool 

The text displayed depends on if you’re currently connected to the geodatabase (Disconnect GeoDB) or not 

connected (Connect GeoDB).  

 Disconnect GeoDB—Click to disconnect from the geodatabase and work in standalone mode. 

This allows you to set up the Cityworks database without an Esri license. All of the functionality is 
available except for Asset Setup.  

 

 Connect GeoDB—Click to connect to the geodatabase. Designer confirms that you have an 

ArcGIS license available for your login and activates the Asset Setup functionality.  

 

NOTE: When you log in to Designer, you can check the Access Geodatabase checkbox to automatically 
connect to the geodatabase.  

Exit 

Click Exit to close Designer.  

Cityworks Designer Menu 

Click on the Designer icon or use the shortcut <Alt + space bar> to open the menu with options for moving, 

sizing, minimizing, maximizing, and closing.  

NOTE: Because Close is the active menu function by default, double-clicking on the icon closes Designer. 
Buttons for minimizing and maximizing are also located in the upper right corner of the title bar. 
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Navigation Tree 

Designer functions are listed in folders on the left side of the window. Click on the plus sign to display the 
contents of the folder. To access a function, either click on it in the panel on the left or double-click on the 

icon in the panel on the right. The function opens in the right-side panel.  

To change the way the icons are displayed, right-click in the panel on the right and select the desired view. 
View Large Icons is the default setting shown below.  

 

The name of the function that you are currently viewing is displayed in three locations: the title bar, the blue 
header at the top of the function panel, and in the hierarchy on the left. Note that a wrench icon also appears 

next to the function in the hierarchy on the left.  

 

NOTE: Active tabs, buttons, and columns are shown with orange highlighting. 
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The navigation tree can be collapsed to view more of the current function by clicking on the white arrow 

located in the center of the left margin. To restore the tree, click the white arrow again.  

 

Buttons 

Windows may contain multiple panels and/or tabs. The Save button saves all the information found on the 

panel or window to the database. The Clear button clears the fields so new information can be added. The 
Add button adds the item to the list box in the window and to the database. Most items in list boxes can be 

clicked on to reload the information back into the fields for editing. Add and Remove buttons may also 
appear in certain panels for features like Comments, Keywords, or Attachments. The Refresh button 

updates the information.  

 

The Delete button deletes any selected item(s) from the database. You are always asked to confirm before 

an item is deleted so that it is not accidently removed from the database.  

Some items, like work order templates or service request templates, can have historical data connected to 
them, so Azteca Systems Inc. does not recommend deleting them. Instead, we recommend that it be 

inactivated so that the historical data remains intact. For more information, see Inactive or Cancelled 
Information.  

The Remove button usually removes a relationship linking data together, rather than deleting the 

information. Usually there is no confirmation when removing information.  

When a set of arrows is found between two lists, each item is listed only once, on one side or the other. 
Select the desired item(s) from the list on the left to move the item(s) to the list on the right by clicking the 

right arrow. Use the left arrow to remove items. Double-clicking a single item also moves it to the other list. 

All items listed on the right are assigned in the database.  
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Keywords 

 Type in a keyword and click the Add button in the Keywords pane to add it to the list and save it in the 

database.  

NOTE: Spaces are not allowed in the keyword field, but an underscore may be used to connect words if 
desired.  

Multiple Selections 

Multiple selections may be made using either <Shift + click> or <Ctrl + click>. 

Resizing 

 Double-click on the column header to expand the column to the width of the longest field. You can also 
adjust the column width by clicking on the right margin of the column and dragging to the desired width.  

 

Panels can also be resized by clicking on the top, bottom, left, or right margin and dragging the margin to the 

desired location.  

Sorting 

 Lists are generally ordered alphabetically. To sort the list by a column, click on the column header. 

NOTE: Numbers are sorted as text, so numbers are listed beginning with 1s, then 2s, 3s, etc.  
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Date Fields 

Click in any date field to open the calendar. Click on the desired date and click Select to load the field.  

 

TIP: To return to today’s date, click on the Today: <month/day/year> at the bottom of the calendar. To 
view the entire year, click the maximize button or double-click on the title bar.  

Tabbing Sequence 

The tabbing sequence for all windows flows from left to right, then top to bottom, from control to control. 

Use the Tab key in conjunction with the arrow keys to navigate through the window. Pressing <Shift + 

Tab> reverses the direction of the tab. Once the tabbing has gone through all the functions on the window, 
it disappears for one Tab before moving to the Login button and down to the selected function before 

returning to the window to start over again.  

When on a tab, pressing the right arrow key moves to the next tab and pressing the left arrow key moves 
back through the tabs. If there is a divider, as on a Hierarchy tab, it stops there and the arrow keys move it 

to the right or left.  

NOTE: See Field Value Tables for more information on moving within a list. 

Field Value Tables 

Some windows have a table with a column for Field (or Element) and Value. These tables are found in the 

following locations.   

 Administration > Employees > Employees tab 
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 Cityworks Setup > Employees > Employees tab 

 Cityworks Setup > Request Templates > Request Template Edit form 

 Cityworks Setup > Request Templates > General Info tab 

 Cityworks Setup > Work Order Templates > General tab 

 Cityworks Setup > Contractors > Contractor Edit form in the Information and Custom 

Fields boxes 

 Cityworks Setup > Equipment > Equipment Edit form in the Custom Fields box 

 Cityworks Setup > Materials > Material Edit form in the Custom Fields box 

 Server Setup > GIS Services > Map and geocode service definitions box 

 Others > Preferences > General tab  

Type in the first letter (or up to three letters) to move to the first field in the list beginning with that letter 
combination or use the up/down arrows once a field is highlighted to move to another field. Press the space 

bar to move to the Value column for the field, type in the information, and press the Enter key to close the 
field.  

 

Some fields may already be populated with default values. When there are only a few options, click the space 
bar to toggle between the options. On yes/no fields, click the space bar to toggle between Y and N (or 

double-click in the field). Dropdown selections or selection boxes are available for populating some values.  

Define New Code 

Some dropdown lists have the option Define New Code listed alphabetically with the other options.  

 

Select this option to add a new code and description. A Codes window, similar to the one below, will open. 
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Enter the Code and Description and click Save to add the new code.  

NOTE: The code type is listed under the title bar. A Code may be 50 characters long and a Description up 
to 100 characters in length. 

These codes can also be added in Others > Codes by selecting the desired Code Types from the list on the 
left and entering the codes on the right.  
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Importing Data 

Text files can be used to download some of the required information into Designer. These are the functions, 
windows, and tabs where data can be imported. 

 Administration > Employees > Load Employees tab 

 Cityworks Setup > Employees > Load Employees tab 

 Cityworks Setup > Work Order Template Classes > Load tab 

 Others > Codes > Import Codes tab 

 Others > Customer Accounts > Import Customer Accounts tab 

 Others > Customer Accounts > Import Street Names tab 

 Others > Other System Codes > left lower pane 
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Instructions are found near the top of the tab that explain the requirements for the file, such as the number 

and type of fields that are needed. The files must be text files with the correct database field names for the 
data to be imported.  

To convert Excel files to text files, open the file in Excel and click File > Save As. Select either the Text 

(tab delimited) (*.txt) or CSV (Comma delimited) (*.csv) option and click Save.  

 

1. In Designer, double-click in the Import File field.  

2. Navigate to the desired file and double-click on it to load the path into the Import File field (or 

select and click Open). 
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3. Select an option for Delimited By:  

 Comma 

 Tab  

 Other—Specify the delimiter. A semi-colon is the default.   

4. Click the Load button to import the data into the list.  

If you get an error, check to see if there is a row of column headers at the top of the file you’re trying to 

load. Also check to see if the text is in the correct column order shown in Designer at the top of the import 
tab.  

NOTE: You can view the Import Results on the Import tab under Others > Codes. Multiple files can be 
loaded at the same time, so this allows you to see which ones imported successfully.  

5. If desired, remove any unwanted record(s) from the list by selecting them and clicking Remove.  

6. Click Save. 

Setting up Data Trees 

In a number of locations in Cityworks, information is presented in a tree structure. For example, requests, 

contractors, equipment, materials, or tasks. The trees are set up in Designer. See each section for more 
information.  

 Cityworks Setup > Request Templates 



 

14    Introduction Designer 2013 Guide 

 Cityworks Setup > Contractors 

 Cityworks Setup > Equipment 

 Cityworks Setup > Materials  

NOTE: Cityworks Storeroom administrators may also set up the materials tree in Storeroom.  

 Cityworks Setup > Tasks 

 Server Setup > Contract Line Items 

You can also use the Cityworks Data Template to add multiple items to the Cityworks tables listed below. See 
Cityworks Data Template for more information on this functionality. 

 ContractorLeaf 

 Employee 

 EquipmentLeaf 

 MaterialLeaf 

 ProblemLeaf 

 TaskLeaf 

 WOTemplate 

Hierarchy Tab 

The hierarchy is made up of three levels: trunk, category, and item. Trunks are essentially folders that 

contain categories and items. Items can be placed in a category or in a trunk.  

  

1. Click New Trunk to add trunk name(s).  

2. Type the name of the trunk. Press Enter and type the name of the next trunk. Repeat until all 
desired trunks are entered.  
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TIP: The information can be entered in any order, but they will be listed alphabetically in the hierarchy.  

3. Click OK to add the trunks to the Hierarchy.  

The next step is to add items to the trunks. If you wish to categorize the items within the trunk, first you’ll 

need to add those categories.  

4. Click on the trunk and then click Add Category.  

5. Type the name of the category. Press Enter and type the name of the next category. Repeat until all 
desired categories for this trunk are entered.  

 

6. Click OK when finished.  

7. To add an item, select either the trunk or category and click New Item. 

If you used the Cityworks Data Template to populate your database, the list on the right may already be 

populated. If this is the case, select an item or multiple items and drag them to the desired location in the 
hierarchy. 

There are two ways to search for items. The Find Items dropdown list contains two options: 
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 Find Items not in Tree: Click to view all of the items in the list on the right that have not been 

placed in the hierarchy yet. If desired, you can Print or Save the list. 

 

 Find Selected Items in Tree: Select an item (or multiple items) in the list on the right and click 

Find Selected Items in Tree to see where they are located in the hierarchy. Items can be 

placed in more than one location in the hierarchy.  

 

NOTE: If an item has not been placed in the hierarchy, the Tree Path for that item will be blank. 

IMPORTANT: Before deleting any item from the list on the right, use the Find Items > Find Selected 
Items in Tree option to see if it appears in more than one domain. This is especially important for materials 
and equipment because the same materials and equipment may be used for more than one domain. Deleting 
an item deletes it from all domains in which it is found.  

The Delete Node(s) button deletes the node and all information contained in it from the hierarchy. It does 
not delete the item from the list on the right or from the database.  
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Additional Database Information 

Some tables in Designer have hidden columns containing extra database information, like the Code element 

values that point to where Cityworks pulls items out of the element table, default values, etc. Since this 
additional information is not needed to access the basic Designer functions, the columns are hidden from 

view.  

To open the hidden columns, hover the mouse to the right of the last column header until the cursor changes 
to an arrow with a double bar. Click and drag the column open.  

 

NOTE: Hidden columns are present whenever there is an arrow with a double bar.  

Inactive or Cancelled Information 

Azteca Systems Inc. does not recommend deleting items like employees, tasks, custom field templates, or 

templates for service requests, work orders, inspections, etc., because these items are tied to historical 

information in the database. Instead, we recommend inactivating or cancelling them. Inactivated employees 
or cancelled templates will not show up in Cityworks, but they will appear grayed out in Designer.  

 To designate an employee as inactive, go to Employees and select the desired employee. Change 

the Is Active field to N.  

  

 To cancel a service request template, go to Request Templates and open the desired template. On 

the General tab, change the Cancel field to Y.  

 To cancel a work order template, go to Work Order Templates and select the desired template. 

Change the Cancel field to Y.  

 To cancel a custom field template, go to Custom Field Templates and select the desired category 

in the Existing Categories panel and click the Inactive radio button. 
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 To cancel a task, go to Tasks and open the desired task. Check the Cancel Task checkbox. 
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Administration 

 Administration functions are performed by the Cityworks database administrator to set up the database 

administrators, domains, and domain administrators. The Administration functions are Cityworks DBA, 
Cityworks Domains, Storeroom Domains, Stake Domains, Password, and Employees.  

Cityworks Administration is accessible to all Cityworks database administrators once logins have been set 

up using the Cityworks DBA function.  

NOTE: The Password function is only available for users who configure Cityworks with the encrypted 
password option.  

 

 Cityworks DBA—Set up the Cityworks database administrators and logins. 

 Cityworks Domains—Define the domains and domain administrators with their logins. Also 

assign the defined asset groups to the domains once the Cityworks domain administrator has 

populated the asset groups. Domains are used to manage security. 

 Storeroom Domains—Set up the Storeroom domains and Storeroom domain administrators 

with their logins. Only available to organizations using Storeroom.  

 Stake Domains—Set up the Stake Domains for the work order and/or service request 

descriptions. Only available to organizations using the Dig-Smart interface. 

 Password—Generate an encrypted password for each user’s real password so users cannot log 

into the Cityworks database except through Cityworks.  

NOTE: Cityworks must be configured to work with encrypted passwords for this function to be available. 

  Employees—Sets up the basic employee information, including labor rates and skill sets. 

NOTE: Employees may also be accessed by Cityworks domain administrators under Cityworks Setup.  

Some overlap occurs between Cityworks database and domain administrators. For example, employees may 
be set up either by the Cityworks database administrator in Administration > Employees or by the 

Cityworks domain administrator(s) in Cityworks Setup > Employees. All security for service requests and 

work orders is set by employee groups. In 2012.1, the group rights for work orders, service requests, and 
inspections were simplified. Please read Knowledge Base article 10619 for more information on the Group 

Rights Migration tool. These groups can also be used to add labor costs. Employee groups must be set up by 
the domain administrator in Cityworks Setup > Domain Groups.  

Cityworks DBA 

The Cityworks database administrator is responsible for setting up and maintaining the Cityworks database 
structure and creating the domains. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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Duties of the Cityworks database administrator: 

 Create the Cityworks database, user accounts, and ODBC connection. 

 Establish domains and assign a Cityworks domain administrator for each domain. 

 Assist in the installation of new versions of Cityworks, including updating the Cityworks database. 

Logins for the Cityworks database administrators are assigned on the Cityworks DBA window. 

NOTE: See Using Designer for the First Time to access Designer with the default Cityworks administrator 
login. 

1. To expand the Administration section, click the plus sign (+) next to it. 

 

2. Click on Cityworks DBA to open the Cityworks Database Administrators window.  

   

3. Enter the Login and Full Name of the Cityworks database administrator. 

 

4. Click Save to add it to the list below and the database.  

5. Repeat these steps to add any other Cityworks database administrators. 

NOTE: Once the Cityworks domain administrators are set up, Azteca Systems Inc. recommends changing the 
password for the azteca login in the RDBMS to secure the system.  

Cityworks Domains 

Cityworks may consist of a single domain or multiple domains—it depends on how your organization wants to 
organize security and access to information. A domain is a distinct group with shared work activities and 

resources. Each domain acts as a filter with its own request templates, work order templates, and employees.  
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An employee can only belong to one domain. The Cityworks database administrator may administer in 

multiple domains as long as they are not added as employees to any domain. All Cityworks domain 
administrators assigned to a specific domain can make changes to the configuration settings for that domain 

only. They can also edit service requests and work orders, even after they have been closed. 

NOTE: If you are using Storeroom, materials may be separated by Storeroom domains. Users only see the 
quantity and costs of materials on the work order Material panel for storerooms they have permission to 
access. 

When multiple departments are involved in performing specific tasks on a work order (e.g., a street 
department that repaves after a water main is repaired), these departments may belong to the same domain 

or security settings can be used to give access to the other domain. The other Cityworks domain 

administrator may have permission to edit the full work order template or only certain tasks and/or costs. 
Access to a single work order may also be set on the work order but if this is a common occurrence, it should 

be done at the template level. Costs from another domain can be added to a work order if permission is 
given.  

TIP: Many organizations with interdepartmental users choose to use one domain to share information and 
limit access through the security functions.  

Call takers in a central call center may be set up to access more than one domain. In this case, the Submit 
To or Dispatch To employee can be set in the request template in Designer. While a user may access 

request codes for another domain and create a service request, the request Submit To or Dispatch To 
employees are accessible only to members of the same domain.  

Once Cityworks domain administrators have been added, they set up the asset groups. Since asset groups 

may belong to multiple domains, the Cityworks database administrator is responsible for assigning the asset 

groups. 

Material and equipment are shared by domains; however, each domain sets up their own material and 

equipment hierarchies. Use the Current Domain dropdown at the top of the hierarchy to switch to a 

different domain. Storeroom also allows the domain to be switched, but users only see the storerooms that 
they have permission to view.  

 

1. Log in to Designer as the Cityworks database administrator and click on Cityworks Domains.  

2. Type in the Name and Description for the domain at the top of the panel and click Save.  
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NOTE: If you’re using Server and want to use districts, check the applicable District checkboxes for the 
domain. Districts can represent any geographical area desired—for example, when several organizations are 
responsible for providing different services based on city, county, or other boundaries. Districts are populated 
by the domain administrator under Others > Codes > ADISTRICT.  

3.  Type in the Login and Full Name of the Domain Administrators in the center panel and click 

Add. 

4. Once the domain groups have been set up, they will display on the left in the Domain Asset 
Groups panel. Select the desired Asset Groups for this domain and click the right arrow to move 

them to the list on the right. 

NOTE: A domain administrator will need to set up the asset groups. See Asset Group Definitions for 
information on setting up the asset groups. The database administrator may also be able to set up the asset 
groups if he/she is a superuser.  

 

TIP: Double-clicking on a single item in either list moves it to the other list. 
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Domain Administrator Role 

 Cityworks domain administrators are in charge of configuring and customizing Cityworks for use in their 

domain. 

Duties of the Cityworks domain administrator: 

 Select the asset groups and related GIS layers for the domain. 

 Establish employee groups and assign security. 

 Set up tree structures and keywords for requests, contractors, equipment, materials, and tasks. 

 Create request templates with a series of questions and answers and other relevant information. 

 Create work order templates and tasks. 

 Define custom fields. 

 Populate tables with attributes for employees, contractors, materials, and equipment.  

 Define valid values for selection boxes and dropdown lists. 

 Link geodatabase fields to Cityworks fields (field mapping) to automatically populate asset 

attributes on Cityworks inspection/test forms. 

 Customize form layouts, printing templates, and reports. 

The Cityworks domain administrator functions consist of these groups. The Storeroom function is listed only 

for logins of Storeroom domain administrators. It is not accessible to superusers who oversee more than one 
domain. 
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 Cityworks Setup—Allows customization of the request, work order, and inspection templates 

along with lists of employees, contractors, equipment, materials, tasks, and permits. See 

Cityworks Setup for more information.  
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 Asset Setup—Works with the asset information and mapping functions. See Asset Setup for 

more information.  

 Storeroom—Defines the Storeroom domain groups to allow permission for employees to 

perform the storeroom transactions. See Storeroom for more information.  

 Server Setup—Contains the settings used in Cityworks Server AMS. Server Setup is only 

displayed when there are valid Server tables in the database. See Server Setup for more 

information.  

 Others—Performs miscellaneous functions, including preferences. See Others for more 

information.  

Storeroom Domains 

The Storeroom Domains function is for organizations using the Storeroom application to manage materials. 
This function sets up the Storeroom domain names, descriptions, administrators, and storerooms. 

Once a storeroom domain has been defined, Cityworks assumes that the Storeroom application has been 

installed, licensed, and is being used. This requires that all materials have been assigned to a storeroom and 
populated with the stock-on-hand. In addition, transaction permissions must be set for each storeroom. 

1. Click on Storeroom Domains.  
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2. Enter the Name and Description for the Storeroom domain at the top and click Save.  

3. Repeat the previous step for all desired domains.  

4. Select the desired domain from the list on the top right panel to activate the middle panel. 

5. Enter the Login and Full Name of each Storeroom Domain Administrator in the middle panel and 
click Add. 

IMPORTANT: A login name can only be assigned to one domain.  

6. Repeat these steps to assign domain administrators for each domain.  

7. Click the Create new storeroom location button (magnifying glass icon) to open the STORERM 

Codes box.  

 

8. Enter the Code and Description for the storeroom and click Save.  

9. Repeat this step to add all desired codes. When done, close this window.  

NOTE: Storeroom codes may also be set up by the Cityworks domain administrator under Others > Codes 
> Others category > STORERM. 

10. In the main Designer window, assign the storerooms to the domain by selecting them from the list 

on the left and clicking the right arrow to move them to the Assigned Storerooms list on the right. 
You can also double-click on a single item in either list to move it to the other list. 

TIP: While a storeroom may belong to more than one domain, not many organizations choose to have 
multiple domains run the same storeroom(s).  

TIP: Double-clicking on a single item in either list moves it to the other list. 
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11. Repeat the previous step to add all of the storerooms to the desired domain.  

Dig-Smart Stake Domains 

 Stake Domains is for organizations that use the Dig-Smart interface for marking utility lines prior to 

digging. Dig-Smart is a GIS-centric application that interfaces with ArcMap.  

NOTE: See Dig-Smart in Glossary of Terms for more information on this application. 

A ticket created in Dig-Smart can be set up to automatically generate a request or work order. These steps 
must be taken to set up Dig-Smart. 

 Under Custom Field Templates, create a work order and/or service request with a Category 

named DigSmart that contains these exact fields:  

o DS_TICKETID 

o DS_STARTDATETIME 

o DS_CONTACT 

o DS_COMPANY 

NOTE: See Custom Field Templates for details on how to create these fields. 

 Create a DigSmart request and/or work order template and apply the custom field template to 

each domain that handles Dig-Smart requests and/or work orders. 

IMPORTANT: A Dig-Smart template must be defined as a service request or work order before proceeding 
with these steps. See either Request Templates or Work Order Templates for instructions on how to set up 
the desired Dig-Smart template. 

1. Click on Stake Domains under Administration.  

2. Select the Cityworks Domain from the dropdown.  

3. Select the radio button option for Work Order or Service Request to list the associated templates. 

4. Select the desired Template on the left. 

5. Select the Initiated By employee from the list on the right. 

6. Click the Save button to save the information to the database and list the information in the lower 

pane. 
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To delete a Stake Domain from the database, select the Initiated By employee from the list on the lower 

pane and click the Delete button. 

Password 

The password option is for organizations using the encrypted password function. Follow the instructions for 

Adding Password to Designer if Password is not listed under Administration in Designer.  

Adding Password to Designer 

If the Password option is not listed under Administration, Cityworks has been installed without the 
encrypted password option. It may be added by changing the ConfigureCityworks.xml file which 

populates the registry keys read during the login process.  

1. Open Windows Explorer and navigate to the ConfigureCityworks.xml in the Cityworks folder. 
The default location is: C:\Program Files\Cityworks\ConfigureCityworks.xml. 
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2. Right-click on it and select Edit. 

 

3. Change the false between <Proxy> to true, save, and close the file.  

NOTE: The SavePassword option above the proxy setting allows the user to save the password on the 
login screen if set to true.  

4. Select All Programs > Cityworks > Configuration > Configure Cityworks from the Start 

menu. Or if Windows Explorer is still open, click on ConfigureCityworks.exe, immediately above 
the ConfigureCityworks.xml file in the Cityworks folder to configure Cityworks.  

 

NOTE: Nothing opens on the user interface and this takes just a few seconds to complete. 

5. Click Login from the Designer toolbar and log in again to refresh the software and activate 

Password.  

Encrypting a Password 

The Password function sets up the link for encrypted password so users are unable to log into the database, 

except through the Cityworks application, and thus protects against unauthorized use. The Cityworks 
database administrator should maintain the list of the logins with their real and encrypted passwords.  

IMPORTANT: Encrypted passwords should never be disclosed or distributed. 

1. Click on Password.  
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2. Type the user’s database login into the DB Login field. 

 

3. Type the user’s assigned password into the Real Password field which generates the Encrypted 

Password as the Real Password is typed in.  

NOTE: Because the software links the real and encrypted passwords, typing in the real password always 
generates the same encrypted password. 

4. Make a record of the user login and both passwords. 

5. Click the Clear button to enter the next Cityworks user. 

6. Follow steps 2-5 to generate a list of logins and passwords for all Cityworks users. 

7. Enter the Encrypted Password for each user’s login when creating the user in the database 
system.  

8. Give the user the login and real password to use when logging in to Cityworks.  

Employees 

The Employees function is the only one that may be accessed as a Cityworks database administrator or a 
Cityworks domain administrator. It is the same in either location, except that custom fields, employee skill 

sets, and dynamic cost codes must be set up by the domain administrator. Once set up, these fields may be 
populated from either location. If desired, employee records may also be created for departments and 

contractors. A single employee may belong to multiple domains as long as the login is different for each 

domain.  
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The Groups in the Domain Groups list is set up by the Cityworks domain administrator in Domain 

Groups. Once employees have been added, they may be quickly added to groups using the Domain 
Groups function. A single employee may also be added to all the groups to which he/she belongs on the 

Employees tab by checking the box in front of all applicable groups.  

NOTE: If employees are added using the Cityworks Data Template EmployeeLeaf, the employees must still 
be assigned to the applicable group(s). 

Many details about the employees can be listed on the tabs and others can be tracked using custom fields. 

The tabs most frequently needed are on the left and those that are accessed mostly during the initial setup 
have been placed on the right.  

Employees Tab 

The Employees tab contains most of the employee’s information, including phone numbers, email, job title, 

groups, custom fields, and various pay rates for overtime, holiday, etc. Existing information can easily be 
updated here by making the change(s) and clicking the Save button. 

Rates are used to add labor costs to service requests and work orders. They can also be used in searches and 

reports. To maintain privacy, rates may also be set up by group type and view permissions may be restricted. 
In addition to the rates listed, specialized rate types are available. Cost codes are customized rates as defined 

by the organization. Job codes, which pay employees a certain rate according to the job type, can override 
the cost codes. These dynamic rates are set up on the Cost Codes or Job Codes tab found on the Codes 

window under Others.  

NOTE: See the sections in on Cost Codes Tab and Job Codes Tab for information on setting up customized 
rates. 
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1. Look over the fields listed in the Field Value table to see if any other information is tracked by the 
organization.  

NOTE: You can add any additional fields desired in Custom Data Fields under Others. See Custom Data 
Fields for detailed information. 
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2. Add employee information by one of the following three methods. 

 If an employee list already exists, switch to the Load Employees tab and follow the instructions 

listed there. See Importing Data or Load Employees Tab for more information.  

 

 If no employee list exists, use the Microsoft Excel CityworksDataTemplate.xls to type in the 

employee information (or export to a file and have another employee populate the spreadsheet). 
See Cityworks Data Template for more information.  

 To add a single employee or update an employee’s information, use the General Information 

box on the left center pane of the Employees window. The required fields include Last Name 

and Is Active. See Field Value Tables for more information.  
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 Employee ID—A client-site ID, such as a payroll number, up to 15 characters in length. 

 Login ID—Used to log in to Cityworks; up to 30 characters, usually assigned by the database 

administrator or IT staff who assign Windows logins to match the schema used by the 
organization, e.g., first initial with the last name.  

 Last Name—Up to 30 characters long, apostrophes allowed. 

 First Name—Up to 15 characters. 

 M.I. (Middle Initial)—2 characters allowed. 

 Work Phone—Up to 24 characters. 

 Email—Required for Submit To employees who are set up to automatically receive emails about 

requests or work orders; maximum 250 characters. 

 Pager—Or other phone number, such as cell or home. 

 Title—Job title, position, or classification; up to 40 characters. 

 Organization—Or department. 

 Hourly Rate—For tracking labor costs; may be actual rate, an average based on job 

classification, a fully-burdened rate that includes benefits, overhead, etc. or any variation. If 

nothing is typed in the space, the field defaults to $0.00 when the employee is saved.  

 Image—Type in the network path to an image file or double-click in the field to open a browser 

box and browse to the desired image file to load the path in the field and load the image in the 

blank space on the right pane. 

 Is Active—Required field: Y for active, N for inactive. Inactive employees are listed in gray in 

the Existing Employees list in Designer and are not listed in Cityworks selection lists. Setting 
an employee to inactive, instead of deleting them, preserves the historical data. 

 Map Service Id—Select from the dropdown menu to associate the employee to a map service.  

NOTE: Employees may also be associated to a map service under Server Setup > GIS Services. 
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 Active Directory Domain—Enter the domain to use for Active Directory (AD) authentication to 

manage network administration and security through a central location. Internet Explorer (IE) 

must be utilized to use the AD Domain. Instruct IE to send the credentials via an Internet 
Information Services (IIS) setting. In the Web.config file for Server AMS/PLL 

(…inetpub\wwwroot\<site_alias>\WebSite), set the authentication mode from “Forms” to 
“Windows” as shown below:  

NOTE: Don’t set the Web.config file at the machine level, or all sites are subject it. 

… 

<system.web> 

 … 

 <authentication mode=”Windows”/> 

… 

</system.web> 

There is another way to configure Windows authentication; however, this is not required if the Web.config file 

is changed. 

 Start IIS 

 Right-click your application’s virtual directory and then click Properties. 

 Click the Directory Security tab. 

 Under Anonymous access and authentication control, click Edit. 

 Make sure Integrated Windows authentication is the only selected checkbox. 

When using AD Domain, the software skips the password portion (ignoring the value set in the encrypted 
PASSWORD field of the CWSVRMEMBERSHIP table) so those with AD passwords that change every ‘x’ 

number of days are not affected. 

1. Check the Domain Groups to which this employee belongs.  

NOTE: Employees may also be assigned to domain groups under Cityworks Setup > Domain Groups. 

2. Populate any Custom Fields by double-clicking in the Value field. A box for entering in the 
information opens, such as Choose a Date or Enter Value. Use it to enter the Value in the field.  

Some Custom Fields may be required by the organization before the employee information can be saved. A 

Required Value information box opens to ask the user to enter a value for the listed required custom field if 
a required field hasn’t been populated. If multiple custom fields are required, a message will open for each 

one in the order listed until all required fields are populated.  

3. Click the Save button.  

4. If desired, set the Regular Rate by clicking on the Category in the list to load the information into 
the top of the pane, set the radio button option to Percent (default setting based on the Hourly 

Rate) or Fixed which adds an additional amount to the hourly rate, and click the Update button for 

each rate.  

NOTE: If these rates do not match those used by the organization, use cost codes instead and leave these 
Regular Rates blank. See the section on Assign Cost Codes Tab for more information. 
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 Benefits—Pay for additional items an employer may provide, such a health insurance, life 

insurance, retirement plan, etc.  

 Holiday—Pay rate for working on holidays. 

 Other—Use for any code not already included in the list. 

 Overhead—Use for any overhead costs that are added to billable work for other departments, 

etc. 

 Overtime—Pay rate for working more than 40 hours per week; generally time and a half. 

 Shift Differential—Additional pay for working swing, graveyard, or other shift. 

 Stand By—Additional pay for being on-call for emergencies during the evenings or weekends. 

The organization sets up the rate schedule to match their desired method of calculating rates. There are 

two different ways of setting rates. For example, overtime may be selected in addition to the regular rate 
for the total labor cost on a work order. However, if all of the cost is considered overtime, uncheck 

Regular, which is checked by default, and check Overtime on the labor pane.  

NOTE: Use the Cost Code tabs if additional rates are needed. 
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5. If desired, add any desired attachments for the employee, for example, a resume, certificate, W4 

form (Employee's Withholding Allowance Certificate), etc. Drag and drop the file(s) into the field or 
click the Add button in the Attachments pane on the lower right to open a browser box for 

navigating to the file. 

 

Navigate to the desired file in the Select attachment file(s) box and double-click on the file (or select and 
click Open) to load the path.  
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Skills Tab 

The Skills tab allows the organization to track any skill sets, certification, or other specialized training an 

employee may have received.  

1. Populate the Codes list for AEMPSKIL (or have the Cityworks domain administrator do it). The 
Codes list is found in Others > Codes under the Description of Employee Skill Sets. Enter the 

Code and Description on the bottom right pane and click the Save button. Add all desired codes in 
this manner. 

 

2. Switch back to Employees (under Administration or Cityworks Setup), click on the Skills tab, 
and select an employee from the dropdown.  

NOTE: If necessary, change the Current Domain at the top to list the desired employees. 
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3. Select the applicable Code from the list to load the Description.  

4. Type the applicable information in Class Title, Provided by, Instructor, and Certification. 

5. If applicable, check the Certification Date and/or Expiration Date and type in the date or select 

using the dropdown to open the calendar.  

TIP: The checkbox in front of the date activates the date field and can be automatically checked by clicking 
the dropdown arrow to select the date. 

6. Click the Save button to save the information to the list on the right pane and clear the fields. 

Scroll across to view all the fields: 

 Code 

 Description 

 Class Title 
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 Instructor 

 Provided by 

 Certification 

 Class Date 

 Expiration Date 

 

7. Add each skill for this employee by following steps 4-7. 

8. Change the employee using the dropdown selection at the top of the left pane and add skill sets for 
the other employees in the same manner.  

NOTE: The employee selection listed is for the Current Domain shown above the tabs which may be 
changed for administrators who are working with more than one domain. 

The Clear button clears the fields. The Remove button removes the selected skill(s) for the employee from 
the list and in the database. No confirmation box opens. 

Assign Cost Codes Tab 

The Assign Cost Codes tab is used to link the employee(s) to customized, dynamic labor rates created on 

the Cost Codes on the Codes window found under Others. The cost codes are defined for the employee by 
entering the percent or fixed amount for the rate. If the domain is using the Regular Rates found on the 

Employees tab, skip this section as only one rate type may be used.  

IMPORTANT: At this time, dynamic cost codes do not support asset- or task-based costs. Do not use 
dynamic costs if labor will be associated to assets or tasks. 

1. Under Others > Preferences, set the Use Dynamic Cost Codes option to Y to activate dynamic 

costs and display the Assign Cost Codes tab on the Employees window.  

NOTE: Selecting the dynamic cost codes activates the Cost Codes and Job Codes tabs on the Codes 
window and lists the defined codes on the Employees > Assign Cost Codes tab and on the Work Order 
Templates > Labor tab. 
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2. Switch to the Codes window under Others and open the Cost Codes tab to define the desired 

codes.  

NOTE: See the Cost Codes Tab section for detailed information on how to populate these codes. 
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3. Return to Employees under Cityworks Setup and switch to the Assign Cost Codes tab. 

 

4. Select the employee(s) to which the cost code applies. 

5. Select the Cost Code. 

6. Select the radio button option for Percent or Fixed and enter the Rate. 

7. Click the Add button to list the information below and save to the database. 

Once the cost codes have been assigned, the Dynamic Cost Codes box on the lower left pane of the 

Employees tab displays the cost codes for the selected employee.  
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Load Employees Tab 

The Load Employees tab allows employee information already stored in a file to be imported for use into 

Cityworks.  

NOTE: The load process is briefly described in step 3 under Employees Tab, on the tab itself, and under 
Importing Data. 
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Once the information is loaded, the employee groups may be assigned by selecting the employee(s), the 

domain, and the group(s). Click the Selected button to add each selection to the database (or click the 
Save All button to save all the employees and use the Domain Groups function to assign the employees).  

Inactive Employee Search Tab 

The Inactive Employee Search tab allows for various searches on inactive employees. An inactive 
employee may then be replaced with an active employee who has permission to perform the selected 

responsibilities but only for certain types of records. See step 5 for more details.  

1. Switch to the Inactive Employee Search tab and select the desired radio button option for All 
records or Filter. 

 

2. If Filter is selected, check the desired box(es) in Filter Options. 

 Work Order Templates (Labor)—Lists all work order templates with an inactive employee 

listed in the labor selection. 
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 Request Templates—Lists all request templates having an inactive employee as a Submit To 

or Dispatch To person. 

 Questions / Answers—Lists inactive employees who are the Submit To or Dispatch To 

person based on a request template’s question-and-answer series. 

 Employees—Lists all inactive employees in the domain. 

 Employee Relates—Lists all the dropdown selections in the database tables where an inactive 

employee is found. 

 Tasks (Assigned To)—Lists inactive employees associated with a task on a work order 

template. 

 

 Materials (Labor)—Lists inactive employees associated with labor when assembling a material. 

3. Click the Search button to list the results. The total number of records is listed under the buttons at 

the top of the results list. Generally the Cityworks table is listed in the Description column but may 

also be found under Type or Item. 

  

4. If desired, the results list can be printed or saved, by clicking the Print or Save button.  

NOTE: The list prints in a landscape format with an additional column added for Employee SID. 

 

Clicking Save opens a dialog box. Type in the File Name and click Save.  

Click Yes when the message box opens to create the file (or replace an existing file if a text file with that 

name and path already exist).  

A message box opens to confirm that the file was saved and details where it is found. 

The file is saved as a text document and opens in Notepad. 
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5. If desired, you can replace an employee with another one. To do this, select the records from the 

search to change, select the employee from the selection list, and click the Update button at the 

bottom of the window. These records may be updated on the Inactive Employee Search tab. 

 Request Templates: Submit To or Dispatch To 

 Question/Answer: Submit To or Dispatch To 

 Work Order Tasks: Assigned To 

If no records are selected, a Select Record message opens asking the user to select a record to update 

first. 

If a record cannot be updated, an Update Employee message opens to alert the user as to what 

information cannot be updated using this function. Make a note of these and update them on their respective 
forms to update the employee information. 

Desktop Event Layers Tab 

The Desktop Event Layers tab allows the Cityworks domain administrator to create new event layers and 
share them with other users in the domain or copy existing event layers from one user to another.   

1. Switch to the Desktop Event Layers tab and select the desired Event Layers to copy.  

NOTE: If only one event layer is selected, the associated SQL Statement loads in the Configuration box 
on the right. 
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2. Select the employee(s) from the Employees box to add the event layer(s) to the user’s event layer 

selection list in Cityworks.  

NOTE: The Employees list is alphabetical by first name. If desired, click in the Last Name field to sort by 
surname. When an employee is selected, any defined event layers for this employee load on the lower pane. 

 

3. To create a new event layer: Type in the Event Name, maximum 30 characters, and SQL 
Statement, a maximum of 900 characters with the number of characters remaining displayed in 

parenthesis above the box.  

NOTE: No checking is done to validate the SQL Statement. 

4. Click the Save button to save the event layer for the selected users and list them in the Event 
Layers box. 
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Cityworks Setup 

Most of the Cityworks functionality for service requests and work orders is done in Cityworks Setup. 
Domain groups are defined and privileges assigned. Templates for service requests, work orders, custom 

fields, comments, and custom inspections are created. Tree structures are built for requests, contractors, 

equipment, materials, and tasks. Permit and inspection information may be added and template security 
assigned.  

In 2012.1, the group rights for work orders, service requests, and inspections were simplified. Please read 

Knowledge Base article 10619 for more information on the Group Rights Migration tool. 

 

IMPORTANT: When accessing the Designer domain functions for the first time with a new database, the 
Cityworks domain administrator must first go to Others > Preferences and click Save to set ArcGIS as the 
data model. If using ArcView 3.x, set the Use ArcGIS Data Model (#21) value to N (no) by double-clicking 
(or pressing the space bar) in the Value field before saving. 

 

The following functions are found in Cityworks Setup. 

 Domain Groups—Defines the Cityworks employee groups for managing security in the domain.  

 Employees—Sets up the basic employee information, including labor rates and skill sets.  

NOTE: The Employees window is the same here as in Administration. It is the only function available to 
both the Cityworks database administrator and Cityworks domain administrator. It is discussed in full detail 
under Employees. 

 Request Templates—Sets up the request type with all the accompanying question-and-answer 

series and default settings for submitting and dispatching personnel, duration, etc. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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 Work Order Templates—Sets up all the work order information by type, including all the 

default settings for priority, work months, duration, cycles, tasks, labor, materials, equipment, 

printing, security, and budget plans. 

 Custom Field Templates—Defines custom fields for requests and work orders.  

 Contractors—Provides basic information about contractors for work orders, such as how they 

are paid, what they supply, etc. 

 Equipment—Provides information about the equipment and its cost for work orders.  

 Materials—Provides information about the materials used for work orders with costs, minimum 

quantity to keep on hand, parts, etc. 

 Tasks—Defines all the possible tasks or steps that can be used to complete work orders, 

including defaults for assigning the task and estimated time to complete.  

 Permits—Defines permit information, including cost and source, to add this cost to a work 

order.  

 Custom Inspection Templates—Creates templates for custom inspections.  

 Inspection Custom Observations—Defines checklist questions for custom inspections with 

the answer format. 

 Predefined Comments—Sets up groups of possible comments for requests or work orders by 

category to facilitate data entry on handheld devices or standardize the responses. 

 Template Security—Assigns Cityworks security to domain groups for request and work order 

templates. In 2012.1, the group rights for work orders, service requests, and inspections were 
simplified. Please read Knowledge Base article 10619 for more information on the Group Rights 

Migration tool. 

 Employee Relates—Assigns employees access to Cityworks functions and defines who is in the 

Cityworks dropdown selection lists for various request, work order, and inspection fields. 

 Work Order Template Classes—Allows automation in selecting work order templates based on 

an asset’s attributes for a particular class of work when different tasks or procedures need to be 

followed. 

Domain Groups 

Domain Groups defines the employee groups for the domain. These groups serve two functions in 

Cityworks.  

 Define employee groups to facilitate adding labor to a request or work order by Group Name or 

Keyword.  

NOTE: Group Name or Keyword loads all the employees in the group so the user can quickly select the 
applicable employees and add the labor hours. 

 Set up the level for the group’s access to GIS rights in Cityworks Anywhere and Cityworks Server 

applications. 

Employees may belong to as many groups as desired. Cityworks is designed to have multiple groups for 

selection lists to facilitate data entry. If an employee belongs to multiple groups which are assigned different 
security privileges, Cityworks assigns the rights with the greatest access to the employee.  

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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NOTE: Security privileges do not need to be set for groups used for selection lists who do not access 
Cityworks. Security is set using Domain Groups, Template Security, and Employee Relates.  

1. Select the Current Domain. 

 

2. Type in the Name and Description of the group (or select from the Existing Groups to update 

the information). 

3. Click the Save button to save the group.   

4. Click on the Group Name to activate the rest of the window. 

5. Cityworks Anywhere or Server users may select the desired options in the Anywhere/Server GIS 
Rights box and click Save.  

NOTE: The last selection made for Anywhere/Server GIS Rights determines which option is active. 

 View Only for groups who will not be editing GIS data at any level and only viewing it.   
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 Attributes for groups who are allowed to edit only GIS attributes. In Anywhere, it would be on 

the Cityworks Inventory Editor form. In Server, it would be on the Editor form accessed via 

the GIS Search or work order Assets panel, as well as on the inspection Assets panel under 
Editable Fields (if configured).   

 Geometry (Server Only) for groups who are allowed to edit both GIS attributes and the map 

geometry.  

 Activity (Server Only) for groups who are allowed to only edit GIS attributes within a work 

activity, such as an inspection, and not in the Editor form.   

6. If you are a Server user and use districts, check the box(es) in front of each applicable District.  

NOTE: District is only visible for users connecting to a Server database. 

7. Click the Save button to save the Anywhere/Server GIS Rights and District information. 

8. Type a keyword in the Group Keywords pane and click the Add button to list them. Add as many 
keywords as desired.  

NOTE: The first three letters, other abbreviations, or acronyms may be used as keywords. 

9. Select the employee(s) from the list on the left who belong in the selected group and click the right 

arrow to move them into the group (or double-click on each employee to move them to the right).  

An employee may also be added to a group by selecting the individual on the Employees tab of the 
Employees window and checking the box under Domain Groups for each applicable group.  

 

Employees 

Employees is discussed as part of Administration since it is the only function available to both the Cityworks 

database administrator and Cityworks domain administer. See Employees for full details. 

Request Templates 

 Request Templates sets up the categories and items for service requests, including questions for call 
takers to ask to generate the type of information needed for the inspectors. Request templates can also be 

created for frequently-asked questions to provide call takers with the necessary information and track the 

number of incoming calls for the subject. Cityworks does not contain any predefined request templates. A 
cloning function facilitates the set up by copying the information on all tabs to allow each organization the 

flexibility to completely customize the system to match their current procedures.   
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Request and problem are frequently used as interchangeable terms in Cityworks since most requests report 

on problems. Because many clients now use requests for additional items, Cityworks has moved from 
Problem Templates to Request Templates to more accurately reflect the openness of the system in 

tracking any type of information desired.  

NOTE: Some field names in the Request table in the Cityworks database still refer to problem, such as 
ProblemCode, ProbAddress, ProbCity, ProbZip, and ProbAddType. 

If the organization uses districts, zones, boundaries, commissioner areas, or any other geographic 

relationship for requests, define these under Others > Map Layers and Fields before beginning these 
steps.  

NOTE: See the related section on Map Layers and Fields. 

Request Hierarchy Tab 

This information is organized into a Hierarchy on the left and a template list on the right on the Hierarchy 
tab. The Cityworks Data Template > ProblemLeaf may be used to load the information into the list or each 

item may be added by clicking New Item to open the Request Template Edit window. A Request 

Template Edit window with multiple tabs may be opened for the request template by double-clicking on it in 
the tree or in the list.  

NOTE: The General Info tab allows information from multiple request templates to be viewed and updated 
at the same time. This tab is discussed at the end of the Request Templates section. 
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1. Create the hierarchy trunks and categories.  

NOTE: See Setting up Data Trees for details. 

2. Add each new request template using the New Item button.  

NOTE: Multiple request templates may be added using the Cityworks Data Template > Problems Leaf. 

3. Add the detailed information on the Request Template Edit window as outlined in the following 
sections.  

NOTE: Once a request template is completed, it may be cloned as described under Cloning a Request 
Template. 

Request General Tab 

A request code may be added or information updated on the General tab of the Request Template Edit 

window. 
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1. Set the default Value for each Field on the General tab. The window opens with these default 

values.  

 

 Code—Type in the request code, up to 20 characters. 
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 Description—Type in the description of up to 50 characters.  

NOTE: The Description lists in the request tree after the tilde following the Code. 

 Category—Select from the dropdown or click Define New Code and click out of the field to 

open the APROBCAT Codes box for defining a new code.  

Request categories may also be set in Others > Codes under APROBCAT. 

 

 Duration—Enter a whole number for the days or hours in which the service request should be 

completed. This number is used to populate the Projected Finish Date on the service request.   

NOTE: A search can return all requests considered past due based on the expected Duration Time and 
Units. 

 Duration Units—Double-click (or use the space bar) to toggle between DAYS and HOURS. 

 Submit To—Select the default employee who receives this type of request. Leave blank if this 

request may be assigned to more than one employee.  

NOTE: An email may be set up to automatically email the Submit To and/or Dispatch To employee when 
the request is saved. 

 Dispatch To—Select the default investigator who investigates this type of request. 

 Priority—Select the urgency of this request using the dropdown selection or click Define New 

Code and click out of the field to open the APRIORIT Codes box for defining a new code.  

NOTE: The same set of Priority codes is used for work orders. Beginning with 4.5 sp 3, at least one priority 
code is required and up to 9 are allowed. 

Priority may also be set in Others > Codes under APRIORIT.  

 Custom Field Category—Select from the dropdown which is populated in Custom Field 

Templates. See the section on Custom Field Templates for details on defining a category and 

adding fields. 

 Printer—Assigns a default printer to print this type of request. 

 Word Template—Use the dropdown to select the name of the default custom print template or 

leave blank to use the Cityworks default SR.dot template. If the desired code is not in the list, 
click on Define New Code to open a Codes box for adding new codes. Type in the Code of 8 

characters or less and the Description. For details on Customizing Print Templates, see 
Cityworks Customization. 
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 Auto Close Request—Toggles between Y and N to allow a request to automatically close as 

soon as the request is saved. N is the default setting.  

TIP: The Auto Close Request function is useful when the organization wishes to log calls which require no 
further action, such as frequently asked questions. 

 Cancel—Allows administrators to cancel this request code so it is no longer available for use but 
the request history remains in the database. N is the default setting.  

 For Public Website—If the request template is to be accessed on a public website, change the 

setting to Y (True). N (False) is the default setting.  

NOTE: When toggling, the choices are Y and N; however, once saved, it displays True or False in the For 
Public Website field. 

 Default Project—Double-click in the field to open the Select a project box and select from the 

hierarchy if all requests of this type belong to a specific project. 
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NOTE: The Clear button can be used to remove a selected project from the request template. 

 Other System Code—Use the Other System Codes window under Others to populate this 

field. Once populated, the field mappings to another system, like 311, are listed in the field by 
Code, Description 1, and Description 2.  

 QA Model—Toggles between Branch and Linear. 

NOTE: Linear is for Server users. 

2. Click the Save button to add the request template to the hierarchy and the database and assign the 
SID.  

NOTE: The SID is a system-generated, unique identifier in the Cityworks database. 

The request template must be saved before Comments, Keywords, or Attachments are added since it 

must have a ProblemSID to link to these other fields. This message box opens to alert the user. 

3. If desired, enter any frequently-used Comments for the request type on the right pane and click the 
Add button in the Comments pane to list it on the right. Comments may be up to 250 characters 

long. They are listed on the service request and loaded by double-clicking on the desired comment.  

TIP: Predefined Comments are especially valuable for handheld wireless systems to facilitate data entry or 
to standardize responses for search queries. 

4. Type in a keyword and click the Add button in the Keywords pane to add it to the list. Do this for 

each keyword. No spaces are allowed in keywords; may use underscore (or low line _ ) to connect 

words.  

NOTE: Clicking the Add button saves the data to the request template.  

5. To add any related file(s), click on the Add button in the Attachments section to open the Select 

attachment file(s) box, browse to the network location, select the file, and click OK to load the 

path on the right. Do this for each file.  

Once all the information has been entered on all the tabs for a request template, the Clone button can be 

used to enter the same settings for another request template. See Cloning a Request Template for more 

information. 
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IMPORTANT: Once request templates have been used, they should not be deleted. To prevent a template 
from being used, set the Cancel setting to Y so it is no longer available as a selection for new requests but 
can be displayed with historical information. 

If a template hasn’t been used, it may be deleted by clicking the Delete button. When the confirmation 

message opens stating the process will delete the named template and everything under it and asking if the 
user wants to continue, click Yes to delete the template.  

Questions Tab 

Questions are set up to facilitate the call takers in gathering all the information needed by the inspector and 
to provide standard responses to callers for each type of request. Input from the inspectors and call takers is 

invaluable in setting up scenarios to provide written records of the details. With questions and answers set up 

in this manner, calls may be taken by a central dispatching system, providing the necessary information to 
both caller and inspector.  

TIP: A question loop may be created, especially for frequently-asked questions, so that the call taker can 
return to the beginning of the sequence and begin again. 

1. Switch to the Questions tab.  

 

2. Enter the question and click Save. 

3. Add all the questions. 

4. If necessary, use the up/down arrow buttons (or drag and drop a question) to move questions into 

the desired order. 

The Clear button clears the Question field and the Delete button deletes the selected question.  

NOTE: Only one question may be deleted at a time. 

Answers Tab 

Answers can be set up for each question using several formats. The question that follows can vary depending 

on the answer to make obtaining the correct information as quick and easy as possible.  
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1. Switch to the Answers tab.  

 

2. For the question listed in the Question field, select the Answer Format radio option. 

 This Text—Type in a possible answer.  

 Yes 

 No 

 Unknown 

 Date 

 Any Free-form Response—Allows the call taker to enter exactly what is reported. 

If Date or Any Free-form Response is selected, no other Answer Format may be selected. An Error 
message opens when trying to add any other responses by alerting the user of the format specified. If a 

different format is wanted, highlight the item in the Answers list and click Delete before adding the new 
response. 

3. Select the Next Question for the given answer.  

TIP: Skip questions in sequences where they do not apply.  

4. If desired, select any of the following fields for the given answer.  

 Submit To—Select a Submit To employee for the request template if all requests of this type 

go to a particular employee or department. 
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TIP: A department may be used as the Submit To field so someone in the department can assign the 
Dispatch To according to who is available or already in the area. 

 Submit To Layer—Enter the GIS layer name for the polygon feature class for area-based 
submitting when a location determines the Submit To employee.  

NOTE: To have a service request submitted or dispatched to a certain employee based on its location, select 
a Submit To Layer with a Submit To Field and/or Dispatch To Field. The software uses the map layer to 
assign the Submit To and/or Dispatch To field according to the location of the incident address on the 
request. Map layers are defined under Others > Map Layers and Fields. 

 Submit To Field—Enter the field name containing the Submit To employee from the polygon 

feature class table. 

 Dispatch To—Select a Dispatch To employee if this type of request is always dispatched to the 

same employee or department.  

 Dispatch To Field—Enter the field name containing the Submit To employee from the polygon 

feature class table. 

 Priority—Select a different priority if the answer changes the default priority set for this request.  

5. If desired, enter any Instructions for the given answer for the call taker to follow or pass along to 

the caller. 

6. If desired, add an Attachment by clicking in the field to open the Select attachment file(s) box 

and browse to the desired file. To add a web page, go to the site, copy the URL (Uniform Resource 
Locator or global address of web documents), and paste into the Attachment box.  

TIP: Entering a URL path allows call takers to access web pages providing a dynamic link to the most current 
information without having to update the Attachment on the request template. 

7. Click the Save button to add the information to the database and list.  

8. Follow steps 2-7 for each Question in the dropdown list. Check the Show all questions box to list 
all the questions in the Next Question dropdown for looping questions back to the beginning.  

 

TIP: When creating a question loop, be sure there is an end, such as having a question that can be 
answered Yes or No where one option loops back and the other ends the series. 

Scroll over to view the additional columns of information in the list. These columns correspond to the 
information found on the tab. 

If desired, an answer may be edited by double-clicking on it in the list to reload the fields. Make the desired 

changes and click the Save button. When the message opens stating that the answer already exists and 

asking if the user wants to update it, click Yes to save the changes.  
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Map Layers Tab 

The Map Layers tab defines which additional GIS fields are displayed on the service request. Different map 

layers may be set up to correspond with various districts, zones, boundaries, commissioner areas, etc. There 
is no limit to the number of map layers that can be set up.  

NOTE: Map layers are defined under Others > Map Layers and Fields. They must also be defined in the 
map document as a polygon feature class. 

1. Switch to the Map Layers tab.  

 

2. Select the map layer on the left pane to populate the corresponding Value in the Select Layer 
Fields on the right.  

3. Select the desired value and click the Add button to add the Map Layer and Field Name to the list 

below. 

Security Tab 

The Security tab is used to set the group access rights for the request template, giving permission for the 
group’s users to view, add, update, delete, and/or view cost. In 2012.1, the group rights for work orders, 

service requests, and inspections were simplified. Please read Knowledge Base article 10619 for more 
information on the Group Rights Migration tool.  

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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NOTE: Security permissions can also be set for multiple request templates at the same time on the 
Cityworks Setup > Template Security. 

1. Switch to the Security tab.  

 

2. Select the group(s) on the left. 

3. Select the applicable table(s) from the center.  

4. Check the box(es) under Set Access Rights for the permissions allowed for each of the tables. 

 View—Permission to view this type of request, the associated customer calls, or the request 

labor costs. 

 Add—Permission to create a request, add a customer call, or input request labor. 

 Update—Permission to update a request after it has been saved and populate general request 

information, customer call information, or labor costs. 

 Delete—Permission to delete a request once it has been created, delete calls from the request, 

or delete labor costs.  

TIP: Azteca Systems Inc. recommends cancelling service requests rather than deleting them from the 
Request table to allow users to view the information and reactivate the request if necessary. Limit the users 
with Delete permission for Request. Deleting a request removes that ID from the database so it cannot be 
reused or accounted for.  

IMPORTANT: Delete permission for the RequestLabor table is needed for any users inputting labor costs 
so they can remove information which has been incorrectly entered. 
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 View Cost—Permission to view costs, including labor; generally reserved for management-level 

personnel to protect employee privacy. 

5. Click the Save button. 

WO Templates Tab 

The WO Templates tab is for use only with Cityworks Server AMS and allows the Cityworks domain 

administrator to link multiple work order types to the selected request to easily create a work order from a 
request.  

NOTE: Cityworks Server AMS allows a 1:m relationship where one request can be linked to many work 
orders; Cityworks Desktop is a 1:1 relationship. 

1. Switch to the WO Templates tab. 

 

2. Select all work order types from the list on the left that apply to the selected request, using the Ctrl 
or Shift key to make multiple selections. 

3. Click the right arrow located between the panes to associate the work order templates to the request.  

NOTE: A work order template only shows up on one list at a time but can easily be moved from one to the 
other. If it is necessary to remove a work order template from the Associated WO Templates list, click on 
left arrow or double-click on the template to move it. 
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Cloning a Request Template 

Once all the information for a request template is set on all the tabs, a template may be cloned to another 

request type to facilitate the set up. Frequently, much of the information remains the same for requests in 
the same Category, especially on the Map Layers and Security tabs. Cloning allows all the information 

loaded on the tabs to be moved to another template and then modified as needed.  

1. Switch back to the General tab. 

2. Double-click in the Code field (or select Code and press the Enter key) and type in the new Code. 

3. Press the Enter key or exit out of the Code field which activates the Clone button and inactivates 
the Save button.  

 

When a request template is opened, all buttons may be activated. If the administrator attempts to clone a 
template without first entering a new Code, a message box opens to remind the user to modify the code and 

try again.  

4. Click the Clone button. 

5. Modify the Description field to match the new Code. 

Once information is entered in a field other than the Code field, the Save button is active and the Clone 
button is inactive.  

6. Change any other settings for the template on the General tab, including removing any Comments, 

Keywords, or Attachments that are not applicable. 

7. Click the Save button. 

8. Verify that the information on the other tabs is correct or modify it as necessary. 

General Info Tab 

 To facilitate data entry when multiple templates share the same field values, information can be entered on 

the General Info tab of the Request Templates. The left pane lists all the fields and values found on the 
General tab of the Request Template Edit window, except for Code and Description, with any default 

values for the domain.  

All the Existing Templates are listed on the right pane with the current values for all the fields displayed by 
columns in the same order as on the list. Arrow up or down on the Existing Templates list to load the 

corresponding values on the General Info pane on the left. This allows the administrator to view the current 

information without having to open each template and make mass updates by selecting the templates and 
entering a Value in the table on the left. Any values entered here override what is currently displayed.  

TIP: Mass updating for request templates is particularly useful when an employee needs to be added or 
removed from the Submit To and/or Dispatch To lists or a new printer is installed. 

1. Close out of the Request Template Edit window and switch to the General Info tab of the 
Request Templates.  
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NOTE: The Value in the General Info box lists the default value assigned by the Cityworks domain 
administrator. 

 

2. Select the Current Domain from the dropdown selection. 

3. Select the templates for updating from the Existing Templates list, using <Shift + click> or <Ctrl 
+ click> for multiple selections. 

4. Double-click in the Value field(s) to update and enter the new value(s). 

5. Click the Save button to make the changes. 

Use the Clear button to clear the field Value column. The Refresh button refreshes the values in the 
columns on the right pane. Request templates may also be deleted by selecting the templates and clicking 

the Delete button.  

IMPORTANT: Deleting request templates is not recommended if they have been used; setting Cancel to Y 
is preferred to maintain the request history. If the template is deleted, the rest of the information is orphaned 
in the Cityworks database. 

Scroll across to view the additional columns, which list the same fields as on the left pane in the same order.  

TIP: Columns may be collapsed to view the columns further to the right with the Code and Description. 
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Work Order Templates 

Work order templates contain default information for each type of work order, including priority, labor, 
materials, and equipment estimates, etc. Because configuration is unique to each organization, Cityworks 

does not include any predefined work order templates. A cloning function, similar to the one found on 

request templates, facilitates the set up by copying over the information on all tabs, except for the Budget 
Plan tab. View and edit permissions are assigned by domain group to each work order template. Selecting 

the asset type displays the associated work order templates.  

When a work order is created, the associated tasks can load automatically, along with estimated labor costs, 
employees, materials, and equipment. Data entry is simplified for the user by adding the necessary 

information to the work order template.  

Before adding work order templates, the following information should be added to Designer (click on any one 
to view more information):  

Cityworks Setup functions: 

 Employees  

 Contractors 

 Equipment 

 Materials 

 Tasks  

Asset Setup functions: 

 Asset Group Definitions (Define Groups and Assign Assets tabs)  

The default setting for labor cost is the rates listed for the employees under the Employees function. To use 

dynamic labor costs, which are based on the Cost Codes and/or Job Codes that you enter, set up these 
additional functions.  

Others functions: 

 Codes—Use the Cost Codes tab and/or Job Codes tab.  

 

 Preferences—Select Y for Use Dynamic Cost Codes. (N is the default and uses static costs.) 

 

Work Order General Tab 

The General tab lists basic information about the work order activity, including the asset type the work is 

done on, description, priority, repeat cycle, and work months.  

Multiple work order templates may be selected on the General tab before adding information to the 

General, Misc. Info, Printing, and Security tabs if the same information applies to all the templates. No 
Value is listed for any Field on the right pane of the General tab since these values may vary for the 
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selected templates. Any information added here and saved overrides the default or current Value listed for 

the selected Field on each of the work order templates listed.  

 

However, the Tasks, Labor, Materials, Equipment, and Budget Plan tabs may not be used when 

multiple work order templates are selected. A message box opens to inform the administrator that the 

information on the selected tab cannot be altered for multiple templates. 
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1. Click on Work Order Templates under Cityworks Setup.  

2. Select the Current Domain and Asset Group from the dropdown selections. 

3. Select the radio button option for the type of asset to create the work order template for and to 
populate the Asset list on the left.  

 Features—Use for a list of feature classes in the selected asset group. 

 Objects—Use for a list of related objects at any n-level for the selected asset group. 

 Others—Use for a list of non-asset based, user-defined work order groups, such as 

miscellaneous work like equipment or office maintenance.  

TIP: To use asset readings to generate work orders, use Features or Objects, e.g., set up vehicles as 
related objects. 

4. Type in the work order Description at the bottom of the middle pane, up to 100 characters long, 

and click the Save button to activate the rest of the form.  
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When the work order template Description is saved, the header of the window adds the asset type and 

Description so the user knows which template is open when working on the tabs.  

5. Populate the Value for each Field listed at the top of the right pane. This pane is populated with 
these default values.  

 Category—Select the maintenance department from the dropdown or click Define New Code 

and click out of the field to open the Codes box for defining a new AWOCAT code.  

NOTE: Work order categories may also be set in Others > Codes > Add/Modify tab > Asset Group: 
Others under AWOCAT. 

 Priority—Select the urgency or importance of this work activity using the dropdown selection or 

click Define New Code and click out of the field to open the Codes box for defining a new 

APRIORIT code.  

NOTE: Priority may also be set in Others > Codes under APRIORIT. This same set of codes is used for 
requests. Beginning with Cityworks 4.5 sp 3, at least one priority code is required and up to 9 are allowed. 

 Days to Complete—Type in the number of days routinely needed to complete the work. The 

number entered in Days to Complete is used to calculate and populate the Projected Finish 
date on the work order. New work order templates have a default value of 2.00 (unless they 

were cloned from an existing template). On a work order, the Projected Start date must be 

completed, but the Projected Finish can be left blank.  

NOTE: If the Days to Complete field is left blank, the Projected Finish date will display MM/DD/YYYY 
on the work order. 

TIP: To search for Past Due work orders, fill in the Days to Complete field. 

 Account—Type in any user-defined tracking number to automatically populate the Account field 

on each new work order of this type, up to 20 characters. 

 Shop—Select the maintenance shop or department from the dropdown list or select Define 

New Code and exit out of the field to open the Codes box for Shop.  

NOTE: The shop list can also be populated in Others > Codes > Shop. Shop is usually associated with a 
polygon map theme divided into service areas but may be defined as a code without the map. 

 Date—Defaults to today’s date but may be changed if desired. This Date field is for showing the 

date the template was created. 

 Auto Create Tasks—Select Y to automatically list the tasks on the Tasks tab for new work 

orders of this type. Each predefined task with a sequence of 1 is listed with a Current status on 
the new work order. Each additional task has a status of Pending. No projected or actual dates 

are populated. 
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Select N to list the tasks on the Tasks tab into the Predefined list on the new work order for the users to 

use as task selections. 

 

 Custom Field Category—Select from the dropdown which is populated in Custom Field 

Templates. See the section on Custom Field Templates for details on defining a category and 

adding fields.  

 Stage—Toggles between Actual and Proposed. New work orders will be set to this predefined 

stage automatically. 

 Expense Type—Toggles between Maintenance or Capital Improvement. 

 Cancel—Select Y to inactivate the work template and maintain the work history but prevent the 

template from being used any more. All new templates default to N.  

 Include Weekends in Cycles—For cyclical work orders, a Y response includes weekends when 

calculating start dates and can schedule a work order to begin on a weekend. This functionality is 

especially useful for treatment plants, pump stations, or other locations where employees work 
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every day of the week. An N response doesn’t include weekends in calculating start dates and 

schedules a cyclical work order for the next workday following the weekend.  

 Default Project—Opens the Select a Project popup to automatically associate all work orders 

of this type to the selected project.  

 

NOTE: A project can be cleared from the field by clicking the Clear button. 

 Submit To—Select from the dropdown to automatically load the Submit To field for these types 

of work orders. 

 Supervisor—Select from the dropdown to automatically load the Supervisor field for these 

types of work orders. 

 Unit Accomplished Description—Select from the dropdown box with a customized set of 

possible unit codes. Set these codes under Others > Codes > Asset Group of Others > 

UACCDESC. The Description for the selected Code will be listed on each work order of that 
type in the space following the Unit Accomplished entry field. 

TIP: Setting the value on the template facilitates data entry into the Units Accomplished field because the 
units are already listed on the work order. It also prevents some users from entering a distance in feet while 
others are entering it in miles. With the units consistent per work order type, the values can be added 
together to provide accurate information on the work that is being accomplished. 
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 Lock Unit Accomplished Description—Select Y to prevent the user from changing the desired 

value on the work order form so no selection box pops up when a user clicks on the unit 

description. Set to N to allow users to access the selection box and change the unit descriptions.  

NOTE: The Cityworks domain administrator can change the units when creating a new work order with the 
lock set to yes but once the work order has been exited, the units can no longer be changed by any user. 

 Maintenance Score—A user-defined field used to calculate or set a score on a work order 

template. The score is applied when the actual finish date is set on the work order. The 

maintenance score represents various work activities performed on an asset over time. Every 
time work is done on an asset, the maintenance score is accumulated to create a historical 

maintenance record. This information is visually represented as orange circles on the map using 
the Condition panel with a set time frame. 

 Custom field value action on child WO creation—If the field is left blank or Default is 

selected, fields do not copy over. If ParentWO is selected, a child work order's custom value 

fields will load with the parent work order data.  

 Is reactive?—Select Y to indicate that this work order template is reactive. The default, N, 

indicates that the work order template is not reactive.  

NOTE: When Database Manager runs, it will update this field for any historical records based on whether or 
not the work order has a service request associated with it.  

6. If desired, select a Repeat Cycle of Every or Once for cyclical work orders. Changing the radio 

button option from Never to Once or Every activates the other fields.  

TIP: A Repeat Cycle can also be set up from an individual work order. The benefit to doing it as part of 
the template is that it is automatically set up on every work order of this type. 

 Never—Default setting which does not automatically generate another work order.  
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 Once—Set for a work order activity requiring a crew to return one time, such as for an 

inspection.  

 Every—Set the desired cycle length for regular, scheduled maintenance work by typing in a 

number and selecting the desired unit from the dropdown selection of Days,  
Weeks, Months, or Years. Then set the From date to be either from the Actual Finish Date 

or Projected Start Date. 

 

7. Uncheck any Work Months during which the specified work activity is not performed, for example 

mowing the grass at a park location that receives snow during the winter months.  

8. Click the Save button.  

IMPORTANT: If a work order template has been used, do not delete it. Cancel the template to maintain the 
work history. Deleting the work order template orphans the information creating problems in the Cityworks 
database. 

If it hasn’t been used, a work order template may be deleted by selecting the work order template and 

clicking the Delete button. Click Yes when the confirmation box opens. Deleting is included to allow 
modifications in template names and descriptions at the time of set up.  

Tasks Tab 

The Tasks tab attaches predefined tasks to the work order. A work order template must be selected on the 
General tab before switching to any of the other Work Order Template tabs or a message box opens to 

remind the user. 

1. Switch to the Tasks tab.  
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2. Use one of the following ways to load the task selection. 

 Type a keyword in the blank Search by Keyword field and press Enter to list the associated 

task(s).  

 

 Select either Name or Hierarchy from the dropdown selection. Selecting Name loads all the 

tasks in the box. Use the scroll bars to find the desired task. 
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Selecting Hierarchy opens the box for selecting a group of tasks. Open the folder(s) to locate the desired 
task(s) and double-click on the entire folder or a single task (or select and click OK) to list the task(s) in the 

box. Tasks may be selected from other domains since some tasks may require cross-departmental 
cooperation.  

NOTE: The Clear button can be used to clear the task list on the top pane. 

TIP: Open the folder to verify that materials are listed in it. If the folder contains other folders, the hierarchy 
closes when the folder is selected without loading any tasks. 

 

3. Select the task from the list to add to the work order in the order the work is to be performed. 
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4. If desired, select an Assigned To employee from the dropdown list.  

5. To add a Shop, tab to the Shop field (or move to the field and press the Enter key or double-click 

in the field) to open the SHOP Codes selection box. Double-click to load the Shop field (or select 
and click Select). If necessary, populate the box by typing in the Code and Description for each 

shop.  

6. Enter the Days to Complete the task if different than 1. 

7. You can change the Sequence number if the task can be done at the same time as the previous 
task or to add a task that comes earlier in the sequence.  

NOTE: The next number automatically loads in the Sequence field when the Add button is clicked. 

8. If desired, enter any Comments. In a new work order, these Comments are listed with the tasks, 

not on the work order Comments.  

9. Click the Add button to add the task to the list at the bottom and advance the Sequence number.  

10. Add each task needed for this work order by following steps 2-6, changing the Sequence number if 

needed for tasks that can be done at the same time or to add a task that comes earlier in the 

sequence.  

If an additional sequence ID is wanted when an item with that number already exists, a Confirm Update 

message opens stating that the numbered sequence already exists. Click No to have it list an additional task 

for the number indicated or click Yes to renumber the previously defined sequence ID(s). 

If the task is already in the list, but needs to be updated, double-click on it to reload the Task and 
Description. Make the desired changes and click the Add button. Click Yes when the message box opens 

stating that this task already exists and asking if the user wants to update it.  

To delete from the list, select the task(s) and click the Delete button. Click Yes when the confirmation box 
opens asking if the user wishes to remove the selected task(s) from the template.  

Labor Tab 

The Labor tab attaches employee or contractor labor costs to the work order. Assigning labor to the 
template lists the labor costs on the work order as an Estimated cost which, if accurate, can be transferred 

to the Actual costs. Another way to add this labor is to view the Actual costs and then select Predefined. 

This loads the employees and/or contractors into the list so you can select the desired ones and enter their 
labor.  

1. Switch to the Labor tab.  
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2. For contractor labor, switch to the Contractor radio button option. 

3. Load the employee(s) or contractor(s) in the center right pane by one of the following methods.  

NOTE: Multiple employees may be listed at the same time using Group Name or Keyword and multiple 
contractors by using Contractor Hierarchy or Keyword. 

 For employees, select either Group Name or Employee Name from the Search By dropdown 

selection and use the Group Name dropdown to find the desired group or employee.  

TIP: Since Group Name is the default selection, the groups are already loaded in the Group Name 
dropdown. 

 Type a Keyword into the field and press the Enter key to list the employees or contractors, 

depending on the radio button option selected.  

 Select either Contractor Name or Contractor Hierarchy from the Search By dropdown. For 

Contractor Name, which is the default, use the Group Name dropdown to find the desired 

contractor. For Contractor Hierarchy, double-click on the desired folder or contractor from the 

popup box.  

4. Select the employee(s) or contractor(s) from the list to add to the work order.  
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NOTE: At least one of the employees or contractors must be selected before clicking the Add button or a 
message opens to remind the user to select a labor item. 

TIP: If the hours are the same for multiple employees, their labor can be added at the same time. 

5. If using dynamic costs and the job code is needed to override the cost codes, right-click in the Job 

Code field to open the Codes box for selecting the code.  

NOTE: Static or dynamic costs are set up by domain under the Preferences option, Use Dynamic Costs, 
and determine whether the software lists Rate Types or Cost Codes; the default Rate Types are used for 
N and Cost Codes for Y. 

   

Double-click on the selected code (or select and click the Select button) to load the Job Code and override 

the regular rate.  

 

6. Select the employee(s) or contractor(s) from the list to add to the work order. At least one of the 

employees or contractors must be selected or this message box opens to remind the user.  

7. Check the box(es) for the Rate Types or Cost Codes if different than Regular or in addition to the 

Regular rate. Click in a checkbox to uncheck a Rate Type or Cost Code.  

NOTE: Cost Codes are customized by each organization for tracking labor and usually reflect the method 
used prior to implementing Cityworks so users will be familiar with those customized types. 

8. If desired, select the radio button option for how to display Cost.  
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NOTE: The default setting for which Cost option to display is preset according to the Use Dynamic Costs 
setting in Preferences. 

 Show Static—Use for the regular default rates from the Employees tab of the Employees 
window.  

 Show Dynamic—Use for Cost Codes or Job Codes. 

 Show Both—Use to see both static and dynamic costs when static costs existed before 

switching to cost codes. The active code is shown in black text; the inactive code in gray text.  

NOTE: If both static and dynamic costs exist, they will be totaled together in the Estimated Labor Costs 
shown at the bottom left. These costs are used on the Budget Plan tab so it is recommended that the 
organization set up one or the other for each template, but not both. 

 

9. Enter the estimated Hours. 

10. If desired, enter a Description.  

11. Click the Add button to list the employee(s) or contractor(s) in the list on the lower pane along with 
the total Estimated Labor Costs at the bottom. 

 

12. Add labor for all employees and/or contractors needed for this work order template. 

To modify labor, add the correct information and select the entries to remove from the list, and click the 

Remove button. Click Yes when the confirmation box opens to remove the item(s) from the list. 

Materials Tab 

The Materials tab attaches predefined materials to the work order template which are then listed on each 

work order of this type.  
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1. Switch to the Materials tab. 

 

2. Load the desired material(s) into the center pane by selecting the Search By option for material 

Name or Hierarchy or typing in a Keyword and pressing Enter.  

NOTE: Hierarchy or Keyword can be used to list multiple materials at a time. 

Selecting Name loads all the materials into the table.  

Hierarchy opens a selection box from which a folder of materials can be selected.  
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3. Select the material(s) from the list.  

TIP: Multiple materials may be added at the same time if the same number of units of each material is 
wanted. 

4. Type in the estimated number of Units Required if different than 1.  

5. Click the Add button to list the material on the lower pane and generate the Estimated Material 

Costs at the bottom of the window.  

6. Add other materials in the same manner until all desired materials have been added.  

TIP: The only way to change an entry in the list is to add a new one and remove the incorrect one. 

Contractor-Provided Materials 

If a contractor typically provides some of the materials as well as the labor, these material costs can be 
added to the work order template. The total cost is listed along with the units provided so there is no 

calculating performed using the cost per unit. 

1. If a contractor provides the material, select the material from the list and click the Contractor 

button to open the Contractor Material Cost box loaded with the material ID and Description.  
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2. Type in the Contractor Name or double-click in the field to open a Select a Contractor box with 

the contractor hierarchy and select a contractor.  

 

3. Type in the remaining information and click OK when finished to add the information to the lower 

pane.  

NOTE: Contractor Total Cost is the total cost for the number of units entered. 

 

Equipment Tab 

Equipment can be added to the work order template to aid the user in selecting the equipment used when 
filling out the work order and is also used as a cost estimate. Each piece of equipment with a unique ID 

represents 1 equipment unit. Multiple units are used only for those items, such as barricades or small hand 
tools, which are not uniquely identified.  

1. Switch to the Equipment tab. 
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2. Select the equipment needed using Name or Hierarchy from the Search By dropdown or type in a 
Keyword and press Enter to load the equipment on the center pane.  

NOTE: These selections are similar to those found on the Labor and Material tabs and work the same way. 
Multiple selections may be loaded at a time using Hierarchy or Keyword.  

3. Select the desired equipment from the list. 

4. Enter the Hours needed for the selected equipment item.   

5. Enter the Units Required if more than 1 item is needed and each item does not have a unique ID. 

6. Click the Add button to add the equipment to the work order template and to list it on the lower 

pane with the Estimated Equipment Costs. 
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Contractor-Provided Equipment 

A contractor may also provide equipment along with labor and/or materials. These equipment costs can also 

be added to the work order template, similar to adding contractor-provided materials. 

1. If a contractor provides the material, select the equipment from the list and click the Contractor 
button to open the Contractor Equipment Cost box loaded with the equipment ID and 

Description. 

 

2. Type in the Contractor Name or double-click in the field to open a Select a Contractor box with 

the contractor hierarchy and select a contractor. 

 

3. Type in the remaining information and click OK when finished to add the information to the lower 

pane.  

NOTE: Contractor Total Cost is the total cost for the number of units and hours entered. 
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Scroll across to view additional fields.  

Misc. Info Tab 

Miscellaneous information adds predefined comments, instructions, and attachments which will be 

automatically included on each new work order of this type.  

1. Switch to the Misc. Info tab. 

 

2. Type in any Comments and/or Instructions. 

3.  Click the Save button.  

4. Click the Add button to open a Select attachment file(s) browser box for locating the desired file. 
Attach as many files as desired. 
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Printing Tab 

The Printing tab sets the preferences for the default printing parameters for the work order template, 

including selecting a printer and specifying map information. Skip this section if the organization does not 
print work orders. 

Custom templates can be created by the organization to print paper documents for each work order type and 

must be stored in the Templates file of the Cityworks directory. Custom template names can be no longer 
than 8 characters. Custom map templates may also be created for printing maps using the ArcMap layout 

function. Map template names may be 250 characters maximum.  

NOTE: See Customizing Print or Email Templates for more information.  

IMPORTANT: Azteca Systems Inc. recommends keeping a master copy of all custom templates in another 
location to facilitate the installation of future versions of Cityworks.  

1. Switch to the Printing tab. 

 

2. If desired, enter the name of a customized Microsoft Word Template, 8 characters or less in 
length.  

NOTE: Leave the Microsoft Word Template field blank to use the default Cityworks template, (pw.dot). 

3. Enter the number of days before the work order type lists in the Print Queue.  

TIP: If using the internal email option for WO Print Queue as the event, the number set for the Days 
before Projected Start Date determines when the Submit To person receives email notification that the 
work order is in the Print Queue and is ready for printing. 



 

Designer 2013 Guide Cityworks Setup    89 

4. If desired, select the default printer to which this work order type is printed.  

NOTE: If the default printer is left blank, the work order prints on the user’s default printer.  

5. Select the By default print radio option for Work Order, Map, or Both.  

To automatically activate the Map printing options box on the work order Print tab, the administrator 
must select the Map or Both option on the Designer Printing tab. The user can also activate the box by 

selecting either Print Map Only or Print Both on the work order Print tab or deactivate it by selecting 

Print WO Only. 

6. If printing the map, select the Map Settings on the right pane.  

 Default Map Template—Type in the name if there is a custom ArcGIS layout or double-click in 

the field to open a browser box for locating the file.  

NOTE: The default location for .mxt files is in Program Files > ArcGIS > Bin > Templates directory. 

 Print map with scale (x) times the extent of the selected set—Type the desired number 

in the blank to determine how much space around the selected set is included in the printed 
map. The default is set at 2 which adds either half the length or width of the selected set to each 

side, adding more background. Set to 1, the map prints the selected set to the margins with no 

additional background in either width or length.  

 Single Map for ALL Features—Select this radio button to print a single map containing all of 

the features attached to the work order.  

 Individual Map for EACH Feature—Select this radio button to print an individual map for each 

feature attached to the work order.  

NOTE: By default, the map is set to print in a portrait layout. 

7. Click the Save button to save the selected information.  

Security Tab 

The Security tab sets the group permissions for who has what access to the work order type. In 2012.1, the 
group rights for work orders, service requests, and inspections were simplified. Please read Knowledge Base 

article 10619 for more information on the Group Rights Migration tool.  

NOTE: Security may be set for multiple work order templates on the Cityworks Setup > Template 
Security. 

1. Switch to the Security tab. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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2. Select the group on the left pane. 

3. Select the work order table(s) from the center pane that the selected group needs to access. 

4. Check the applicable box(es) for Security Options. 

 View—Permission to open a work order to view the information only. 

 Add—Permission to create and add information to a work order, such as comments, labor, 

materials, equipment, tasks, etc.  

 Update—Permission to edit work order information and change the Submit To employee on a 

work order after it has been saved. 

 Delete—Permission to delete work order information.  

IMPORTANT: Users who are adding labor, material, and equipment costs need Delete permission for the 
LaborCost, MaterialCost, and EquipmentCost tables in case the values entered need to be modified.  

NOTE: Azteca Systems Inc. does not recommend deleting work orders from the WorkOrder table; 
cancelling a work order is the recommended method of inactivating a work order because it still allows for 
viewing the information and leaves the historical information intact. Limit the users with Delete permission to 
WorkOrder. 

 View Cost—Permission to view costs. Check View Cost for the LaborCost table to allow a 

group rights to view the labor costs on the Labor pane of the work order. Check View Cost for 
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the LaborCost, MaterialCost, and EquipmentCost tables to display the Work Order Cost 

Summary form from a work order, accessed from the Tools menu.  

NOTE: All employees can view costs for materials and equipment on the right pane of a work order. 

5. Click the Update button to add the information to the Existing Security list on the lower pane. 

6. Continue adding all the desired groups by repeating steps 2-5. 

Budget Plan Tab 

The Budget Plan uses information from the Labor, Materials, and Equipment tabs to project a budget 
for the work activity. A Daily Budget and Total Budget are displayed on the tab. These budget projections 

can be saved by year.  

TIP: If different areas need different budgets for the same work template, a work order template may be 
cloned to project these budgets separately. See section on Cloning Work Order Templates. Cloning a work 
order template does not clone budget information. 

Gray fields are user-defined in a Codes box by entering the desired Code and Description to match 
whatever the organization wishes to track. White fields indicate fields where numeric data is entered. 

Calculations are based on the information entered so changing the values yields different results and can be 

used to obtain the desired results. Crew Days and Labor Days fill in when the % is entered for the month. 
Red text in the Target column indicates that further adjustments in the budget plan are necessary to reach 

the desired target; green text indicates the projection plan is on target.  

Budget plans can be compared to the actual work accomplished on the Budget Reports tab in the 
Cityworks Report Engine of the Cityworks Desktop software. They can be used to more accurately predict 

future budgets and determine cost projection, productivity, optimal crew size, etc. The gray, user-defined 
fields can be used to group the results.  

Tracking work progress against the desired or anticipated levels at regular intervals promotes crew 

accountability and efficiency, improves data quality and more accurate tracking of the material inventory 

needed, and provides administrators with reliable indicators for infrastructure management decisions. Budget 
plans can play an important role in a work management system.   

Some settings in Others > Preferences determine the layout and selection on the Budget Plan tab. The 

year shown begins with the month selected for the First Month of the Fiscal Year. The Default Workday 
Hours and Default Applied Overhead Percent load in the corresponding fields. The Budget Range 

Years determines the years that are listed in the Budget Year dropdown selection.  
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The following calculations are performed by the software.  

NOTE: Avg. Crew Size is imported from the Labor tab. Daily Budget populates the Labor, Materials, 
and Equipment with the totals set up on the respective tabs and totals these together for the total Daily 
Budget. 

 Crew Days = Work Qty ÷ Avg Daily Production 

 Unit Cost = Total Budget ÷ Work Qty 

 Labor Hours/Day = Workday Hours x Avg Crew Size  

 Total Budget = Daily Budget x Crew Days (for Labor, Materials, Equipment, and totals 

these three items in the Total Budget) 

1. Switch to the Budget Plan tab.  

IMPORTANT: If at any point during the data entry, you need to switch tabs to Labor, Materials, 
Equipment, or any other view, always save the information already entered as the Budget Plan tab reverts 
back to the last view saved when it is reopened.  
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2. Select the desired Fiscal Year from the dropdown or type it in the field.  

3. Double-click in each of the gray boxes in the Management frame to open a Codes box and type in 

a Code and Description in the fields at the bottom and click the Save button to save to the list. 
Add as many codes as needed. Double-click (or select and click the Select button) to load the 

information in these fields.  

NOTE: These description fields may be used for any information the organization wishes to track in 
association with the work order template. The Code and Description are fully customizable for each field in 
the Management and Cost sections. Possible examples are shown for each. 

 Management Unit—Use for dividing an area into geographic zones or management units, 

especially if accounting and reporting is managed separately. 

 

 Unit Description—Use to describe how the management unit is divided or to detail the asset 

inventory for the work activity. 

 

 Activity Program—Use to describe the work activity program.  
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 Activity Code—Use to further describe the activity. 

 

4. Type the Inventory in the Cost frame and double-click in the gray field to open another Codes 

box. Type in the desired codes and descriptions for the Inventory as described in step 3 and load 
the desired Description in the field. 

     

5. Type the multiplier in the x Effort Level field and double-click in the gray box next to x Effort 
Level to open another Codes box for defining the codes and descriptions for the Effort Level. 

Follow the same procedure described in step 3 to load the desired Description in the field.  

NOTE: Effort Level can be used to express the quantity of work expected per asset, such as the average 
number of potholes per mile, or it may indicate the job requires more effort in certain terrain or weather 
conditions. The Effort Level multiplier may be a 2-place decimal. 

 

6. Double-click in the field to the right of the Work Qty field to open a Codes box and follow the same 
procedure described in step 3 to load the desired Description in the field.  
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NOTE: Work Qty is automatically populated and calculated by multiplying the Inventory by the Effort 
Level. 

 

7. Type the average number of assets from the Inventory for which the work activity can be 

completed in one day in the Avg Daily Production field and double-click in the description field to 
open the Codes box. Follow the same procedure described in step 3 to load the desired Description 

in the field.  

NOTE: A decimal may be entered in the Avg Daily Production field to indicate the portion of the work that 
can be completed in a day. For example, if it takes four days to complete work on one asset, enter .25. 

 

8. If desired, enter the Workday Hours and/or Applied Overhead if different than the default 

settings set in Preferences.  

NOTE: Applied Overhead may reflect any additional costs, such as for utilities, maintenance of equipment, 
the average benefits package per department or crew, etc. 

9. In the Work section, type in the Percent of the job that needs to be accomplished per month. Use 

<Ctrl + R> to fill in the boxes forward if the same value is wanted for each month.  

NOTE: <Ctrl + R> overrides any information already entered. The Crew Days and Labor Days of the 
work completed are calculated according to the Avg Crew Size displayed above when the Percent is 
entered. Crew Days and Labor Days can be modified if desired by typing in the field. 

 

10. Modify the information as needed to match the targets.  

11. If desired, check the Lock Budget box to prevent any changes from being made to the budget. All 

fields with the exception of Budget Year are grayed out as well as all the buttons except for Save 

and Print.  

TIP: Locking the budget for prior years keeps the information intact so that the values cannot be changed by 
refreshing or accidentally modifying the information. 

12. Click the Save button to save the budget to the list at the bottom of the pane. 
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If the Total does not match the Target (if there are any red numbers in the Target column), a message 

box opens to warn the administrator. If the Total is close enough, click Yes to save the budget plan as is. 

Click No to modify the plan.  

 

Once a budget plan is saved, it may be opened by selecting it from the list at the bottom or from the Budget 

Years dropdown selection at the top. Scroll across to view the rest of the fields. 

To create a budget for another year, select the Budget Year from the dropdown selection. A message box 
opens to see if the same settings are wanted as the year currently displayed. Click Yes to import the 

information and make any necessary modifications; click No to clear the information and begin again.  

The Refresh button allows the administrator to apply changes on the Labor, Materials, and Equipment 
tabs for updating costs.  

IMPORTANT: If changes have been made to labor, materials, or equipment, do not refresh budget costs for 
prior years.  
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Inspections Tab 

The Inspections tab for Cityworks Server AMS users allows default custom inspections to be linked to the 

work order to automatically create the inspection every time a work order of this type is created. Create the 
inspections under Cityworks Setup > Custom Inspection Templates and select the desired asset type(s) 

for the inspection to list the inspections on this tab.  

NOTE: Refer to Custom Inspection Templates for information on how to create these inspections. 

1. Switch to the Inspections tab. 

 

2. Select the inspection from the panel on the left. Use Ctrl or Shift to make multiple selections.  

3. To create associated inspections, follow these steps: 

 Check the Auto Create checkbox. 

 Select either Initiate or Close from the Event dropdown. Select Initiate if you want the 

inspection interval to begin from the date that the work order is initiated. Select Close if you 

want the inspection interval to begin from the date that the work order is closed. 

 Enter an Interval Number. 

 Select an Interval Unit (Days, Weeks, Months, or Years).  

4. Click the right arrow to save the selected inspection(s) as Default Inspections.  

NOTE: Double-clicking on an inspection moves it to the other list. An inspection only shows up on one list at 
a time but can easily be moved from one to the other. 

5. Click the Update button to add the information to the Cityworks Database. 
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Cloning Work Order Templates 

Once all the setup has been completed for a work order template, the settings can be applied to new 

templates by using the cloning functions on the General tab. Templates can be cloned to the same asset 
using the Clone button or a description can be applied to other assets using the Clone to Entities button. 

The Clone button adds new work order templates to the selected asset type. 

1. Select the desired asset and a work order template with the desired information to clone. 

2. Click in the Description field and enter a new Description to activate the Clone button. 

 

3. Click Clone to copy all the information set on the tabs over to the new work order template.  

NOTE: Cloning does not add information to the Budget Plan tab. This must be set up by year for each 
template. 

4. Check the information on the tabs and modify as needed for the new work order activity. 

The Clone to Entities button applies the selected work order activity and all its settings to additional assets.  

1. Select the desired work order Description to clone to other assets. 

2. Click the Clone to Entities button to open the Clone Workorder Templates To Entities box. 

 

3. Select the desired asset group from the Asset Group dropdown. 
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4. Select the radio button option for Features (default setting), Objects, or Others.  

5. Select the desired asset(s) from the list, using the Shift or Ctrl key for multiple selections. 

6. Click the Clone button.  

A progress bar opens at the bottom of the box until the cloning is complete.  

  

7. Click OK when the Summary box opens to say the clone is complete. 

8. If desired, change the Asset Group and/or radio button option and select any additional assets to 
which to apply this work order Description. 

9. If desired, modify the Description and repeat steps 2-6 to clone additional templates. 

10. When cloning is complete, close the box. 

Custom Field Templates 

Custom Field Templates adds custom fields to requests, work orders, and predefined inspections or tests.   
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1. Select Request, WorkOrder, or a predefined inspection or test from the Apply to Table field.  

2. Type the desired Category in the Add/Modify field and add a Description OR select from the 
Existing Categories list. 

3. Click Save. 

4. In the panel on the right, enter the Field Name.  

5. Select the Field Type from the dropdown selection. If additional information is needed, related fields 

are displayed. 

 Date 
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 Numeric—Opens Min Value and Max Value fields for setting the minimum and maximum 

ranges for defining valid values.  

 

TIP: Beginning with Cityworks 4.5 sp 5, the software now validates that a number was entered. Prior to this 
release, if no valid values were entered (at least the Min Value), no restrictions were placed on the type of 
data a user could enter. 

 Varchar—Opens a Code Type field and radio button options for Use Description or Use 
Code to designate whether to display the code or the description on the work order. For free-

form response, leave the Code Type blank. 

 

Define possible responses by clicking in the Code Type field to open the Codes box for selecting the 
applicable code and select the radio button option for how to display the information on the work order.  
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Populate the Code and Description in Others > Codes. Select the Asset Group from the dropdown, enter 

a new Code Type beginning with the letter already found in the field, enter the Description, and click the 
Save button. Populate the Code Type on the right pane by typing each Code and Description in the two 

boxes at the bottom of the pane and clicking the Save button.  

NOTE: Code Types begin with a letter corresponding to the Asset Group selected. For codes that apply to 
more than one asset group, select Others as the Asset Type. Others custom codes begin with the letter A. 
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6. Check the box for Is visible? to display the field on the request, work order, or inspection.  

TIP: Uncheck the Is visible? checkbox to track a field with a default value to prevent users from changing 
it, for example, tracking an internal accounting code fund structure on each work order activity type to 
reconcile work order costs back to a financial system. 

7. Check the box Is required? for fields where a response is needed by the organization.  

NOTE: Values for all required fields must be entered before a work order can be closed. 

8. Check the box for Always sort by code? to always sort the list displayed on the request, work 
order, or inspection by the code.  

9. If desired, enter a Default Value for the custom field.  

NOTE: Default values can be used to track any information the organization needs, such as internal codes to 
link back to another application, permitting information, etc. 

10. If desired, enter a Link Field Name to integrate work orders to applications with unusual field 
names.  

NOTE: The Link Field Name field is not seen or used by the end user. Give the field a logical custom name 
and place the third-party system’s name in the Link Field Name. 

11. Click the Save button on the Define Custom Fields pane to save the custom field to the Existing 
Custom Fields list.  

The Existing Custom Fields list contains these display columns to allow the administrator to see all the 

custom information for the category selected on the left frame. 
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 Field Name 

 Field Type—Date, Numeric, or Varchar. 

 Visible—Y or N; available to users. 

 Required—Y or N; required fields must be populated before a user can save. 

 Code Type—Applies only to Varchar and only if the administrator defines a custom code to 

specify values for a selection list. 

 Code/Desc.—If using a Code, this column shows whether the user will see the Code or 

Description list. 

 Min. Value—Use to set a minimum value for the Numeric field. 

 Max. Value—Use to limit the value so it must be lower than the value listed. 

 Default—Lists a Default Value if one was selected for the field. 

 Link Field Name—Lists the field from another application to link to Cityworks. 

 Always Sort by Code—Y or N; indicates if the list is sorted by the code.  

12. Add all custom fields for the selected category by repeating steps 5-10. If needed, a field can be 

edited by double-clicking on it in the Existing Custom Fields list to load it back into the Define 
Custom Fields frame, making the desired edits, and clicking the Save button. 

13. Add custom fields for all additional categories by repeating steps 1-11. If the same fields that were 

set up for one category are wanted in another category, click the Select button on the right pane to 
open the Select Custom Field(s) box.  

Select the Category on the left and the field(s) on the right. 

14. Click OK to add the selected fields to the new category. 
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Deactivating a Custom Field Category 

If a custom category is no longer needed, select it from the Existing Categories list and click on the 

Inactive radio button option on the lower left pane. Inactive prevents the fields from being displayed on 
any future work orders but retains the fields on all previous work orders where they appear, thus keeping the 

historical data intact. 

Deleting a custom field category or field is allowed to facilitate the setup; however, it is designed for use only 
in the case where a selected custom category has never been used. A message opens to confirm the deletion 

as this will remove either the category or specific field and all the related customer field data. Click Yes to 
delete the custom category or field.  

IMPORTANT: If the custom category or field has been used, Azteca Systems Inc. recommends deactivating 
the category to preserve the history.  

Contractors 

The Contractors function tracks contractor information with their contracted rates. This contractor 

information is available for adding contractor labor, material, and/or equipment costs on a work order.  
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The Contractors window is similar to Request Templates with the tree on the left and the list on the 

right. The same contractor may be placed in multiple domains as well as multiple locations within the 
hierarchy.  

NOTE: Assemble the tree using the New Trunk, Add Category, and New Item buttons, as described in 
the section Setting up Data Trees. 

 

The New Item opens the Contractor Edit box for adding the details. Once the contractor is added, it may 

be opened for updating from the list on the right by double-clicking on the desired contractor or the leaf on 
the left. Contractor information may also be added using the Cityworks Data Template.  

1. Set the value for each field in the Information pane. The window opens with these default values. 

TIP: All field types and lengths are listed in the ContractorLeaf tables in Appendix 2: Cityworks Data 
Template Fields. 
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 Name—Type in the name of the contractor, up to 35 characters in length.  

NOTE: The Name field cannot be changed once the contractor is saved, except by deleting the contractor 
and then adding it back in again. 

 Description—Type in the full name of the contractor if it did not fit in the Name field, a 

description of the service(s) this contractor provides, or any other descriptive information desired. 
A maximum of 50 characters is allowed.  

 Overtime Factor—Type in the number by which to multiply the pay rate for any overtime 

incurred. This is set to 1 by default, meaning that the regular rate applies to overtime work.  

 Emergency/Holiday Factor—Type in the multiplier for any emergency work or holiday pay. 

The default value is 1. 

TIP: If nothing is entered in the Overtime Factor or Holiday/Emergency Factor fields, no additional 
labor is added to the usual rate. If these rates are used in addition to the regular labor rates, enter numbers 
less than 1. If only the overtime or holiday/emergency rate is applied, enter numbers greater than 1. 

Type in the following contractor information: 

 Address—Type in the contractor’s street or mailing address.  

 City 

 State 

 Zip code 

 Cell Phone 

 Office Phone 

 Other Phone 

 Fax 

TIP: All phone and fax numbers allow for 50 variable text characters so multiple numbers can be stored in a 
single field. 
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 Email—Allows a maximum length of 250 characters for entering multiple email addresses. Use a 

semicolon to separate each address. 

 Contractor Number—Type in the reference number used to track the contractor.  

NOTE: Contractor Number may be a contract number, a contractor number, or any alpha-numeric ID up to 
15 characters in length. 

 Contact Name  

 Locally Based—Toggles between Yes and No to indicate whether the contractor is locally 

based or not. Yes is the default value. 

 Comments—Record any additional information about the contractor, up to 256 characters. 

 Federal Tax Id—Enter the contractor’s federal business ID number. 

 FMS No. —Enter the Financial Management System (FMS) number.  

 PIN—Enter the Personal Identification Number (PIN) for the FMS number. 

 Registration Date—Enter the date the contractor received their FMS number. 

 Minority / Women Owned Business Enterprise—Toggles between No and Yes to indicate if 

the contractor qualifies as a minority and women business enterprise (MWBE). No is the default 
value. 

Enter the contractor’s insurance information. The amount fields are numeric, allowing allow up to 12 digits 
with 2 decimal places, and have a default value of 0. For older vehicles, a contractor may elect to carry only 

general liability coverage. 

 

 Liability Insurance Amount 

 Liability Insurance Certificate—Enter the certificate number for liability coverage. 

 Liability Insurance Effective Date 

 Liability Insurance Expiration Date 
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 Worker’s Comp Amount—Enter the amount of worker’s compensation insurance the 

contractor carries to cover their workers.  

 Worker’s Comp Certificate 

 Worker’s Comp Effective Date 

 Worker’s Comp Expiration Date 

 Automobile Insurance Amount  

 Automobile Insurance Certificate 

 Automobile Insurance Effective Date 

 Automobile Insurance Expiration Date 

 General Liability Amount  

 General Liability Certificate 

 General Liability Effective Date 

 General Liability Expiration Date 

 Visible in Server—The default is set to Yes to allow the contractor information to display in 
Cityworks Server AMS. Click to toggle to No so it doesn’t display in Server.  

2. In the Overhead box, type in the Rate and select the radio button option for how the overhead is 

calculated into the contractor cost (Percentage or Hourly). Leave blank if overhead is not 
applicable to this contractor. 

3. In the Rate Type box, type in the Amount and select the radio button option for how this 

contractor is paid:  

 Hourly—Cityworks uses this rate to calculate labor on the work order by multiplying it by the 

number of hours. 

 Fixed—Cityworks places this fixed value in the labor cost field when this contractor is selected.  

TIP: Fixed is the most flexible rate because it allows the user to modify the labor cost. Hours may still be 
tracked, but do not affect the fixed amount. 

 Per Unit—Cityworks multiplies this amount by the total number of units to calculate the labor 

cost.  

4. In the Provides box, check the box(es) for all resources this contractor may provide (Labor, 

Material, and/or Equipment).  

NOTE: Provides is for information only. Contractor labor, materials, and/or equipment may be added to 
Cityworks work orders for all available contractors regardless of which boxes are selected here. 

5. Optional for licensed contractors: Check the Licensed box to activate the other License 

Information. 

 Expiration Date—Type in the field or use the dropdown arrow to open a calendar. By default 

the current date loads in the field. 

 Type of Work—Enter a description of up to 250 characters. 

6. Click the Save button to save the contractor. 
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7. Type a keyword in the Keywords box and click the Add button to list them. Do this for each 

keyword.  

The contractor must be saved in the database to generate the SID which provides the link for the keywords 
before they can be added or an error message opens to remind the administrator to first save the contractor.  

NOTE: Keywords are automatically saved in the database when the Add button is clicked. 

8. Optional: Add custom fields for collecting more contractor information. Go to Others > Custom 

Data Fields and select ContractorLeaf from the Tables dropdown. Type in the Field Name, 
select the Field Type and any associated fields that open up for the selected type, check the box for 

Field Visible and/or Field Required, and click the Save button to add it to the list and place it in 

the Contractor Edit window.  

NOTE: See Custom Data Fields for more information. 
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9. If any Custom Fields are listed, double-click in the Value column in the box to open a Codes box 
or Enter Value box. Follow the prompt to enter the value, and click OK.  

NOTE: The type of Enter Value box depends on the selected Field Type and the parameters set in step 8. 

  

10. Click the Save button to save the custom field values.  

Equipment 

Use the Equipment function to list all the equipment owned and used by the organization. Include all 
equipment that may be charged to work orders. The Cityworks Equipment Manager add-on also accesses this 

information for equipment check in/out and reserving.  

NOTE: Additional equipment items may be added to Cityworks Equipment Manager for tracking purposes 
even if they are not charged to work orders. 
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The Equipment window has a tree on the left and equipment list on the right. Build the tree using the 
toolbar buttons as described under the section Setting up Data Trees. Equipment lists may be imported using 

the Cityworks Data Template and then placed into the tree structure. Equipment may be selected from the 
list and dropped into a folder in the hierarchy. 

 

Once the equipment list is in the database, additional items may be added by clicking the New Item button. 

Equipment information may be edited by double-clicking on the equipment in the hierarchy or ID list.  

1. Type in the ID, up to 20 characters.  

NOTE: Once the ID has been defined and saved, it cannot be edited. 
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2. Type in the Model, 15 characters maximum, and Manufacturer, 20 characters maximum.  

3. Type in the Description, up to 56 characters. 

4. Optional: Type in the Warranty Date.  

NOTE: Equipment Warranty Date is not used on the work order. 

5. Optional: Click in the Image field to open a box for navigating to the image file path.  

NOTE: Image files need to be stored on a network drive for the images to be accessible to all users. 

6. Type in the Unit Cost and select the radio button option for Hourly or Fixed to determine how the 

equipment costs are calculated on the work order.  

NOTE: Hourly is the default. Fixed always adds the same cost to the work order, but allows for editing that 
cost and can still track the actual hours used. 
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7. Optional for users of Equipment Manager: Check the box For equipment check in/out only if this 

equipment is not to be added to the work order.  

NOTE: Checking the For equipment check in/out only prevents the item from showing up on the work 
order equipment list, forcing it to be issued through Equipment Manager. 

8. Optional for Server users: Uncheck the box for Viewable in Server if the equipment is not to be 

listed in the current selection list in Server. This inactivates the item but still allows for searching on it 
and maintains its history.  

NOTE: By default Viewable in Server is checked for all equipment items. 

9. Click the Save button to generate the unique equipment ID. 

10. Type a keyword in the Keywords box and click the Add button for each keyword.  

An error message opens to alert the administrator to save the equipment first, as the SID assigned when the 
equipment is saved provides the link to the keywords in the database.  

11. Add any desired custom fields under Others > Custom Data Fields and select EquipmentLeaf 

from the Tables dropdown. Type in the Field Name, select the Field Type and any associated 

fields that open up for the selected type, check the box for Field Visible and/or Field Required, 
and click the Save button to add it to the list and place it in the Equipment Edit window.  

NOTE: See the section on Custom Data Fields for more information. 

12. If there are any Custom Fields listed, double-click in the Value column in the box to open an Enter 

Value box, follow the directions listed there to enter the value, and click OK.  

NOTE: The type of Enter Value box depends on the selected Field Type and the parameters set in step 10. 

 

13. Optional: Add any desired Attachments by double-clicking in the field and navigating to the desired 

file. 

14. Click the Save button to save the custom fields.  

NOTE: Keywords and attachments are automatically saved in the database when you click Add. 
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Materials 

The Materials window lists materials used on work orders. Many fields defined on the Material Edit 
window are displayed with the material in columns on the work order Material pane. Some fields are for 

organizations using the Cityworks Storeroom add-on software and some for users of Miner & Miner’s Designer 

interface. 

 

 

The Materials window consists of two tabs and accesses a Material Edit window for material details with 

an additional five tabs. 

Materials Hierarchy Tab 

The Materials window contains a Hierarchy tab for organizing materials into a tree on the left and an 
alphabetical list on the right, like contractors and equipment.  

NOTE: See Importing Data and Setting up Data Trees for directions on setting up materials. Materials may 
also be set up in Cityworks Storeroom. 

Once the Materials tree and list is complete, a Material Edit form may be opened by double-clicking on the 
material in either the tree or from the list. A new material may be added by clicking the New Item button 

which opens the Material Edit form for entering the data. 
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Materials General Tab 

The General tab contains material information such as model, manufacturer, cost, supplier, part number, 

storeroom stock, keywords, custom fields, and attachments. While every field may not be applicable to every 
material, populate as many fields as possible. Much of the information is displayed on the work orders and 

some fields may be used for searches. Azteca Systems Inc. recommends populating the ID (required), 

Description, Unit of Measure, Unit Cost, Min. Quantity, and Cost Type.  

If Cityworks Storeroom is installed, some fields may have locks placed on them to allow that material 

information to be maintained and edited in Storeroom only. Check the Preferences setting for Allow 

Materials Edit in Designer to enable or disable this capability. 
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1. Enter the following fields: 

 ID—Key identifier of 20 characters or less 

 Description—A 40-character field listed with the ID as a separate column on the right pane or 

separated by a tilde in the tree on the left 

 Model—Manufacturer’s material ID, up to 15 characters 

 Manufacturer—20 characters or less 

 Detail—150 additional characters allowing a more detailed description of the material  

NOTE: The Detail field is not displayed on the work order. 

2. Select the Unit of Measure from the popup box of UNITMEAS Codes. Double-click on the desired 

code or select it and then click the Select button). 

NOTE: You can add codes by typing in the Code and Description at the bottom of the box and clicking 
Save. UNITMEAS codes can also be populated in Others > Codes under the Asset Group: Others.   
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NOTE: Since unit measure codes are user-defined, they may vary from those shown above. 

3. Select the recommended Audit Interval for the frequency of performing audits on this material 

from the popup AUDITINT Codes box.  

NOTE: AUDITINT Codes are set up in Others > Codes and are user-defined so may vary from those 
shown. 

 

4. Type in the Unit Cost. 

5. Type the desired minimum quantity desired to keep on hand in the Min Quantity field.  

NOTE: Min Quantity is used to search for all materials with less than the desired minimum quantities. This 
is the quantity considered to be the re-order point. 

6. Type in the Supplier, up to 20 characters. Storeroom users: Select the Supplier from the dropdown 

list which is populated in the Storeroom add-on.  

7. Type in the Part Number, up to 20 characters. 
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8. For Storeroom users: Select the radio button option for Cost Type to use on work orders. Current is 

the default setting.  

NOTE: Weighted Average, FIFO, and LIFO cost types are for the Cityworks Storeroom add-on product. 
Cityworks administrators may set up storeroom information in Designer or in Storeroom. Storeroom is the 
only Cityworks application that contains code to work with these other three cost types. 

 Weighted Average—Totals all the costs for the selected material divided by the number of 

units on hand.  

 Current—Uses the current price of the material when it was most recently received.  

NOTE: If the Cityworks Storeroom add-on is not used, the Current value must be manually entered for each 
shipment. 

 FIFO—“First in, first out” inventory method which uses the older unit costs first when distributing 

parts until the older inventory is gone and then the newer unit costs are used for the newer 
inventory. 

 LIFO—“Last in, first out” inventory method which uses the most recent costs first when 

distributing parts until the newer inventory is gone and then uses the older unit costs for the 
older inventory. 

9. Miner & Miner Designer Users: Select the CU (Compatible Units) Category from the dropdown.  

Populate the CU Category in Others > Codes > ACUCAT. 

 

Type the geodatabase information in the GDB Table Name and GDB Subtype fields for materials that are 
represented by feature classes in the geodatabase.  

NOTE: GDB Subtype is the subgrouping of the geodatabase object. 

10. Optional for Server users: Uncheck the Viewable in Server checkbox to remove the material from 

the current selection lists in Server but still allow the material to be included in searches and the 
history to remain intact.  

11. Optional: Click in the Image field to navigate to an image file and load the image in the top right 

corner.  

TIP: Store image files in a network location accessible to all users. 

12. Add any desired Custom Fields for materials under Others > Custom Data Fields, selecting 
MaterialLeaf from the Tables dropdown, typing in the Field Name, selecting the Field Type and 

any associated information, entering a Default Value, checking the applicable boxes for Field 
Visible and/or Field Required, and clicking the Save button for each custom field. 
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13. Populate the Custom Fields by clicking in the Value column to open a selection box, Choose a 

Date, or Enter Value box and select the value or follow the prompt to enter a valid value, and click 

the Select or OK button to load the value.    

Required fields must be populated or a message opens when saving to tell the user to enter a value in the 

required custom field listed.  

14. Click the Save button to save the material and material information to the database and generate a 

material SID.  

15. Type a keyword into the Keywords field and click the Add button. Do this for each possible 

keyword. 

NOTE: Keywords, Storeroom information, and Attachments are saved using the Add button located in 
their respective boxes. Keywords and Storeroom information are saved to the database one entry at a time. 

16. Select the Storeroom from the STORERM Codes popup box adding the storerooms needed, type 

in the Stock on Hand for the selected storeroom and Location within the storeroom where the 

material is stored, and click the Add button.  

NOTE: Storeroom add-on users must populate these Storeroom fields. If no information is added to the 
Storeroom box, the Total Stock remains 0. 
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If no information is added to the Storeroom box before the Material Edit box is closed, the software loads 

N/A in the Storeroom and Location fields with zero Stock on Hand. 

17. Add any applicable Attachments by clicking the Add button to open a browser box, locate the file in 
a network location, and click Open to load the path into the list. Do this for each desired file.  

TIP: Multiple Attachments may be added at the same time if they are located in the same folder. 

 

18. If the defined material requires assembly, follow the steps under Assembly Parts Tab, Labor Tab, and 

Equipment Tab to add the additional information to the material.  

19. To add a new material, click the Clear button to clear the fields and follow steps 1-17.  

20. Close out of the Edit Material box when finished adding materials using the Close button at the 
bottom of the form or the red X in the top right corner. 

To delete a material, click the Delete button and click Yes when the confirmation box opens asking if the 

user wants to delete the material.  

IMPORTANT: Storeroom stock must be zero before a material can be deleted. A Delete Error message 
opens to alert the user that material cannot be deleted where stock exists.  
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Assembly Parts Tab 

A material can be assembled from multiple materials and can include labor and equipment needed for the 

assembly. This may be used with or without the Miner & Miner Designer application. Define all the 
components as materials and then add another material for the assembly and add the parts on the 

Assembly Parts tab. 

1. Switch to the Assembly Parts tab. 

 

2. Load the material(s) in the center right pane by one of the following methods.  

NOTE: Multiple materials may be listed at the same time using any of the three options. 

 Keyword—Type a keyword in the Keyword field and press Enter to list the associated material 

parts. 

 Hierarchy—Select Hierarchy from the dropdown (or type h into the field) to open the Select a 

Material Group popup box and navigate to the desired folder or leaf to load the material(s) into 
the list. If a folder is selected, all the materials in the folder are listed.  
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 Name—Select Name from the dropdown (or type n into the field) to list the materials. 

3. Select the material wanted from the list and enter the Quantity needed to assemble one unit. The 

Quantity entered must be a positive, whole number or an error message opens stating that the 
quantity cannot be a decimal value because fractional parts cannot be added.  

TIP: If necessary, divide the Unit of Measure into smaller increments so whole numbers may be used in 
the Quantity field. 

4. Click the Add button to add the material to the list at the bottom.  

5. Repeat for each material needed. 

The combined material cost for the items and quantities shown on the Assembly Parts tab is loaded on the 
General tab in the Unit Cost field which cannot be edited from the General tab. 

Labor Tab 

The Labor and Equipment tabs allow a material to be configured as a compatible unit. If estimated cost 
units are added to a material, they are copied to the work order estimated labor and equipment costs when 

this material is added to the estimated material costs. This information can be selected for actual costs by 

using the Predefined dropdown option on the work order.  

Add the labor needed to assemble the parts on the Labor tab. 

1. Switch to the Labor tab. 
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2. If necessary, change the radio button option from the default Employee setting to Contractor. 

3. Load the employees or contractors into the center pane by one of the following methods. 

 Keyword—Type a keyword into the field and press the Enter key.  

 Group Name—Select from the dropdown list for Group Name to load the employees in the 

group.  

 Employee Name—Select from the Search by dropdown list to populate the list. 

 Contractor Name—Select from the Search by dropdown list to populate the list. 

 Contractor Hierarchy—Select from the Search by dropdown to open the Select a 

Contractor Group box, select a folder or contractor, and click OK. 
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4. Select the employee(s) from the list using <Shift + click> or <Ctrl + click> for multiple selections.  

5. Select the Activity from the dropdown list. Populate this list in Others > Codes > AMATACT.  

NOTE: Activity is utilized in the Miner & Miner Designer interface. 

6. Enter the Work Description and the No. Hours required. 

7. Click the Add button to list the employee(s) with the labor on the bottom of the pane. 

To remove labor from the list, select the employee(s) or contractor(s) and click the Remove button.  

Equipment Tab 

Add the equipment needed to install, remove, or repair the assembly on the Equipment tab. The information 
added here is added to the work order estimated equipment when the material is selected. 

1. Switch to the Equipment tab. 
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2. Load the equipment on the center pane one of the following ways.  

 Keyword—Type a keyword into the Keyword field and press the Enter key to load the 

equipment. 

 Name—Select from the Search By dropdown to load all the equipment.  

 Hierarchy—Select as the Search By field to open the Select an Equipment Group and select 

the equipment leaf or folder from the tree to load the equipment.  

 



 

Designer 2013 Guide Cityworks Setup    127 

 

3. Select the equipment needed from the list on the center pane. 

4. Select the Activity from the dropdown list.  

NOTE: See step 4 of the preceding section for where to populate the Activity list. 

5. Type in the number of Hours Required for using the equipment. 

6. Type in the Units Required if different than 1. 

7. Optional: Type in the Description of the equipment use. 

8. Click the Add button to list the equipment information at the bottom of the pane. 

Use the Remove button as needed to remove any incorrect information. 

Reserved Tab 

The Reserved tab lists the work order IDs, units required, and projected start date for any open work orders 

within the specified date range which have the selected material added to the estimated material cost list. 

1. Switch to the Reserved tab. 
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2. Select the From and To date ranges using the dropdown calendars or clicking on the month, day, 
and/or year and typing in the desired date.  

NOTE: See the section on Date Fields for more information on setting the date. 

TIP: Today’s date is listed at the bottom of the calendar and can be selected by clicking anywhere along the 
bottom of the calendar. 

3. Click the Show Reserved button to display information for the reserved material. The Total number 
is tallied and displayed in the bottom left corner. 

Search Stock on Hand Tab 

The Search Stock on Hand tab allows an administrator to query for materials by ID, supplier, 
manufacturer, model, part number, storeroom, quantity, minimum quantity, cost, etc. Wildcard searches may 

be used for all fields except for Cost Type, Stock on Hand, and Unit Cost. 

1. Close the Material Edit window and switch from the Hierarchy tab to the Search Stock on Hand 
tab. 
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2. Select the Current Domain from the dropdown. 

3. Select the desired parameters for the search, using % before and after for a wildcard search if just 

part of the information is known or more results are wanted. 

 Material ID—Select from the dropdown to determine how much stock of a particular material is 

on hand or type in a wildcard search.  

TIP: If a material is selected on the Hierarchy tab from the tree or the list, it automatically loads into the 
field when the Search Stock on Hand tab is opened. 

 Description—Type in all or part of the description to list the matching materials. 

 Manufacturer—Type in all or part of the manufacturer’s name to list materials obtained from a 

particular manufacturer. 

 Part Number—Type in all or part of a part number to list the materials. 

 Model—Type in all or part of the model number to list the materials. 

 



 

130    Cityworks Setup Designer 2013 Guide 

 

 Supplier—Select from the dropdown to list materials obtained from a particular source or type a 

wildcard in the field. 

 Storeroom—Select from the dropdown to list which storeroom(s) to search or type a wildcard in 

the field. 

 Location—Select a location within a storeroom to list all the materials found there.  

TIP: Use Location to generate a list of materials for performing an audit. 

 Cost Type—Check any or all of the boxes to search by cost type.  

NOTE: See Materials General Tab for descriptions of the cost types. 

 Stock on Hand—Select the quantifier (less than, less than or equal to, equal to, greater than, or 

greater than or equal to) from the dropdown symbols and type in a corresponding value or use 
the dropdown to select MinQuantity or Total MinQuantity as the search parameter. 

 Unit Cost—Select the quantifier, less than, equal to, or greater than, from the dropdown 

selection and type in a corresponding value.  

4. Select the display fields from the upper right pane, Display these Fields in the Search Results.  

NOTE: The UID (user-defined ID) is always displayed as the first column. 

5. Click the Find Item(s) button to list the Search Results at the bottom of the pane.  
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If doing a less than Total MinQuantity search, StockOnHand and Storeroom are not displayed but are 
replaced with a column for TotalStock.  

The Clear button clears the search parameters and the results so a new search can be performed.  

The Material Edit box may be opened for any of the materials in the Search Results list by double-clicking 

on the desired material. 

The list may be saved to a file by clicking the Save to File button to open the Save Search Results As 
dialog box. Navigate to the desired location for saving the file, name the file, and click the Save button.  

A File Saved message opens listing the path of the saved file once it has been created successfully. 

Tasks 

The Tasks window defines the tasks or steps needed to complete a work order. A task may be related to an 

asset with its own labor, materials, and/or equipment costs.  

Tasks Hierarchy Tab 

Tasks are organized into a hierarchy on the left pane and listed on the right pane.  

NOTE: See Setting up Data Trees. 
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To open the Task Edit window, click on the New Item button. To edit a task once it has been defined, 
double-click on the task leaf in the hierarchy or on an item in the list.  

Task Edit Window 

The Task Edit window provides information about the task, including description, assigned to employee or 
shop, time to complete, keywords, and a response to track accomplishments. 
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1. Type in the Name, 20 characters maximum. This is a required field.  

2. Type in the Description, up to 100 characters. 

3. If a particular employee is always assigned the task, select an Assigned To employee.  

NOTE: The Submit To field on a work order automatically changes to the Assigned To employee when the 
task status changes to current. 

4. If a particular shop is assigned the task, select a Shop. 

5. Enter the Estimated days to complete the task.  

6. Optional: Type in a Response Label if a task-specific response is needed for the work order (up to 

11 characters). This allows the Response for each task to be defined to track accomplishments or 

whatever the organization desires, such as the number of Sq ft landscaped, the number of Linear ft 
cleaned or plowed, the number of Cubic yards of fill used, the number of Curb miles removed, 

Count, # of bags used or filled, the number of Structures inspected, the number of Pumping 
hrs, the number of Potholes filled, the Cubic tons of trash picked up, etc. 
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 NOTE: If the Response Label field is left blank, it defaults to Response (although in some older 
databases, it may default to a null response). 

TIP: The column header on the work order Task pane will still be labeled Response (as different tasks can 
have different units associated to them) but the user can reload the item back into the fields to view the type 
of response entered in the field. 

 

7. For Miner & Miner Designer users: Check the Notify M M box to identify that task as an initiator of 

the planning functions of the interface. 

8. Click the Save button to add the task to the database. 

9. Type in the task Keywords, clicking the Add button after each one to add it to the Value list. 

10. Optional: If only certain valid values are wanted for the response field in step 6, add Response 
Codes by typing in an associated Code and clicking the Add button to list the Code.  

11. Optional: Type in any predefined Comments, up to 250 characters in length, to include with the 

task on the work order.  

If values are the same for another task, change the task Name and click the Clone button. Make any 
necessary changes and click the Save button to save the new task. 

IMPORTANT: Do not delete tasks which have been used on work orders as this deletes the link in the 
Cityworks database and orphans the task information on the work order.  

The Cancel Task checkbox allows the administrator to deactivate a task so it can no longer be added to a 
work order but can still be listed with historical data and used as a search parameter. 

If the task hasn’t been used, it may be deleted by clicking the Delete button and clicking Yes when the 

confirmation box opens to verify the user wants to delete the task. 

Permits 

Permit information is included on work orders to allow the permit cost to be tracked and included in the 

calculations for work order costs when permit costs are paid by the organization. Cityworks allows any 
permitting costs associated with a work order to be added to the work order cost. The types of permits that 

can be stored with a work order are defined in Permits.  

1. Type in the Permit Type, 8 characters maximum, and Description, up to 50 characters. 

2. Type in the Cost of the permit. 
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3. Click in the Source field to open the APSOURCE Codes box and select the source of the permit.  

 

 Add the Code and Description at the bottom of the box (or in Others > Codes > 

APSOURCE). 

4. Optional: Type in any Comments, up to 250 characters, to include any information about the 
permit, such as permit requirements, contact person, address, phone, email, related account 

information, etc. 

To modify or update an existing permit, double-click on it in the list to load the fields. Make the necessary 
changes and click the Save button.  

NOTE: The Permit Type field may not be edited, except by adding the new Permit Type and deleting the 
old one. Since the current information is stored in a different table, the historical data remains intact. 

Custom Inspection Templates 

Custom Inspection Templates are designed to create customized inspections for gathering and tracking 

any observations an organization wishes on any desired assets. Questions can be set up to gather specific 
information and results can be selected from standard responses for valid values or may be free-form entry.  

NOTE: While some field mapping is set up for some predefined Cityworks inspections and tests to 
automatically update condition or asset attributes in the geodatabase, this feature is not available for custom 
inspections. 

Besides setting up the template here, select the entity on the Asset Inspection Configuration window 

under Asset Setup for the Inspection Type of INSP (with Custom Inspection as the Description) to 

provide access to the custom inspection template from a work order created on that asset type. See the 
section Asset Inspection Configuration for more details. 



 

136    Cityworks Setup Designer 2013 Guide 

Condition Score 

Weights and scores are used to calculate a condition score and are set in the Observations and Results 

tabs. This information is used to determine where to allocate maintenance money most effectively and 
visually see any trouble spots on the map. By default the colors on the map mean the following: 

 No Score = blue 

 0-33 = green 

 34-66 = yellow 

 67-100 = red 

In Designer, each question is assigned a weight, and each answer is assigned a score. Once an inspection is 

complete, the final condition score is calculated. The condition score is a normalized value from 0-100.  

NOTE: Condition scoring is not supported with a Branch Q/A Model.  

The logic for the condition score is as follows: 

 Maximum total score is calculated (sum of weight multiplied by the maximum score of each 

question). 

 Total score is calculated (sum of weight multiplied by the score of each question). 

 Condition score is calculated (total score divided by the maximum total score, multiplied by 100). 

The examples have the following weights and scores assigned. 

 Weight 

Question 1 20 

Question 2 10 

 

Question 1 Score 

Answer 1 2 

Answer 2 1 

Answer 3 0 

 

Question 2 Score 

Answer 1 10 

Answer 2 5 

Answer 3 0 

 

Example 1: 

For Question 1, Answer 2 was selected. 

For Question 2, Answer  1 was selected. 
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Max Total Score is 20 * 2 + 10 * 10 = 40 + 100 = 140 

Total Score is 20 * 1 + 10 * 10 = 20 + 100 = 120 

Condition Score is 120 / 140 * 100 = 86  

Example 2:  

For Question 1, Answer 3 was selected. 

For Question 2, Answer 2 was selected. 

Max Total Score is 20 * 2 + 10 * 10 = 40 + 100 = 140 

Total Score is 20 * 0 + 10 * 5 = 0 + 50 = 50 

Condition Score is 50 / 140 * 100 = 36 

Custom inspections may be branched where the response to the observation leads to the next observation or 

linear where all the observations are visible and the user responds only to the relevant ones.  

NOTE: Custom Inspection Templates are similar to Request Templates Questions and Answers. 

Cityworks Server AMS administrators will have an additional Security tab as well as a Server Panel 
Configuration tab for Linear inspections to set up the inspection panels. 

Templates Tab 

The Templates tab provides the basic information about a Custom Inspection Template including which 
asset type(s) the inspection can be performed on. This custom inspection will be available on work orders 

when these assets are selected. 

1. Type in the Name and Description for the custom inspection template. 



 

138    Cityworks Setup Designer 2013 Guide 

 

2. If desired, select an employee for the Submit To field. Note that this list is configured under 
Employee Relates, so if the desired employee does not appear in the list, he/she needs to be 

added under Employee Relates.  

3. Server AMS users: Select the Priority from the dropdown selection, type in the Duration, and select 
the Duration Units from the dropdown for Hours or Days. 

4. Select the Q/A Model for the questions and answers. 

 Branch—Displays one question at a time; the answer determines the next question. 

 Linear—Show all questions at once; the user responds to only the relevant questions.  

NOTE: Condition scoring is not supported with a Branch Q/A Model.  

5. Server AMS users: If any custom ratings have been programmed into the system, type the name into 

the Custom Rating Method field. 

6. Click the Save button to save the inspection template and activate the rest of the window. 
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7. Select the Template Name from the Existing Templates list on the upper right pane. 

8. Select the desired Asset Group from the dropdown in the lower center pane. 

9. Select the radio button option for Show Features or Show Objects to list the feature or object 
classes from the selected Asset Group on the left.  

10. Select the feature(s) or object(s) from the list on the left and click the right arrow to move the 

selections to the right (or double-click on each desired selection).  

NOTE: The left arrow or a double-click moves a selected feature or object from the right pane back to the list 
on the left. Each feature or object in the Asset Group is listed either on the right or left. 

11. Click the Save button to save the asset(s) with the template.  

TIP: Moving the assets to the right does not save this information to the database.  

If necessary, an existing template may be deleted by selecting the template from the list and clicking the 

Delete button. Click Yes when the confirmation box opens to delete the template.  

IMPORTANT: Deleting a template removes the template from use and also prevents viewing the historical 
data. Even though most of the information remains in the Cityworks database, there is no way to display it in 
Cityworks once the custom inspection template is deleted.  

Observations Tab 

The Observations tab outlines the possible questions related to the custom inspection. Weights are 

assigned to each question which is used to calculate the Condition Score. When creating a Branch series, 

every question will require a response to be entered by the inspector to move on to the next observation.  

1. Switch to the Observations tab. 

 

2. Type in each Question, assign a Weight (if applicable), select the Answer Type, and click the 
Update button to list the question in the list.  
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NOTE: The Answer Type can be Single, Multiple, or Assets. Single supports all answer formats, 
Multiple supports only the This Text answer format, and Assets supports only the Any Free-form 
Response answer format. A Weight can only be assigned if the Answer Type is Single.  

3. Enter all applicable questions with weights and answer types.  

NOTE: Click the Weights icon to assign weights to all questions in the list from one screen. Click Save. 
Weights are used to calculate the condition score. 

4. If necessary, switch the Sequence of the Question by selecting it in the list and clicking the up or 
down arrow to move it to the desired position (or drag and drop). 

To modify a question, double-click on it in the list to load it into the Question field, make the desired 

change, and click the Update button. If necessary, it may be deleted by clicking the Delete button, in which 
case a confirmation box opens to confirm the deletion from the database.  

Results Tab 

The Results tab allows the administrator to set up the types of answers for each observation. If using the 
Branch Q/A Model, follow-up questions are also set up for the series using the Next Observation field. 

This field is inactive for a Linear Q/A Model. Scores are assigned to each answer which is used to calculate 

the Condition Score. 

1. Switch to the Results tab. 

 

2. Select an Observation from the dropdown list.  

The Answer type for the observation is displayed above the dropdown. The fields displayed on the Results 

panel will vary depending on the Answer type used.    
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3. For Branch: Select the Next Observation from the dropdown list for the question to follow the 

given answer.  

4. Enter a Score to be used to calculate the condition score.  

5. Select the radio button for the desired Answer Format.  

NOTE: Only one type of format may be used per question. 

 This Text—Allows for a series of valid values to be entered to keep the answers consistent. Type 

a valid value in the field.  

TIP: It may be helpful to allow for a response of Other when using This Text, in case the answer needed 
hasn’t been listed. 

 Yes/No/Unknown—Select the radio button option. 

NOTE: Select only Yes/No if no Unknown response is anticipated. 

 Date     

 Any Free-form Response—Open-ended question so inspector can enter any answer. 

 Checkbox 

 Default Checked 

6. Optional: Enter Instructions if certain procedures are to be followed for the given situation. 

7. Optional: Enter Explanations to provide more details about the answer. 

8. Click the Update button to add the answer to the list. 

9. Follow steps 1-7 to add the next applicable answer for the observation until all answers have been 

entered.  

NOTE: For Date or Any Free-form Response, only one answer is allowed. 

10. Click the Scores icon to open Update Scores and assign a score to each answer. Scores are used 

to calculate the condition score. Click Save. 

 

11. Add answers and scores for the rest of the observations.  

If necessary, an answer may be updated by double-clicking on it in the list to load it back to the top pane, 

editing the information, and clicking the Update button. Click Yes when the confirmation box opens. This 
prevents the user from adding an answer that already exists in the database.  
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Server Panel Configuration Tab 

The Server Panel Configuration tab allows the administrator to configure how to display custom 

inspection observations and results on the right pane of an inspection. The observations can be grouped into 
panels with subheadings. This tab is only visible when connecting to a Server database and the Q/A Model 

is set to Linear on the General tab, as it does not apply to the Branch option. 

1. Switch to the Server Panel Configuration tab. 

 

2. Type in the Title Bar Text for the first subheading. 

3. Enter a Sequence for the title bar.  

4. Click Save to save the information to the right pane. 

5. If any questions are required, select them from the lower left Observations pane, check the 
Required box, and move them to the right Items pane with the right arrow.  

TIP: All Required questions must be answered before the inspection can be closed so only select the ones 
that the organization wishes to track every time this custom inspection is performed.  

6. Select the other questions to list from the panel on the left and move them to the right pane to add 
them to the database.  

TIP: It is not necessary to click the Save button again for the observations to be added to this page panel. 

7. Click the Clear button to clear the fields and place the cursor back in the Title Bar Text field. 

8. Add each additional subheading with the corresponding observations by repeating steps 2-6. 

Once all the panels have been added, the fields can be reloaded by clicking on them in the Observation 

Group pane to modify the information. 
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Security Tab 

The Security tab allows the administrator to assign security rights for viewing, adding, updating, and 

deleting custom inspections. Since Cityworks Server AMS allows custom inspections to be created 
independent of work orders, security is set up as part of the custom inspection template.  

1. Switch to the Security tab. 

 

2. Select the Domain from the dropdown list.  

NOTE: Custom inspection privileges may be assigned to multiple domains, especially View rights. 

3. Select the desired group(s) from the Name list who are assigned the same user rights.  

4. Select the desired tables.  

5. Check the applicable box(es) for the Security Options. 

 View—Allows the user to open and view the information on an existing inspection. 

 Add—Allows the user to add the custom inspection to a work order.  

NOTE: Server AMS users with Add privileges can also create an independent custom inspection which is not 
tied to a work order. 

 Update—Allows the user to update inspection fields once the inspection is saved.    

 Delete—Allows the user to delete inspections. 

6. Click the Update button to list the information on the lower pane.  

7. Follow steps 1-6 to add all groups in all domains who need access to the custom inspection. 

All assigned permissions can be viewed by selecting the inspection from the Existing Templates list on the 

Templates tab and clicking on the Security tab. 
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Inspection Custom Observations 

The Inspection Custom Observations allows the administrator to populate valid values for Cityworks 
inspection forms. Currently it applies only to electric utilities. 

 

1. Select the Inspection Table Name from the dropdown list. 

 

2. Type in the Observation. 

3. Select the Format from the radio button options. 

 Yes/No—Allows the user to enter Y or N on the inspection form. 

 Code Table—Opens a Select a code table selection box with the valid Code and Description 

listed.  

NOTE: A Code Table may be used more than once. 
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 Alphanumeric value—Allows the user to type in the response. 

4. Click the Save button to list the Observation in the list.  

5. Continue adding all the observations for the given table by repeating these steps. 

6. Switch the Inspection Table Name, adding all the observations for each table. 

An Observation may be deleted by selecting it from the list to load it in the upper pane and clicking the 

Delete button. No confirmation box opens. 

Predefined Comments 

 Predefined Comments may be entered for a selection list on service requests or work orders for the 

selected category. This is especially helpful for field users to facilitate and simplify data entry for frequently-
used comments or to standardize comments.  
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1. Select either Request or Work Order from the Apply To dropdown.  

2. Type in any Comments, up to 250 characters, wanted on the request or work order.  

 

3. Select the desired asset group(s) from the Categories list to which the Comments apply. 

NOTE: The Categories list for service requests is populated from the APROBCAT code type, and from the 
AWOCAT code type for work orders (both are found under Others > Codes).  

4. Click the Save button to list the Predefined Comments in the list.  

NOTE: If necessary, an existing comment may be deleted.  

5. Continue adding all desired Comments for all Categories.   

Template Security 

Employee permissions to view, add, update, delete, and view costs are set up on the Template Security 
window and assigned by groups for each template for six work order tables, three service request tables, and 

the inspection table for custom inspection templates. Template security may also be set on the Security tabs 

of either Request Templates or Work Order Templates. All security for custom inspection templates is 
added here, although privileges can be granted for a specific inspection from the inspection itself. In 2012.1, 
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the group rights for work orders, service requests, and inspections were simplified. Please read Knowledge 

Base article 10619 for more information on the Group Rights Migration tool.  

1. Select the Template Domain from the dropdown. 

 

2. Select the radio button option for Work Order, Service Request, or Inspections.  

NOTE: Inspections applies only to custom inspections. 

3. Select the Group Domains using the dropdown list to populate the related Group Name area with 
the employee groups from the desired domain.  

TIP: If working in more than one domain, be sure the Group Domains selection matches the Template 
Domains selection, unless employees from a different domain are needed for the work order, service 
request, or inspection since groups from the first domain are listed by default. 

4. Select the Group Name. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10619.aspx?Keywords=10619
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5. Select a Table or multiple tables if Group Security settings are the same for all tables.  

TIP: Azteca Systems Inc. strongly encourages that Delete permission for WorkOrder, Request, and 
Inspection tables be limited to only select users. However, all workers who add labor, equipment, or 
material costs also need Delete privileges as that is the only way to correct errors when entering this data. 

Work Order tables:  

 WorkOrder—Access to general work order information.  

 LaborCost—Access to labor information, such as the employee and hours worked.  

 EquipmentCost—Access to equipment costs. 

 MaterialCost—Access to material costs. 

 WOTask—Access to work order task information. 

 LineItemCost—Access to contract line items. 

NOTE: To activate the Costs option on the Tools menu of a work order (which opens the Work Order 
Cost Summary form), the user must be in a group which is assigned View rights to the WorkOrder, 
LaborCost, Equipment Cost, and Material Costs tables. 

Service Request tables: 

 Request—Access to general service request information. 

 CustomerCall—Access to customer account information.  

 RequestLabor—Access to the labor information on a request, including the employee labor rate. 

Inspection table (for custom inspections only): 

 Inspection—Access to custom inspection templates.  

6. Check the applicable boxes for Group Security.  

 View—Allows the user to view the table information.  

NOTE: View privileges should be assigned to all groups working with Cityworks. 

 Add—Allows the user to add information to the selected table.  

 Update—Allows the user to change information.  

NOTE: Update does not apply to the cost tables. To update cost tables, a user must have Add and Delete 
permissions for LaborCost, EquipmentCost, and MaterialCost tables. 

 Delete—Allows the user to delete information.  

TIP: Azteca Systems Inc. recommends limiting the number of users with permission to Delete work orders 
from the WorkOrder table and service requests from the Request table. An organization may prefer 
employees cancel work orders and service requests rather than deleting them since the IDs are sequentially 
assigned and can then be accounted for. 

 View Cost—Allows the user to see employee labor rates as part of the cost.  

NOTE: Not checking the View Cost also means the Labor Cost display field in request or work order 
searches will not be listed for users in these groups. 

7. Click the Save button to add the information to the template and list it on the lower pane.  
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Click the Print button to print the list on the default printer and click Yes when the confirmation box opens.  

 

Employee Relates 

The Employee Relates window is used to populate the employee dropdown lists in the Cityworks software 

for certain employee fields on service requests, work orders, tasks, projects, inspections/tests, and/or 
Cityworks Storeroom.  

In Cityworks 4.5 SP4, the EditAfterClose field name was added to allow a user to edit a closed request, 

work order, or inspection by assigning them the same rights they would have it if was open.  

In Cityworks 2010.1 SP1, a new table called Search with a field name of ViewCost was added to allow 
employees the right to view labor cost when searching work orders and requests. 

In Cityworks 2012.1, a new Project InitiatedBy field was added to allow the domain administrator to grant 

permission to any user to initiate, update, or delete a project. Also, a new table called EquipChangeout 

with a field name of ChangedBy was added to allow employees access to Equipment Changeout data. A 
field called CancelledBy was added to the Inspection table. 
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Permission for some users to access some of the Designer functions may also be assigned, such as allowing 

an employee to update employee labor rates, contractors, equipment, materials, permits, etc. If selecting 

Designer from the Objects list, the boldface functions from the directory are listed in the Table. When one 
of these is selected, the contents are listed under Field Name.  

IMPORTANT: Full access to any of the functionality within that window is provided when Designer 
permissions are assigned to a user.  

1. Select the Current Domain from the dropdown list. 

2. Select the desired Objects on the upper left pane to populate the associated Table list on the center 
pane. 

3. Select the Table to populate the corresponding Field Name list on the right pane.  
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4. Select the Field Name to populate. 

5. Select the employee group(s) from the Employee Groups list on the center pane to list the 

employees on the right, using <Shift + click> or <Ctrl + click> for multiple groups. 

6. Select the employee(s) from the list to assign to the Field Name.  

7. Click the Add button to link the employees to the Field Name for selection on the Cityworks form 
and list them on the lower pane.  

NOTE: To change the information in the list, select and click the Remove button.  

8. Continue to add the desired employees to each Object and Field Name by repeating these steps. 

Once the Employee Relates are set up, all the employees associated to the selected table are displayed on 

the lower pane. Selecting a Field Name lists just those employees associated to that field. 

If desired, print this list to the user’s default printer by clicking on the Print Relates button and clicking Yes 
when the confirmation box opens.  

 

Work Order Template Classes 

NOTE: Work Order Template Classes are for Server AMS only. 

Work Order Template Classes allows the automation of the work order template selection to be based on 

up to three attribute values of an asset. This may be useful when different tasks or work procedures need to 
be followed. For example, tree pruning task and equipment may be a function of diameter and species or 

pipe flushing may be based on the diameter of the pipe. Only one asset may be selected per work order 

when using classes.  

NOTE: Class configuration can also be loaded from a delimited text file. 
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Classes Tab 

The Classes tab is used to define the class and select the asset, the applicable rule fields, and default work 

order templates assigned to the class.  

1. Select the desired Asset Group from the dropdown. 

 

2. Select the radio button for the asset type, Features or Objects, to populate the corresponding 

Assets list.  

3. Type in the Description of the class.  

NOTE: The user selects the class Description when creating a work order; however, the actual work order 
template is selected by the software according to the defined rules for the asset values. 

4. Select the applicable asset field from each dropdown to define up to three rule fields.  

TIP: Attributes will only display when connected to the geodatabase. Otherwise type in the field name. 

5. Select the Description for the default work order template from the Default Work Order 

Templates list to use when asset attribute values do not resolve to a rule set.  

6. Click the Update button to save the information to the Existing Classes list. 

7. Repeat the steps for all other asset classes desired. 
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Rule Sets Tab 

The Rule Sets tab is used to assign specific work order templates to values in the rule sets. 

1. Switch to the Rule Sets tab. 

 

2. Select the class from the Defined Classes list. 

3. Select the Work Order Template from the dropdown. 

4. Select the applicable value from each active rule set field.  

5. Click the Save button to save the information. 

6. Continue to select work order templates for each possible set of values for each class. 

NOTE: For values which are not assigned on the Rule Sets tab, the default work order template will be 
used. 

Load Tab 

The Load tab is used to load rule set information already saved in a file. The file must contain these fields in 

this order with the first row consisting of these field names. See screenshot below for an example. 

 RootTemplateId 

 WOTemplateId 

 Rule1Value 

 Rule2Value 
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 Rule3Value 

 

1. Switch to the Load tab. 

 

2. Click in the Import File field to open the browser box. 

3. Navigate to the file and click Open (or double-click on the file). 

4. Select the Delimited By field. 

 Comma 

 Tab 

 Other—Specify the delimiter in the box that opens when this option is selected. A semi-colon is 

the default.  

5. Click the Load button to load the file. 
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Asset Setup 

Asset Setup functions configure Cityworks to interact with ArcGIS. These settings allow the domain 
administrator to filter out GIS layers that are not relevant to Cityworks asset management and establish 

pointers to the geodatabase objects that tell Cityworks where to look for information when accessing the 

geodatabase. 

 

To access this group of functions, the Use ArcGIS Data Model (#21) value must be set to Y on Others > 

Preferences. This is the default setting.  

IMPORTANT: With a new domain and database, this preference must be saved before Designer can be 
used to set up any other domain functions. Double-click (or press the space bar) in the Value field to toggle 
to N (no) if using ArcView 3.x.  

 

Also select the Y or N answer for Geodatabase Asset Groups Owned by SDE (#32) to indicate whether 

SDE is the owner of the geodatabase tables. If using a personal geodatabase, enter N (default value).  

NOTE: If the RDBMS user SDE owns the Esri geodatabase tables (similar to Azteca owning the Cityworks 
tables), this Y setting lets Cityworks know it needs to alter the SQL syntax used to access them. 

These functions are found under Asset Setup. 

 Asset Group Definitions—Defines the asset groups with their features and related objects 

from the GIS layers for creating work orders and identifies the display fields for these assets on 

the Cityworks Asset Identify Form. 
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 Asset Form Configuration—Selects and configures the fields from the geodatabase to display 

on the Cityworks Asset Identify Form and identifies which fields may be added to a 

customized work order print template. 

 Asset Inspection Configuration—Links the assets to their related inspections so when a work 

order is created on an asset, the selected inspections are available to the user. 

 Inspection Field Mapping—Links fields in Cityworks inspection forms to the corresponding 

geodatabase fields so the information loads for the selected asset when the inspection or test 
form is opened. 

 Isolation Trace Setup—Defines the GIS layers, addresses, customer information, etc. for 

isolation traces on water pipes. 

 Asset Reading—Sets up the intervals, milestones, and thresholds with their associated work 

orders for asset readings to automatically generate work orders. 

 Geodatabase Sync—Syncs up the work order entity IDs to the object IDs in the geodatabase. 

Asset Group Definitions 

The Asset Group Definitions function identifies the GIS layers which Cityworks can create work orders on 
and defines the asset groups with their assets for each domain. The display field for Cityworks to use as the 

main identifier for each asset type is also specified along with the relationship. This information is displayed 

on the Cityworks Asset Identify Form. Asset Group Definitions has four tabs for defining the asset 
group information.  

Define Groups Tab 

Asset group codes and names are defined on the Define Groups tab.  
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1. Type in the Group Code, 8 characters maximum, and Group Name, 20 characters maximum. 

2. Check the box Asset Group Owned by SDE if SDE is the owner of the geodatabase tables.  

NOTE: This box has a dynamic link to the Asset Groups Owned by SDE field in the Preferences list. The 
box is checked for Y but if the administrator unchecks the box, the Preferences setting changes to N.  

3. Check the Use mobile assets tracking system box if a mobile tracking system is being used.  

NOTE: Checking the box for any asset type adds the Mobile_Assets layer to the event layer dialog box and 
the mobile asset event layer will be available for viewing on the map. 

4. Click the Save button to list the information in the lower pane and save it in the Cityworks database.  

NOTE: To delete, select the group(s) from the list, click Delete, and click Yes when the confirmation box 
opens.  

Click on a code in the list to load the information back into the fields for making any changes. Click the Save 
button and click Yes when the confirmation box opens.  

TIP: If a Group Code is modified, the new code will be added in addition to the one that is already there. In 
this case, delete the one that is no longer wanted. 
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Assign Assets Tab 

Features and their related objects are assigned to asset groups on the Assign Assets tab. Others may be 

used to set up mock layers to perform administrative functions or other tasks not related to a map feature as 
long as asset readings will not be used to automatically generate work orders.  

NOTE: Features are found on the map; Objects are linked to a map feature. 

NOTE: A single feature class may belong to only one asset group. 

1. Switch to the Assign Assets tab. 

 

2. Select the radio button for Features, Objects, or Others:  

 Features—Use for assets found on the map. 

 Objects—Use for assets related at any n-level to a feature found on the map. 

 Others—Use for any miscellaneous asset which needs to be tracked in the work management 

system. 

NOTE: Asset readings can only be collected for features and objects so if readings will be gathered for an 
asset, it cannot be listed under Others. 

3. Select an asset from the list on the left to load it in the gray Code field on top of the right pane. 

4. Select the applicable Asset Group from the dropdown list. 

5. Type in the Cityworks Description for the asset. This is what the user will see when creating work 

orders.  

6. Click the Save button to list the information in the list on the right pane.  

A Description may be changed by clicking on it in the list to load the information back into the fields. Make 
the desired change and click the Save button. Click Yes when the confirmation box opens to update the 

asset. 
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Field Configuration Tab 

The Field Configuration tab serves to define which ID fields are displayed on the Cityworks Asset 

Identify Form and Cityworks Inventory Editor form and to set the directory location for where images 
are stored.  

The Display Field selected for a related object automatically populates with the Object ID when a user 

adds a new object using the Cityworks Inventory Editor form right-click context menu option Add New.  

NOTE: The Cityworks Asset Identify Form and the Cityworks Inventory Editor are essentially the 
same form; the Identify Form is view only while the Inventory Editor allows for editing fields. Images 
may be added in either location. 
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There are two ways to load asset images on the Cityworks Asset Identify Form. Either a file name or the 

entire image path needs to be stored in the geodatabase for each asset type.  

When storing just the file name, use the Field Configuration tab to designate an image field and Default 
Image Directory location. If images are already stored on a network drive, that directory may be used. If 

not, set one up. Asset types may have their own network folder or all images may be located in a single 

folder. A single image may be used for multiple assets. The user clicks the Add Image button on the 
Cityworks Asset Identify Form to open the browser where the contents of the predefined folder are 

listed. Selecting the desired image and clicking Open loads the image on the form. Once loaded, the image 
opens when the asset is selected. This is the recommended way of storing images unless multiple images are 

wanted. 

If storing the network file path, use the Asset Form Configuration in Designer to set the ImagePath: 
File Path to Y. Storing the entire image path allows images to be kept in any network location and multiple 

fields to be configured for viewing any document. However, it is not as user-friendly for the user. The user 

clicks in the Attribute: Value field to open a browser and finds the desired file which loads into the field. A 
<Ctrl + click> in the field then opens the document or image in an image viewer. It also loads the image on 

the Cityworks Asset Identify Form but it must be loaded every time the asset is selected.  

1. Switch to the Field Configuration tab. 
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2. Select the radio button option for Features or Objects to list the related fields from the 

geodatabase.  

3. Click on the desired Asset from the list on the left. 

4. Enter the appropriate value in the Field Configuration section on the right. 

 Display field—Select from the Value dropdown list.  

TIP: Use a unique identifier such as FacilityID or AssetID for features and AssetID or EquipmentID for 
related objects. 

 Primary image field—Select the attribute field you want to use for images. Note that the base 

file path has to be stored in Attachment Mappings.  

 Entity UID field—Set to any text field after the EntityUID Migration Tool is run. In Server 
AMS/PLL 2011 B2, a field named ENTITYUIDFIELD was added to the ASSETIDFIELD table. This 

means there is one field that has to be tracked to allow GIS data to be linked from the Cityworks 

database to the GIS database. Setting a sole ENTITYUIDFIELD value alleviates the dependency 
on ObjectID. An EntityUID Migration Tool was created to quickly set the ENTITYUIDFIELD for 

multiple entities at the same time. This tool is required when upgrading to Server AMS/PLL 2011 
B2. The tool does not allow users to set the Entity Uid Field to a value other than AssetID, 

FacilityID, or EquipmentID. See KB Article 10598 for more information on the EntityUID Migration 

Tool. 

 Condition score field—Select an attribute to store in the GIS database for further analysis. 

When this field is populated, the most recent condition score is written to the geodatabase. The 

user sees the latest condition score in the Results tab on the map page. 
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 Condition score date field—Select the type of date from the dropdown. When this field is 

populated, the most recent date related to the condition score is written to the geodatabase. The 

user sees the latest condition date in the Results tab on the map page. 

5. Enter the filepath for the folder where attachments or images are stored in the Default Image 

Directory field. This filepath should match the one entered in the Server attachments root directory 
preference. For more information on attachments, see Knowledge Base #10630 Configuring Server 

Attachments on mycityworks.com.  

NOTE: To specify a directory other than the Server attachments root directory, see Attachment 
Mappings. 

6. Click the Save button to save the information in the database and in the list on the lower pane.  

To update the asset information: Click on the asset listed on the lower pane to load the information back into 

the top pane, make the necessary change(s), and click the Save button. Click Yes to confirm the update 
when the box opens. 

Relationships Tab 

The Relationships tab stores relevant geodatabase relationships in the Cityworks database for desired 

assets. These relationships allow the domain administrator to identify and include the GIS relationships that 
are applicable to Cityworks users. For example, annotation layers are important in mapping but not in 

processing work orders, so they would not be included on the Relationships tab. 

The Cityworks Asset Identify Form displays these relationships in the upper left corner as folders.  

NOTE: Objects may be linked at any n-level relationship as long as the first relationship is linked to a map 
feature. 

 

When the asset is selected for creating a work order, the related objects are also listed, allowing a work order 

to be created on the asset and/or any of its related objects.  

1. Switch to the Relationships tab. 

 

https://www.mycityworks.com/KB/KnowledgebaseArticle.aspx?ArticleID=10630
https://www.mycityworks.com/KB/KnowledgebaseArticle.aspx?ArticleID=10630
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2. Select the radio button option for Features or Objects.  

NOTE: Features are found on the map; Objects are linked to a map feature. 

3. Select the Asset from the list on the left pane. 

The list of relationships for the asset in the geodatabase loads on the top right pane. 

4. Select the related object(s) from the All Relationships list for use in Cityworks.  

TIP: Multiple objects may be selected using <Shift + click> or <Ctrl + click>. 

5. Click the Save button to attach the selected object(s) to the asset in Cityworks and list them on the 
lower right pane.  

NOTE: Relationships of related objects may be removed by selecting in the list, clicking the Delete button, 
and clicking Yes when the confirmation box opens. 

6. Repeat these steps as needed for all relationships.  

Asset Form Configuration 

Set up view and usage preferences for the Cityworks Asset Identify Form and the Cityworks Inventory 

Editor form listing the details about features and related objects in the geodatabase.  

NOTE: Both forms are shown in the section Asset Group Definitions. 
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All geodatabase field names are listed for the selected asset and set to be visible on the form (Y in the 

Visible column). The administrator can set the value to N to hide a field. Fore Color and Back Color may 
be selected for each field to make the field stand out from the others. Text may also be set to bold if desired 

by changing the N default value in the Bold column to Y.  

NOTE: Fore Color and Back Color are programming terms for the properties of the text and background of 
a cell. 

The File Path allows more than one path for attachments and/or images to be stored for a single feature 

class when the associated file path field is in a 1:m or m:n related table. Change the default from N to Y for a 
related object (table) to allow the field to activate a browser tool or to open the associated file using the 

computer’s default viewer for the file type.  

NOTE: To specify a different file path directory, see Attachment Mappings. 

If the administrator is setting up customized work order templates and wants to load applicable geodatabase 
fields into the print template, set the value in the Printable column to Y. Entering the 

[TableNameFieldName] on the print template allows the program to load the correct variables for printing. 

1. Select the Asset Group from the dropdown list. 

 

2. Select the radio button option for listing Features or Objects. 

3. Select the Asset from the list on the left and wait while the information loads on the right indicated 

by an hourglass and progress bar.  
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4. To change the default settings on the right pane, select the row and make the desired changes. 

Back Color is the only value that must be the same for each field so changing it in one row changes 
it for all of them.  

NOTE: The form is shown with the default color settings and any changes made in the Fore Color, Bold, or 
Back Color columns are displayed as soon as the change is made.   

 

 

The following changes may be made to the form: 
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 Hide a field—Set Visible to N by moving the cursor to the column and pressing the space bar (or 

double-clicking) to toggle between Y and N. 

 Order of the fields on the form—Select the row and drag the field to the desired location. 

 Other Y/N fields—Place the cursor in the column for Bold (text), File Path (for multiple 

attachments/images), or Printable (print the field values on customized work order templates) 
and press the space bar (or double-click) to toggle between the responses.  

 Color fields—Move the cursor to Fore Color to change the text color or Back Color to change 

the background color and press the space bar (or double-click) to open the Color dialog box.  

NOTE: Back Color changes the background color for the entire form. 

If additional colors are wanted, click the Define Custom Color button to expand the box and the color 

selection.  

 

 Click on the desired color and click OK.  

5. Click the Save button on the left pane to save the changes. 

6. Click Yes when the confirmation box opens asking if the user wants to save changes for the asset 
type.  

TIP: To restore default settings, switch to another Asset on the left pane and click No when the 
confirmation box opens. 

When opening the Asset Form Configuration for an asset, if any geodatabase fields have been added to a 
table, they will be listed. If any fields have been deleted, a confirmation box opens listing the field(s) that 

have been deleted from the geodatabase. Clicking Yes removes the deleted field(s) from the table. Selecting 

No allows this field to display in an older version of the geodatabase; however, this message continues to 
open when loading the information for this asset. 
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Asset Inspection Configuration 

Linking inspections to asset types is done in the Asset Inspection Configuration window. When a work 

order is created on the asset type, clicking the Inspections button on the toolbar opens the list of 
inspections that may be created on that asset. The inspections are loaded into this list by associating them in 

this Asset Setup function. 

All predefined Cityworks inspections are listed under the Inspection Types as well as one for all custom 

inspection templates. Link each asset type for which an inspection can be created to the applicable inspection 
template, including a link to all custom inspection templates that have been created. For custom inspections, 

select INSP with Custom Inspection as the Description.  

 

Once the assets are linked to the Inspection Types, selecting the inspection(s) from the right pane lists all 

the asset types for which the inspection(s) can be created on the lower pane.  
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1. If necessary, change the Current Domain from the dropdown list to populate the corresponding 

Asset Groups list. 
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2. Select the asset from the Asset Groups list to populate the entity list on the center pane. 

3. Select the entity or multiple entities from the list on which to perform the inspection, using Ctrl or 

Shift for multiple selections. 

4. Select the inspection(s) from the Inspection Types.  

TIP: The Apply To column under Inspection Types lists the suggested asset type(s) for which the 
inspection was created for. 

5. Click the Add button to add the information to the lower pane.  

NOTE: Asset types can be removed by selecting them in the list on the lower pane and clicking the Delete 
button and confirming when the Confirm box opens. 

Clicking the Print button opens a confirmation box asking if printing should be continued for the Asset 

Inspection Definitions. Selecting Yes prints the list on the user’s default printer. 
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Inspection Field Mapping 

The Inspection Field Mapping window links information fields from the geodatabase to related fields on a 
work order inspection or test form. Mapping the inspection fields to the desired geodatabase fields allows the 

corresponding values to load on the inspection form when it is opened.   

1. Select the desired inspection from the Inspections list. 

 

2. Select the first field in the Inspection Fields. 

3. Select the group from the Asset Group dropdown. 

4. Select the radio button option for Features or Objects. 

5. Select the asset from the Assets list to populate the associated Asset Fields. 

6. Select the matching field from the geodatabase Asset Fields with which to populate the selected 
field on the inspection form. 

7. Click the Save button to list the field mappings below on the lower pane.  

NOTE: Fields may be deleted by selecting them in the list, clicking Delete, and clicking Yes to confirm. 

To change a field mapping, select the new field and click the Save button. Click Yes when the confirmation 

box opens for updating the field.  

The list may also be printed. Click the Print button and click Yes when the confirmation box opens. 
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Isolation Trace Configuration 

The Isolation Trace Configuration is for water users only. A geometric network is required to use the 

isolation trace function in ArcGIS for identifying valves that must be shut off to isolate a water line and list all 
affected customers. The setup assigns GIS feature classes and fields in those feature classes to the layers 

and fields listed in the GIS Layer column and identifies the customer account information wanted.  

IMPORTANT: For the Isolation Trace feature to work properly in ArcMap, the lateral line layer must 
intersect with the parcel layer to populate the affected parcels. 
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1. Select the Current Domain from the dropdown list to load the associated GIS Layers. 

2. Click in the Value box for each GIS Layer and enter the corresponding GIS feature class or field in 

the Value column.  

NOTE: Critical Customer Field is the only optional field. All others require the name of the GIS layer or 
field where the information is stored. 

3. Click the Save button.  

4. Select the radio button option on the right pane for the Customer Setup used by the organization 
for customer data. The associated fields for the option selected are listed under Field Name. 

 Parcel Layer—Uses parcels in the geodatabase with a field that links to the customer account 

table.  

NOTE: The fields for Parcel Layer are not shown as they will vary. 

 Customer Account Table—Uses the Cityworks CustomerAccount table for the customer 

information and lists the fields shown. 

5. Select each desired customer account field from the Field Name list, using <Shift + click> or <Ctrl 

+ click> for multiple selections.  

6. Click the Add button to add the field(s) to the database and to the list on the lower right pane.  

The customer information linked to the isolation trace may be modified as necessary, using the Add or 
Delete button. If a field is listed on the lower pane but selected again on the top pane, an error message 

opens when the Add button is clicked to alert the administrator that the field already exists.  

If the radio button option is changed, a confirmation box opens to allow the user to remove the current 

customer field settings. Click Yes to delete them or No to retain them.  

Asset Reading 

Work orders can be generated by asset readings rather than just relying on the time calculations in cyclical 

work orders. Readings can be obtained for individual assets and linked to work order templates to 
automatically generate a work order when the defined intervals, milestones, or thresholds are exceeded. 

Vehicle maintenance can be set up if vehicles are defined as features or related objects tied to a shop 
location or building. Standalone is used to record the asset readings and automatically generate the 

corresponding work orders.  

These readings may be used for maintenance work or for emergency situations, such as when a temperature 
or pressure reading on a piece of machinery exceeds a certain threshold. Use Interval and Milestone for 

values which are constantly increasing, such as runtime hours, mileage, etc. Use Threshold for fluctuating 

values which generate a work order every time a certain threshold is exceeded.  

NOTE: Threshold could be used to define the mileage when a vehicle is retired but generally fields which 
are used for Interval and Milestone are not used for Threshold. 

Asset readings are set up in Designer. First, the assets must be defined in the geodatabase as either features 

or objects and corresponding work order templates created for them. A numeric reading field must also exist 
or be set up for the asset in the geodatabase table, such as mileage, runtime hours, temperature, pressure, 

etc.  
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NOTE: An asset may have multiple reading fields if different readings are to be tracked. 

 

Actions Tab 

The Actions tab is used to link the unique identifier(s) in an asset type with numeric values for the reading 

field and the corresponding work orders. 
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1. Select the Asset Group from the dropdown list.  

2. Select the radio button option for Feature Classes or Object Classes to list the desired asset type. 

3. Select the asset from the Asset list on the left to load the lower left pane with the associated 
FacilityID, EquipmentID, or AssetID.  

NOTE: The header of the lower left pane changes to indicate what the display field is for the selected asset. 
If nothing lists in the Value column, verify that the asset groups have been assigned and the display field 
selected under Asset Group Definitions. The Display Field should be the unique identifier in Cityworks for 
the asset, such as the FacilityID, EquipmentID, or AssetID.  

4. Select the desired ID(s) from the Value list.  

TIP: Multiple reading actions for interval or threshold can be set at the same time if the same information 
applies to each asset. 

5. Select the Reading Action: either Interval or Threshold.  

NOTE: Use Interval for readings that continually increase, such as total mileage in a vehicle. Select 
Threshold for emergency situations when an asset reading exceeds a certain temperature or pressure and 
work orders will be created every time the reading is above the Threshold value. Selecting Threshold 
inactivates the Milestone portion of the pane as only one reading Value may be assigned per asset per 
reading Field for Threshold. 
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6. Enter the Value and select the corresponding reading Field from the dropdown list, which lists the 

fields for the selected asset.  

NOTE: Interval, Threshold, and Milestone are numeric fields and their length depends on the field type 
set up in the geodatabase table. 

7. Select the corresponding Work Order Template from the dropdown for the numeric value entered 

for Interval or Threshold.  

NOTE: The Work Order Template dropdown is populated with work orders which have been set up for the 
selected feature or object. 

8. Enter the Description, which may also apply to any related milestones.  

NOTE: The Comments field holds up to 250 characters and displays approximately 40 characters at a time. 

9. Click the Save button to save the asset readings for the selected asset(s).  

10. Optional for Interval: Click on the desired asset from the list on the lower right pane to reload the 
information back into the fields.  

NOTE: Milestones must be added one at a time for each asset in the list as they are linked to the Interval. 

A Milestone may be added for an Interval by typing in the Value for the same reading Field as the 

Interval, selecting the corresponding Work Order Template, and clicking the Add button to save the 
milestone in the list. Do this for each Milestone.  

NOTE: More than one Milestone may be added for the asset. If the Milestone is a multiple of the 
Interval or another Milestone, only one work order is created. The MilestoneID is generated when the 
information is saved. 

11. Click the Save button to save the milestones with the Interval. 

12. Repeat as needed to add Milestones to another asset ID, additional reading actions for the same 

asset using a different reading field, or to add readings for other assets. 

Current asset readings may be viewed by selecting the Asset, Value, and Reading Field. Changes may be 
entered and new information saved by clicking the Save button. Click Yes to confirm the update when the 

message box opens. 

Scroll across to view Comments or any of the other listed fields. 

 

Selecting milestones and clicking the Remove button opens a confirmation box. Click Yes to delete the 

selected milestones. 

No confirmation box opens when deleting from the Defined Reading Actions list. All selected readings are 
removed when the Delete button is clicked. 
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Additional Configuration Tab 

The Additional Configuration tab is used to load the object-feature relationship and fields required by 

Cityworks from the geodatabase table into a Cityworks table, CWAsset, so the asset information is 
accessible without a connection to the geodatabase. Asset readings are entered in Cityworks Standalone. The 

information in this table is used to generate work orders associated with each asset reading. If changes are 
made in the geodatabase that affect these table values, this information will need to be updated.  

NOTE: The Cityworks CWAsset table contains these fields: AssetClass, AssetID, AssetObjectID, 
FeatureClass, FeatureAssetID, FeatureObjectID, LegacyID, Location, WarrantyDate, X, and Y.  

Skip this tab if using a SCADA (Supervisory Control and Data Acquisition) or other automated system to input 
asset readings through an interface that sends the information through the .dll (dynamic link library) into 

Cityworks, as no additional configuration is required. 

1. Switch to the Additional Configuration tab.  

 

2. Select the Asset Group. 

3. Select the radio button option for Feature Classes or Object Classes. 

4. Select the desired feature or object class(es) from the list, using the Shift or Ctrl key for multiple 

selections. 

5. Click the Save button and wait while the information is copied. Progress is tracked in the space at 
the top to the right of the Current Domain by listing the number of records completed out of how 

many and when it’s complete.  

NOTE: If there are no assets in the selected feature or object class, the progress bar flashes but the asset 
group is not listed as there was nothing in the geodatabase to copy over. 
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Once copied into Cityworks, the asset is listed on the lower pane under Defined Assets with the number of 

records. 

 

6. Repeat the steps when needed to update the table information in Cityworks by selecting the table 

from the list, clicking the Delete button, and clicking Yes when the confirmation box opens to 
remove the table. 

Readings Tab 

The Readings tab provides a way to delete incorrect asset readings. It lists all the readings for the selected 

asset.  

 

IMPORTANT: If an incorrect reading generated a work order, it must be deleted before adding a new 
reading for the correct reading to generate a work order.  

 

1. Switch to the Readings tab. 

 

2. Select the Asset Group from the dropdown. 

3. Select the radio button for Feature Classes or Object Classes to populate the ID list below. 

4. Select the Asset ID from the list to populate the Readings pane on the right. 
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5. Select the incorrect reading(s) and click the Delete button.  

TIP: Make a note of the work order ID when deleting a reading associated to a work order. Then go into 
Cityworks and cancel the work order. 

6. Click Yes when the confirmation box opens to delete the selected reading(s). 

When the new reading is saved in Standalone, a work order will be generated if the reading warrants creating 

one.  

 

Geodatabase Sync 

The Geodatabase Sync function verifies that the Object IDs in the geodatabase and Cityworks database 

match and allows non-matching entries to be updated in the Cityworks WorkOrderEntity table. Run the 

tool when updating a personal geodatabase to SDE because SDE renumbers all the objects when they load 
into the SDE. Other changes to the GIS, such as splitting a line, may also require synchronization of object ID 

values in the work order history.  

IMPORTANT: Before beginning these steps, make a backup of the Cityworks database. 

1. Select the radio button option for the records to check:  

 All Records—Checks all records for all features and objects in the database.  

 

 Filter Records—Activates the top pane to allow the records check to be filtered by 

features/objects, asset groups/types, work order status, and/or dates. 

NOTE: Verifying all records may take a considerable amount of time. No other Designer functions may be 
accessed while this analysis is running. 
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2. For Filter Records: Select the Filter Options desired from the top pane.  

NOTE: The SQL query reflects the options selected and is listed in the gray area below the buttons on the 
top pane. 

3. Select the radio button option for Features or Objects.  

NOTE: The EntitySID columns list either the feature or object IDs and the Feature_ID columns list the 
information for the feature. Therefore, their values are the same when the Features option is selected. 

4. Select from the Asset Groups list. Only one asset group may be selected at a time. 

5. To further narrow the search, select the specific asset type(s) from the Asset Types list. Multiple 

asset types may be selected using <Shift + click> or <Ctrl + click>. 

6. If desired, select the Work Order Status for the records in the Cityworks WorkOrder table. 
Multiple status selections may be made.  

NOTE: The Cityworks WorkOrder table is linked to the WorkOrderEntity table through the 
WorkOrderID and lists only the entities found on work orders with the selected status. 
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7. Select either or both an Initiate Date From or Initiate Date To for the work orders.  

NOTE: Selecting a date automatically checks the box for Initiate Date From or Initiate Date To for 
specifying a date range. 

8. Click the Analyze button to start the search. The progress information is listed to the right of the 
radio button options with the number of assets to be analyzed, the time elapsed, and time remaining. 

This information updates each time an asset is analyzed. The progress bar at the bottom provides a 
visual indication of the progress.  

A message box opens if no entities fit the search criteria. 

Analyzing may take some time so, if necessary, the user may cancel the analysis by clicking the Cancel 

button. The records already analyzed remain in the list and the progress status will change to Analysis 
cancelled.  

NOTE: The software finishes analyzing the current asset before cancelling the analysis so there is a lag in 
response time. 

When complete, the number of assets which require updating are listed with the time it took to run the 
analysis. All the assets which have been analyzed are listed in the lower pane under the SQL query. The Old 

EntitySID column lists the ID from the Cityworks database. The New EntitySID is the ID from the 
geodatabase.  

NOTE: If the entity is a feature, both the Entity Type and Feature Type columns will be the same. Related 
objects are listed in the Entity Type with the feature to which they are related in the Feature Type column. 

 

The Status listed in the last column consists of these options. 

 Same—Old and New EntitySID and Feature_ID match. 

 Conflict—The EntitiySIDs do not match.  

NOTE: The assets listed for updating are the total number of records listed with a Conflict status. 

 Not Found—No entry found for the selected Entity UID (feature or object) listed. If no records 

are found, this information box opens.  

9. If assets need updating, these options are available.  
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 To automatically synchronize the IDs, click the Commit button.  

NOTE: If any assets are selected, only those selected will be updated. If no assets are selected, all assets 
requiring updating will be changed. 

 

When clicking the Commit button, two confirmation boxes open before the changes are made. The first one 

asks the administrator to confirm that a backup of the Cityworks database exists. Click Yes on the Confirm 
Backup Exists message when the backup is done. 

 

The second box asks if the selected conflict analysis results should be committed to the Cityworks database. 

Click Yes when the Confirm Sync message box opens to continue with the synchronization. 

When the changes are completed, the Conflict status changes to Updated. 

 

If an error occurs, the Status column returns with Failed. Check to see if the database connection has been 

lost; if so, re-establish it and try again. If not, make the change manually. 

 To manually change the information in the Cityworks database, click the Print button to print the 

list or the Save to File button to save the list as a file. First, use the Remove button to remove 
any records not needed for printing or saving and click Yes when the confirmation box opens. 

o Print—Click the Print button to print the geodatabase sync results. When the 

confirmation box opens, click Yes to print the list to the administrator’s default printer.  

Depending on the length of the list, it may take some time to format the information for printing. A second 

confirmation box may open to estimate the number of pages the list is and asking if the user wants to 
continue.  
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 Save to File—Click the Save to File button to open the Geodatabase Sync Results box. 

Navigate to the desired file location, name the file, and click the Save button.  

Click Yes when the message box opens stating the file doesn’t exist and asking if the user wants to create it.  

A message returns to inform the administrator that the text file was saved and lists its location. Click OK to 
close the message. 

If saving an existing file, click Yes when the message box opens to replace the file. If a new file is wanted, 

click No and save it with a different name. The same Save message opens to confirm that the file has been 
saved. 

The information is saved as a .txt file in Notepad. 
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Storeroom 

The Storeroom group is for users of the Cityworks Storeroom add-on only and functions similar to domain 

administration. Storeroom domains are created and groups are defined to designate which employees have 
permission to issue, receive, transfer, and audit materials for each storeroom. Currently this is the only 

function in the Storeroom group. 

The Storeroom function only displays when the administrator logs in as the Storeroom domain 
administrator. Superuser logins cannot access Storeroom.  

NOTE: If logged in as the superuser, click the Login button on the toolbar and log in with a Storeroom 
domain administrator login for the desired domain. 

There is one function under Storeroom: 

 Storeroom Domain Groups—Sets up the Storeroom domain groups with the employees and 

assigns permission for Storeroom transactions. 

The only other setup required to use the Storeroom add-on is to populate the Codes and Descriptions 

boxes. This can be done in Designer under Others > Codes by selecting Others as the Asset Group and 
populating the following Code Types / Description:  

 ACCOUNT / Storeroom Accounts 

 AUDITINT / Material Audit Interval 

 STORERM / Storeroom Names 

 UNITMEAS / Material Quantity Unit of Measure 

NOTE: Codes and Descriptions may also be populated directly from Storeroom by using the recessed button 
function when one of these Codes and Descriptions boxes open. 
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Storeroom Domain Groups 

The Storeroom Domain Groups function defines the Storeroom groups, places the employees into those 
groups, and assigns permission for groups to audit, issue, receive, and transfer materials in Storeroom. 

Groups Tab 

Storeroom groups are defined by domain. The Groups tab allows the domain administrator to set up 
Storeroom groups and assign employees to the group. 
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1. Type in the Name, up to 50 characters long, and associated Description, up to 160 characters 
long.  

2. Click the Save button to list the Group Name on the upper right pane. 

3. Select the employees from the list of Available Employees on the lower left pane and click the 

right arrow button to place them in the Assigned Employees list on the right.  

TIP: Use <Ctrl + click> or <Shift + click> to make multiple selections or double-click on the desired 
employee to move them one at a time. 

4. Click the Clear button to clear the fields to add another group. 

Modifications may be made to any group by double-clicking on the group in the Existing Groups list to load 

the information on the tab. Employees may be moved in or out of a group, using the right or left arrow 
buttons or by double-clicking on the name.  

NOTE: An employee is listed in one list or the other but not both. 

Group Rights Tab 

The Group Rights tab assigns Storeroom groups permission to perform storeroom transactions. Once the 
information has been entered, it can be viewed in the list on the lower pane by selecting any or all of the 
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groups and storerooms. Update any of the information by following the steps below to replace the current 

listing.  

1. Select the Group Name on the upper left pane.  

NOTE: Multiple groups can be selected at the same time if they need the same Storeroom permissions. 

 

2. Select the storeroom location(s) from the Storerooms list in the center pane where the selected 

storeroom group needs user privileges.  

3. Check the applicable boxes for the Group Security Rights: 

 Audit—Permission to adjust Storeroom quantities when performing audits to reflect the actual 

stock on hand or change material unit costs. 

 Issue—Permission to distribute or release materials to work orders, employees, or accounts. 

 Receive—Permission to add materials to the Storeroom received from suppliers, accounts, or 

work orders. 

 Transfer—Permission to move materials from one storeroom to another. 

TIP: If a person has Issue rights, Receive rights should also be granted so unused materials can be 
received back into the storeroom. 

4. Click the Add button to add the selected permission rights to the database and list them on the lower 

pane. 
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5. Add the permissions for each group by repeating these steps.  

NOTE: The lower pane lists only the information for the selected group. 
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Server Setup 

Server Setup consists of these additional functions needed to complete the configuration for Cityworks 

Server. The Server Setup option is only displayed when the selected Cityworks database contains valid 
Server tables and the existing Server application. See Cityworks Database Manager for specific instructions if 

Server Setup is not listed for the login. 

NOTE: The database list in the Cityworks login dropdown selection is populated with the database at the 
time an ODBC connection is set up. 

 

The following functions are available under Server Setup.  

 Contract Line Items—Set up a tree structure for defining the items available on contracts. 

 Audit Settings—Select the fields to track in the Audit Log for requests, work order, 

inspections, contracts, and/or projects.  

 GIS Services—Points Cityworks Server applications to the server where the map documents are 

stored as well as designating which geolocating service to use. Specific maps can be created and 
customized for a domain, user groups, or employees. 

 Asset Edit Fields in Inspection—Allows the Cityworks domain administrator to select the asset 

fields that are editable on Cityworks Server AMS inspections and saved directly to the 
geodatabase. 

 GIS Attribute Updates—Allows the Cityworks domain administrator to select the asset fields in 

the geodatabase to be updated when a work order is closed with a work order field or custom 
value. 

 User Settings—Allows the Cityworks domain administrator to define a custom layout folder for a 

domain, group, or specific user. 

 Login Manager—Allows the administrator to designate the users who have access to AMS, PLL, 

Contract, and API as well as keep track of the logins being used. 

 Equipment Changeout—Allows the domain administrator to customize labels on the 

Changeout forms. 

Cityworks Database Manager 

Before these Designer settings are available, the Cityworks database must contain valid Server tables, which 
can be done using Cityworks Database Manager. If generating a new database, first generate a Cityworks 
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Desktop database using the GIS Option for ArcGIS. Then follow the steps below. To migrate to a database, 

set up and import the data from an Access personal database first and verify that the fields have mapped 
correctly to the Cityworks database.  

IMPORTANT: Confirm and reset user/role permission for CWWebUser, which are the stored procedure 
scripts that grant proper permission to access the database, before running Cityworks Database Manager.  

1. Open Cityworks Database Manager from the Start menu > All Programs > Cityworks > 
Database Manager. 

2. Check Execute Update Scripts and Validate Table Structure.  

 

3. If running a version update, select the Update to Version from the dropdown. 

4. For the GIS Option, select Server from the dropdown.  

5. Click the Run button to perform the selected operations and wait a few minutes until the process is 

complete. The Actions Performed During Session are listed on the right along with the time it 

took to run. The Last Update lists in red on the bottom of the center pane and indicates if the 
Cityworks database is Server-compatible.  
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Additional Server Configuration 

 When Designer is first opened as a Cityworks domain administration, navigate to Others > Preferences 
and click Save. By default, the Use ArcGIS Data Model (#21) value is set to Y, which is the preference 

needed to use the Cityworks Server. 

 

Additional tabs and fields for setting up Cityworks Server AMS functionality can be found in multiple locations 
in Designer. See the corresponding sections for details on these functions.  

Under Cityworks Setup: 

Request Templates 

 If the organization is utilizing a public website to generate citizen requests, change the For 

Public Website setting to Y (True) for all request types that should be included on the site 

using the General info tab. If adding in a single template or a new template, use the General 
tab on the Request Template Edit window.  

 Use the WO Templates tab to associate multiple work order types to the request template, such 

as a water leak to inspect, repair, or flush main activity for creating a work order from a request.  

NOTE: Because Cityworks Server AMS is a one-to-many relationship (1:m), rather than the 1:1 relationship 
found in Cityworks Desktop, multiple work order types may be associated to a single request as well as 
multiple inspections assigned to a single work order. 

Work Order Templates  

 On the Inspections tab, set custom inspection(s) to automatically be created when the work 

order is created and set up cycles for custom inspections.  

Contractors 

 On the Contractor Edit form, changing the last field in the Information pane to No for 

Visible in Server removes a contractor from the current contractor selection lists in Server.  

Equipment 

 On the Equipment Edit form, unchecking the Viewable in Server box removes the equipment 

item from the current selection lists in Server.  

Materials 

 On the Material Edit form, unchecking the Viewable in Server box removes the material from 

the current selection lists in Server. 

Custom Inspection Templates 
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 Use the Server Panel Configuration tab to designate required observations that users must 

populate before an inspection can be closed and to configure the inspection panels by adding 

subheadings and grouping the observations. 

Employee Relates 

 Set up the base-level security for what a user can do in Employee Relates.  

NOTE: Access for which Server pages a user can access and view is granted through web security rules. 

Work Order Template Classes  

 Use the Classes tab to set up parameters for the software to create different work order 

templates based on various characteristics of an asset, such as size, location, etc.  

 Use the Rule Sets tab to link the work order template to specific values for the fields selected on 

the Classes tab. When the asset is selected, Cityworks checks the parameters and selects the 

appropriate work order template. 

 Optional: Use the Load tab to load this information from a text delimited file.  

Under Others: 

Preferences 

 Populate the Server options, on the General tab.  

NOTE: See the section Preferences for information about these options. 

Other System Codes 

 Populate the codes to set up the field mappings from another system, like 311, to request 

templates. This populates the Other System Code field found on the value table on the 

General pane of a request. 

Contract Line Items 

The list of Contract Line Items set up in Designer is used to create contracts in Cityworks Server AMS. A 

contract is built using line items to specify the conditions. Contracts can be used to bid out specified tasks, 
such as pruning, planting, repairing sidewalks or streets, etc. or to accomplish a certain amount of work. It 

may have a set budget or consist of a set amount of work or quantity of materials. A contract may also be 

used to track materials and/or equipment, pay costs by line item, and be spread over multiple work orders or 
inspections. The remaining units of measure can be calculated to find how much of the contract has been 

used and what remains.  

NOTE: Contracts can only be linked to work orders or inspections. 
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1. Click New Trunk to open the Enter Value box, type in the names for the trunks and click OK.  

 

2. Optional: Select a trunk and click Add Category to add categories under each trunk. Add categories 

for each trunk as needed. 

3. Select either the trunk or category from the tree and click New Item to open the Contract Line 
Item Edit box for defining line items. 

4. Type in the Description. 



 

Designer 2013 Guide Server Setup    193 

 

5. Click in Unit of Measure to open the corresponding Codes box to populate the value. 

 

6. Click the Save button.  

TIP: Clicking the Save or Clone button does not automatically close the box so items can be cloned or 
added to the same trunk or category. 

 

7. To add other items under the same trunk or category, change the Description and if necessary the 
Unit of Measure and click the Clone button to save the new line item.  
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NOTE: The Clone button is activated as soon as the Description is modified. 

8. Follow step 7 until all desired line items are added to the selected trunk or category and then click 

the Close button to close the Contract Line Item Edit box. 

9. Repeat these steps until all items have been added to each trunk and/or category. 

Contract line items can be deleted by opening them from the hierarchy, clicking the Delete button, and 

clicking Yes when the confirmation box opens.  

NOTE: The Delete Node(s) button at the top of the Hierarchy tab just removes the information from the 
hierarchy but not from the Description list on the right. 

Audit Settings 

Audit Settings identifies which fields are tracked in the Audit Log for service requests, work orders, 
inspections, contracts, and/or projects. Initial values and any subsequent changes to the selected fields are 

noted.  

1. Select the Current Domain from the dropdown. 

 

2. Select the Activity (Table) to populate the Available Fields on the left.  

 Contract 

 Inspection 

 Project 

 Request 

 WorkOrder 

3. Select the fields to be tracked in the Audit Log by moving them to the right.  

NOTE: To remove field(s), select and move back to the left. 
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GIS Services 

GIS Services sets up the link for where the Cityworks Server applications look for its GIS information. As 
many as three maps and one geocoding service may be set up per entry. Entries may be assigned to 

domain(s), group(s), or user(s) to provide specific maps for different users.  

In Designer 2011, dynamic, tile, and image service types are supported. Web map and feature layer service 
types are added in 2012.1. It’s very important all services use the same spatial reference. If a REST 

(Representation State Transfer) endpoint is entered, Cityworks Server uses that value instead of the host and 

service values. If no REST endpoint is entered, Cityworks Server uses the host and service values. 

NOTE: There is no difference between the base or raster map; they just provide two ways to store and 
display cached information on the main map. For more information on map caching, refer to Esri’s ArcGIS 
help. 

1. Click in the Value column in the Map and geodcode service definitions frame to enter 
information or open a dropdown list. Required fields include Main Service Name, Main Service 

REST URL, Geocode Service Name, Geocode Service REST URL, and Geometry Service 
REST URL. In the name values, enter the name to display in the legend. In the type values, select 

from the dropdown list of values. 

 

 DYNAMICMAP—Select when using a non-cached map where the data is dynamically rendered 

(the single fused map cache is set to False in the Esri online map service ArcGIS Services 

Directory). This is an Esri published option. 

 FEATURELAYER—Select when using a specific layer from the map service, not the entire map. 

The layer can be either a (spatial) layer or (non-spatial) table.  

 IMAGEMAP—Select when using an image service. 

 TILEDMAP—Select when using a cached map service (the single fused map cache is set to True 

in the Esri online map service ArcGIS Services Directory. This is an Esri published option.  

 WEBMAP—Select when Esri’s webmap has been utilized to publish data to ArcGIS Online. Copy 

the ID portion of the URL from the ArcGIS Services Directory and paste it into the REST URL 

Value field. This is for web services.  
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NOTE: The Public Service Name, Public Service Type, and Public Service REST URL fields are for 
users who wish to publish search results as a map that can be shared with others, regardless of whether or 
not they are a Cityworks user. These fields determine what the map displays. The REST URL field should 
point to a base map that can be viewed by anyone.    

2. Click Save to save the information to the Existing Services. If required information is missing, a 

message box opens to tell the user which field to populate.  

NOTE: Standard Inspections and Equipment Changeout require custom logic included in the Server Object 
Extension (SOE) Service REST URL when working with ArcGIS 10.1. Read Knowledge Base article 10633 for 
detailed information about the SOE Service field. 

3. Go to Others > Preferences > Server gis model and select either geodata or rest. If geodata is 
selected, the two geodata fields are activated. If rest is selected, the SOE field is activated.  

4. Select the Current Domain and applicable radio button option in the Apply To box for Domain, 

Group, or User. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10633.aspx?Keywords=10633
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5. Select the desired domain(s), group(s), or user(s) from the Name list who need access to this Server 

map, using the right arrow to add them. 

6. Follow steps 1-4 to add other Server map information.  

NOTE: Once the map control properties have been defined, the spatial reference of any image service and 
tiled map service must match the spatial reference of the initial loaded layer. The visual display order is 
Raster, Base, and Main. 

Click on an entry in the Existing Services list to change any of the information entered. When the Save 
button is clicked, a confirmation opens to verify the user wants to continue to update the current service. 

Click Yes to update the information.  

TIP: Updating the Service Associations on the lower pane is done by moving the information back and 
forth. It is not necessary to click the Save button to make these changes. 

Asset Edit Fields in Inspection 

Asset Edit Fields in Inspection sets up the attributes for an asset which can be edited directly within a 
Cityworks Server AMS custom inspection form to update the geodatabase values.  

 

1. Select the Asset Group from the dropdown list. 

2. Select Features or Objects radio button to list the associated features or objects. 
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3. Optional: Check the box for Show Tables Owned by SDE if SDE is the owner of the database 

tables.  

NOTE: The checkbox for Show Tables Owned by SDE appears on the form for users connecting to 
ArcSDE but not a personal or file-based geodatabase. 

4. Select the feature or object from the list to populate the Asset Fields from the geodatabase. 

5. Select the desired field(s) from the Field Name list that are part of the Cityworks Server AMS 

inspection which the user will be able to edit. 

6. Select the custom inspection(s) from the Inspection Templates list. If the asset is not already 

linked to the custom inspection type, click the Show All button to list all the custom inspections.  

 

IMPORTANT: If linking an asset to a custom inspection which doesn’t show up when the asset is selected, 
be sure to go back to Custom Inspection Template > Templates tab to assign the asset to the 
inspection.  

7. Click the Save button to list the Editable Fields on the lower right pane. 

GIS Attribute Updates 

GIS Attribute Updates allows closing a work order to trigger an automatic geodatabase update. The 

administrator maps each desired attribute field in the geodatabase to the corresponding work order field or to 
a custom value so an asset’s attribute(s) can be updated when the work order is closed.  

1. Select the Asset Group from the dropdown list. 
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2. Select the radio button for Features or Objects to populate the asset Description list. 

3. Optional: Check the box for Show Table Owned by SDE to include these assets in the 

Description list.  

NOTE: The checkbox for Show Tables Owned by SDE appears on the form for users connecting to 
ArcSDE but not a personal or file-based geodatabase. 

4. Select the asset from the Description list to populate the associated Work Order Templates. 

5. Select the Asset Field from the dropdown listing the geodatabase fields for the selected asset. 

6. Select the applicable radio button and populate the corresponding field to link to the Asset Field: 

 Custom Value—Type the desired value into the field. 

 Work Order Fields—Select from the dropdown list of fields on Cityworks work orders. 
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7. Select the applicable Work Order Templates from the list, using <Shift + click> or <Ctrl + click> 

for multiple selections. 

8. Click the Save button to save the Field Updates. 

9. Repeat these steps to add any other desired fields.  

To view the complete list of Work Order Templates and Field Updates, click the Show All button.  

To remove, select the field(s) from the Field Updates list, click the Remove button, and click Yes when the 

confirmation box opens.  

User Settings 

User Settings allows the Cityworks domain administrator to define a custom layout folder for a specific user. 

This is a way for the domain administrator to customize that user’s user interface (what they see when they 
log in to Server). These settings overwrite the value of the Server default layout folder in Others > 

Preferences. 

User Settings is also used to configure field mode for individual users or groups of users. See below for 

more information on configuring field mode.  
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Default server layout folder is the only option for the Select a setting dropdown.  

1. Enter a value in the text box.  

2. Select the desired employee(s) from the list. 

3. Click the Save button to list the employees in the Existing User Settings panel. 

Browse to C:/inetpub/wwwroot/<sitename>/WebSite/Xml. There will be a folder with the same name as 

what you entered in the Enter a value field. Inside this folder, there are XML files that can be customized. 
The users you assigned to this value will see their user interface as whatever is configured in these files. For 

more information on XML customization, see Server UI Customization on mycityworks.com under the 

Resource and Download Center.  

Field mode allows users to use Cityworks in a mobile setting, such as on a tablet at the job site. Browse to 
C:/inetpub/wwwroot/<sitename>/WebSite/Xml. There is a folder here titled Field that has some out-of-the-

box custom XML files provided for you. If you want to use this XML customization for field mode, return to 
User Settings Designer and type Field in the Enter a value text box, select the desired employee(s) from 

the list, and click Save. 
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If you would like to use your own XML customizations for field mode, you would need to create those XML 

files, add them to a folder under C:/inetpub/wwwroot/<sitename>/WebSite/Xml, and then go to User 
Settings in Designer and enter the name of that folder in the Enter a value text box, select the desired 

employees, and click Save. 

Login Manager 

Login Manager allows the administrator to track the number and type of users in the system by designating 

which users have access to AMS, PLL, or APIs. It allows the administrator to easily see how many licenses 
they have and how many are being used.  
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1. Select the Current Domain from the dropdown list. 

2. Select the desired Domain Group. 

3. Select the tab for AMS, PLL, or API. 

4. Find the desired employee(s) from the list and check the applicable boxes.  

For AMS, check the box to give rights as follows: 

 AMS Edit—gives user rights to view and edit service requests, work orders, and inspections.  
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 AMS Edit+—gives the same rights as AMS Edit, as well as web services.  

 AMS View—gives user rights to view service requests, work orders, and inspections.  

 AMS Inspection—gives user rights to view and edit inspections, as well as view work orders 

and service requests.  

 Call Center—gives user rights to view and edit service requests.   

 Contracts—gives user rights to view and edit contracts.   

5. Click the Load License File button. 

NOTE: You might have to maximize the Designer window in order to see the Load License File button. 

Equipment Changeout 

Equipment Changeout allows the domain administrator to customize labels on the Changeout forms. 

 

1. Select the Current Domain from the dropdown list. 

2. Select the desired Asset Group. 
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3. Select the Features or Objects option. 

4. Select the Asset Type from the list. 

5. Select the Field Name to edit from the dropdown list. 

6. Enter the Field Label to customize the Changeout form. 

7. Either enter the GDB Field Name or select a Coded Value: 

 GDB Field Name—Enter the name of the field from the geodatabase.  

 Coded Value—Select the desired work order entity field.   

8. Click Save to add it to the Cityworks geodatabase and list it in the Configuration section. 

Attachment Mappings 

By default, a user can only download attachments that have the same path as what is specified in the Server 

attachments root directory preference in Designer (under Others > Preferences). Attachment 
Mappings, however, allows you to map a path so that attachments can be downloaded from another 

directory.  

Attachment Mappings can also be used to specify which drives or folder locations Cityworks Server will try 
to access.    

NOTE: If attachments are stored anywhere other than the default image directory under 
C:\inetpub\wwwroot\<site_name>\..., you have to set the attachment mapping.  

 

To give Cityworks Server access to a folder location: 

1. Select the Current Domain. 

2. Enter the Source path for the directory. This must be either a local drive or a UNC path. 

NOTE: The impersonate user must have permissions for the folder location because Cityworks Server 
accesses those locations as the impersonate user. 

An Alias is needed when the Source path cannot be resolved by Cityworks Server and an alternate path 

needs to be used. If an Alias is defined, Cityworks Server replaces the Source with the Alias before 
attempting to find the folder or file. If you are storing attachments in a location other than what is specified 

in the Server attachments root directory preference, you need to define both a Source and Alias.  
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3. If needed, enter an Alias. 

4. Click Save. 

To remove a mapping, select it in the Configured Mappings panel and click Delete.  
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Others 

Others consist of these miscellaneous functions to complete the Cityworks setup. 

 

 Units of Measure—Assigns the units of measure used for fields on Cityworks inspection and 

test forms so they match those used for the asset in the geodatabase. 

 Codes—Defines or imports codes, descriptions, and/or scores for various Cityworks fields, 

displays the CCTV code groups, and sets up the dynamic labor codes. 

 Custom Data Fields—Sets up the custom fields for employee, equipment, material, contractor, 

and timesheet. 

 Preferences—Defines global settings for the domain, including a holiday schedule, and sets up 

the email functions.  

 I/I Quantity Matrix for Smoke Testing—Sets up the light, medium, and heavy quantities for 

the different leak types and categories.  

 Map Layers and Fields—Sets up districts, zones, commissioner areas, or any other geographic 

area by map layer for assigning service requests. 

 Customer Accounts—Sets up or imports the customer account information and imports street 

names with their codes. 

 CU Material Groups—Defines “favorites” (assemblies or groups of materials) used only with the 

Miner & Miner Designer interface. 

 Macro Manager—Updates the macros for custom print and email templates when a new 

version of Cityworks is released so the data loads into the fields correctly. 

 Record Lock—Identifies which requests or work orders are currently locked by Cityworks users 

and allows the administrator to remove the lock(s). 

 Other System Codes—Acts as a look-up table for interfacing Cityworks request templates to 

codes in a third-party software, such as 311. Mappings can be made manually or imported from a 
file. 
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Units of Measure 

Units of Measure allows an administrator to define measurement units for some fields on the inspection 
tables to sync them up with geodatabase information. For example, if manhole depth is listed in inches or 

feet in the geodatabase, then the depth to the defect can be listed with the same units in the Cityworks 

database. Current measurement units can be viewed for each inspection. 

1. Select the Current Domain from the dropdown list. 

 

2. Select the Asset Group from the list on the left to populate the Table Name list. 

3. Select the Table Name for the inspection on the right. 

4. Select a Field Name from the list on the bottom pane to load it into the center area.  

NOTE: The Field Name cannot be changed. 

5. Type in the desired Unit of Measure for the field.  

6. Click the Save button to save the measurement. 

7. Repeat these steps to add each field and unit for the table. 

8. Repeat for each table in the asset group and for each asset group. 
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Codes 

Cityworks Codes define the lists used to populate various feature inventory, service request, work order, or 
inspection fields. Code types and definitions may also be imported into Cityworks code tables. Many codes 

are used on Cityworks inspection forms.  

NOTE: The CCTV, Cost Codes, and Job Codes tabs are only visible when the corresponding Preferences 
have been set.  

Add/Modify Tab 

The Add/Modify tab allows the administrator to populate or modify existing codes to customize the valid 

values a user may select and add additional codes with their values for any user-defined custom fields.  

NOTE: Not all listed code types are used with ArcGIS; some are only used with the ArcView 3x application. 
See Appendix 1: Cityworks Codes for information on which codes to populate. 

TIP: APRIORIT under Others requires at least one code to be defined.  

1. Select the Current Domain from the dropdown list. 

 

2. Select the Asset Group from the dropdown list to load the associated Code Types. Use Others for 

codes that apply to more than one asset group.  

TIP: Codes belonging to an asset group generally begin with the same letter so they are easily recognizable. 
Most Others codes begin with the letter A. 
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3. Select the Code Format:  

 Codes and Descriptions—Use for fields that do not have scores associated to them. This is the 

default setting.  

 Descriptions and Scores—Use only for predefined inspections. 

 

 Codes, Descriptions and Scores—Use for TV Inspection Observations. 
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NOTE: The Code Format selection determines which Code Types are listed in the left pane and which fields 
are active at the bottom of the right pane. 

If the code type is not supported, the Code Types section will say NA, Cannot define codes for current 
selection. 

4. Select an existing Code and Description from the Code Types list on the left pane or add a new 

custom Code Type, 8 characters maximum, and Description by typing in the fields at the bottom 

of the left pane and clicking the Save button.  

NOTE: Code Type is not editable; Description may be edited if desired by typing in the field and clicking 
Save. The first letter of each code represents the asset group and cannot be changed. 

5. Type in the applicable fields at the bottom of the right pane for Code, Description, and/or Score.  

NOTE: The Clear button clears the Code, Description, and Score fields. 

6. Click the Save button, which saves the information into the list and clears the fields for adding 
additional entries.  

NOTE: A code may be deleted by clicking on it in the list to load the fields at the bottom of the pane, clicking 
the Delete button and clicking Yes when the confirmation box opens. 

7. Repeat steps 5-6 to add the rest of the information to the Code Type.  

8. Add all relevant Code Types by repeating steps 3-7 for each Asset Group.  
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Import Tab 

The Import tab allows the administrator to add codes by importing them from an existing file rather than 

using the Add/Modify tab to add them in one at a time. The file must be a delimited text file in one of the 
three formats allowed. 

 

1. Select the radio button for the desired Code Format.  

NOTE: Code Formats are described in the previous section under step 3. 

2. Select the radio button option for Delimited By type. 

3. Click the Browse button to open the Select Code File(s) to Import box.  

TIP: To load multiple files at the same time, keep them in the same folder. 

4. Browse to the desired file(s) and click Open to load the File Path in the list.  

TIP: To make it easier to find the desired file when the File Path is long without having to enlarge the 
window, the hidden column Filename may be opened by hovering over the right margin of the column 
header until the double arrow appears, and then dragging it open. 

   

5. Select the desired file(s) and click the Import Selected button.  

NOTE: Multiple files may be imported at the same time as long as the Code Format and file delimiter are 
the same. 

At least one file must be selected before clicking Import Selected or a message opens to remind the user. 

6. When the confirmation box opens to verify the code format of the file is correct, select Yes to import 

the information.  

TIP: The information varies according to the radio button option selected under Code Format. The Code 
listed on the Add/Modify tab must be the first entry on each row. 
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If the information is successfully imported, the imported file name lists in the Import Results column across 

from the path. If the format is not correct, either an error box opens describing the problem or the first row 
causing the problem lists in the Import Results column.  

 

To remove any entries from File Path, select and click the Remove button. To clear all the files, use the 

Clear All button and click Yes when the confirmation box opens.  

CCTV Tab 

The CCTV tab displays the standard PACP CCTV codes. These PACP codes are also used by the Cityworks 
CCTV Interface for PACP add-on application. When NASSCO (National Association of Sewer Service 

Companies) updates their PACP codes, these codes can be modified accordingly. The staff at Azteca Systems 
Inc. strives to keep these codes current but they may be modified by the Cityworks domain administrator so 

they are always up-to-date.  

NOTE: PACP is the Pipe Assessment and Certification Program of NASSCO designed to standardize sewer 
pipe condition as assessed by a closed-circuit television (CCTV) video camera. 

These codes can be used on the Cityworks TV Inspection form by setting the Use CCTV Codes (item #24) 

to Y under Others > Preferences. The CCTV tab is only available when this preference has been set to Y. 

 

1. Verify that all needed CCTV codes are included with the current parameters.  
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2. To change a field, double-click in the field and type in the correct information. 

 

3. To add in a new code, scroll to the bottom of the list and click in the first column of the blank, 
asterisked row to activate the row and type in the new information. 

Cost Codes Tab 

The Cost Codes tab works in conjunction with the cost code information on the Employees window. Cost 

codes are used by organizations to add custom pay rates not found on the Employees tab for adding labor 
to requests and work orders.  

NOTE: The Cost Codes tab is only visible when the Use Dynamic Cost Codes setting is set to Y in 
Preferences (General tab).  

 

IMPORTANT: Do not use dynamic cost codes for employee labor rates if asset- or task-based costs are 
desired. Cityworks does not yet support this functionality.  
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Do not define a Regular job code as it is already in use. A message opens to tell the user that Regular 

cannot be used as a dynamic code because it is reserved and used in all labor entries. 

1. Enter the Code, maximum of 20 characters, and the Description, up to 250 characters. 

 

2. Enter the Sequence ID to indicate the order for listing the codes.  

TIP: If an alphabetical listing is wanted, use 1 for all Sequence IDs. 

3. Click the Save button to add the information to the list and to the Cityworks database.  

The Clear button clears the fields above the buttons to allow new information to be entered. The Refresh 

button lists the cost codes for all domains.  

To delete a cost codes, select the desired code(s) and click the Delete button. Click Yes when the 
confirmation box opens asking if the user wants to continue.  

The Cost Code must be in the Current Domain to be deleted or an error message opens. It must also not 

be assigned to any employee(s). Remove the cost code from the employee(s) listed on the Assign Cost 
Codes tab before deleting the cost code. 

Job Codes Tab 

The Job Codes tab defines customized job codes used on the Employees window to allow paying a flat rate 

for a particular job type that overrides the employee’s regular labor rate, such as union-based rates for 
digging a ditch, driving, operating a jackhammer, etc. These rates are set with a start and end date so the 

date the work is done determines which rates apply. This enables different rates to be used as needed 
without having to constantly update the rates under each employee.  

NOTE: The Job Codes tab is only visible when the Use Dynamic Cost Codes setting is set to Y in 
Preferences (General tab).  

1. Type in the Code, Description, and Hourly Rate.  



 

216    Others Designer 2013 Guide 

 

2. Select a Start Date and End Date using the dropdown calendars.  

NOTE: Start and End Date cannot overlap for the same Code. 

3. Click the Save button to save the information to the list below.  

NOTE: To delete a job code, click on it and click Delete. 

4. Add all other codes desired for each domain. 

Custom Data Fields 

Custom Data Fields sets up the custom tables for employees, equipment, material, contractor, and 
timesheet.  

 

1. Select the desired table from the Tables dropdown list. 

2. Type in the Field Name. 
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3. Select the Field Type from the dropdown list: 

 Date—No further information needed.  

 Numeric—Type in a Min Value and Max Value.  

TIP: For the software to do a numeric validation on the field value a user enters, type in at least a Min 
Value; otherwise any text may be entered in the field. 

 Varchar—For variable character text. If desired, a Code Type may be used to set valid values 

for the field. Click in the Code Type field to seelct the desired code type.  

  

4. Select the radio button option for Use Code or Use Description for how to display the code for the 
user.  

Custom Code Types also need to be populated with values under Others > Codes.  

5. Check the Field Visible box to display the field on the service request or work order.  

TIP: Uncheck Field Visible to store information where the user does not need to view the field and to 
prevent the field from being edited, such as an account code. 

6. Check the Field Required box if the field is mandatory.  

Requiring custom fields means the user cannot save the record until this information is entered.  

7. Click the Save button to save the custom field.  

Preferences 

Global domain settings are found on the Preferences window. Defaults for specified fields and items on 
requests and work orders may be set. Map polygon layer names can be defined for Map Page, Shop, and 

Tile Number to populate the respective fields on a request or work order. There are three tabs: 

 General for setting global domain settings. 

 Email Settings for setting up email functionality. 

 Holidays for listing the organization’s holiday schedule for cyclical work orders. 

Preferences General Tab 

 The General tab sets up the basic preferences for Cityworks, such as enabling functions and setting default 
values. These preferences are set for the entire domain.  

There are 3 columns that are hidden by default:  

 Element—Lists the name of the field in the Preference table.  

 Default Value—Lists the default reflecting the preference most Cityworks users select for the 

option.  
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 Default Order—Use to put the list back in the original order if it has been sorted by another 

column.  

To display these hidden columns, double-click to the right of the Value header until all 3 display.  

 

1. Select the Current Domain.  
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2. Double-click in the Value field to enter text or toggle between the choices. All of the options are 

explained below.  

3. Check the Update “Print Templates – last update’ to current date/time box to populate the 
current date/time when the Save button is clicked to capture the date if using a network location to 

update custom print templates. Also fill in the Print Templates – network location field by 
navigating to the file where custom Cityworks print templates are stored. The software compares this 

date to the one stored with the templates to use the newer print template.  

NOTE: This checkbox must be checked each time a new service pack containing new templates is installed to 
refresh the date. 

 

4. Click the Save button. 

The Designer preferences are described and numbered according to their default order. 

0. Default Work Order Cost View—Toggles between ACTUAL and ESTIMATED for selecting the 
default radio button option on the Labor, Material, and Equipment panes for new work orders. 

1. Default Geocoding Locator Type—Toggles between STREET and PARCEL to select which 

geolocating service is active on requests and work orders.  

NOTE: Geolocating services must have the word street in the name for those using street layers or parcel 
for those using point or polygon layers. 

2. Allow Materials to be Edited in Designer—Toggles between ENABLED and DISABLED for 

users of Cityworks Storeroom to determine whether material edits may be made in Designer or just 
in Storeroom (DISABLED). Designer contains all the fields found in Storeroom; however, the fields 

for compatible units are found only in Designer.  

3. Manually Assign Work Order IDs—Toggles between DISABLED which assigns a consecutive, 
system-generated ID number and ENABLED which allows users to assign work order numbers.  

NOTE: Azteca Systems Inc. does not recommend enabling users to assign work order IDs. 

4. Manually Assign Ratings—Toggles between DISABLED and ENABLED to allow ratings for certain 

inspections to be manually assigned. 

5. Allow Changes to Initiated Date/Time—Toggles between DISABLED and ENABLED where 
date/time initiated may be changed.  

TIP: Date/time stamps for initiating service requests and/or work orders are tracked in the Audit Log so the 
original date/time may still be viewed. Allow Changes to Initiated Date/Time is useful if the information 
is entered into Cityworks at a later time. 

6. Default Area Code—For areas with only one area code for phone numbers, type in the area code. 

If the area has more than one area code, enter one as the default Value.  

NOTE: If Auto format phone numbers is set to Y, a Default Area Code must be entered. If not, the 
field may be left blank. 

7. Map Feature Name—Type the name of the polygon feature class to use to spatially derive map 

names or grid locations. 
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8. Map Field Name—Type the field name for the map pages in the Value field. 

9. Tile No. Feature Name—Type the name of layer where the tile information is stored. 

10. Tile No. Field Name—Type the name of the corresponding field inside the Tile No. layer. 

11. Shop Feature Name—Type the name of the layer where the Shop information is stored. 

12. Shop Field Name—Type the name of the Shop field from the Shop layer. 

13. District Feature Name—Type in the name of the layer containing the District information. 

14. District Field Name—Type the name of the District field from the District layer. 

15. Default District—Enter the default District. 

16. Default Request Status - Recent—Toggles between OPEN and ALL for whether to list only the 

open requests or all of the recent requests on the Recent window. 

17. Default Hours for Recent Request Search—Type in the number of hours for List Service 
Requests in last ____ Hours on the Recent window. 

18. Default Work Order Status - New—Select the default status for a new work order from the 

WOSTATUS Codes box.  

NOTE: Status codes are customized by the organization so may vary from those shown. 

 

19. Default Request Status - New—Select the default status for a new request from the SRSTATUS 
Codes box. 
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20. Copy Caller QAs to Request Comments—Toggles between N and Y for whether the questions 
and answers are copied into the Comments field on a service request. 

21. Use ArcGIS Data Model—Toggles between Y and N. Y is for organizations using a geodatabase; N 

for ArcView 3x users using shapefiles and/or coverages. ArcView 3x users will need some additional 
formatting. These functions are accessible when the ArcGIS setting is N and the geodatabase 

checkbox on the login screen is unchecked.  

 

22. Include Cancelled Templates and Tasks in Searches—Toggles between Y and N for allowing 
searches to be performed on cancelled request templates, work order templates, and tasks. 

23. Use Equipment Checkout—Toggles between N and Y for users of the Cityworks Equipment 

Manager add-on. 

24. Use CCTV Codes—Toggles between N and Y for users of Cityworks CCTV Interface for PACP. 

25. First Day of Week—Select the day of the week from the dropdown list for the alphabetical first 
column of the popup calendar for selecting dates.  

NOTE: First Day of Week only affects the popup calendar, not the scheduling of work orders. 

26. Use Dynamic Cost Codes—Toggles between Y and N to use Cost Codes and/or Job Codes.  

TIP: Do not use dynamic cost codes if asset- or task-based costs are needed as they are not yet supported in 
Cityworks. 

Settings for the Budget tab on Work Order Templates: 

27. First Month of Fiscal Year—Set the month beginning the organization’s fiscal year from the 

dropdown selection of the alphabetized months.  

28. Default Workday Hours—Type in the Value for the average crew workday. 
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29. Default Applied Overhead Percent—Type in the Value for the percent of overhead costs to apply 

to the work activity. 

30. Default Budget Range Years—Type in the Value for the number of years prior to and following 
the upcoming budget year to list in the dropdown.  

 

Additional settings for all Cityworks users: 

31. Geodatabase Asset Groups Owned by SDE—Toggles between N and Y for organizations using 
SQL Server which have set up SDE (Spatial Database Engine) as the owner of the asset tables 

(feature or object classes). Sites using a personal geodatabase mark N as well as sites using SDE 

with Azteca Systems Inc. or another user set up as the owner of the asset tables.  

NOTE: Checking the box on the Asset Group Definitions window automatically changes the 
Geodatabase Asset Groups Owned by SDE to Y and vice versa since there is a dynamic link between the 
two. 

32. Default Inspection Status - New—Select the default status for a new inspection from the 
INSPSTAT Codes box. 

 

33. Default Request Caller Type—Select the default caller type for new requests from the ACALLTYP 
Codes box. 
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34. Auto format phone numbers—Toggles between Y and N for automatically inserting the 

formatting for a standard American 7- or 10-digit phone number (the Default Area Code set above 
is added to all 7-digit numbers) when phone numbers are entered on a request.  

TIP: If outside the U.S., set the preference to N for Auto format phone numbers. 

 

35. Use Request domain preferences for GIS layers first—Toggles between Y and N for applying 
the domain settings for request Submit To and Dispatch To employees when requests are created 

for multiple domains. Changing the setting to N applies the domain settings of the person creating 
the request.  

36. Number of system IDs to use during DataPump checkout—Set the number of system IDs 

(default is 1000) in the PWSysIDReserve table to determine how many request and work order 
IDs are assigned to DataPump for creating new requests and work orders in the field.  

NOTE: When there are less than 50 IDs remaining, a new block of IDs is assigned to the DataPump user. 

37. Print Templates - network location—Double-click (or press the spacebar) to open the Browse 

For Folder box for navigating to the centralized location of the folder storing the custom print 
templates for Cityworks which can be accessed by each user. Click OK to load the path into the 

Value field. 

 

 

38. Print Templates - last update—Lists the current date/time when the checkbox for Update ‘Print 
Templates – last update.’ To current date/time. and the Save button is clicked to capture the 

date. The software compares this date to the one stored with the templates to use the newer print 
template.  
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NOTE: This checkbox must be checked each time a new service pack containing new templates is installed to 
refresh the date. 

39. Use server attachment structure—Toggles between Y and N. Changing the setting to Y allows 
Server attachments to be viewed in Desktop. 

40. Cityworks Server Url—To allow Server attachments to be viewed in Desktop, enter the Cityworks 

uniform resource locator (URL). 

41. External App—Type in the name of an executable program. In Desktop, Open External App is 
added to the Tools dropdown on the work order form. This launches the external web application. 

 

The following options, beginning with Default Order #42, are specifically for Cityworks Server. 

 

42. Server print output type—Toggles between DOCX and CRYSTAL. If you select .docx, requests, 
work orders, and custom inspections will be printed as Microsoft Word .docx files. The templates 

must be stored at …\inetpub\wwwroot\<site_alias>\WebSite\PrintDocx. If you select Crystal, the 
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records will be printed as Crystal Report PDFs. The templates must be stored at 

…\inetpub\wwwroot\<site_alias>\WebSite\PrintCrystal. Note that standard inspections will always 
print as Crystal Report PDFs. 

43. Server Crystal Reports root directory—Displays the name of the folder where Crystal Reports are 

located, either Crystal or Crystal Oracle based on the type of database being used.  

NOTE: Server Crystal Reports Root Directory is for information only; no changes can be made to this 
field.  

44. Server attachments root directory—Type in the filepath for the folder where the Cityworks 

attachments are stored. For more information, see Knowledge Base article #10630 Configuring 
Server Attachments on mycityworks.com. 

45. Server map default starting position—Select from the dropdown for: 

 Maximized (full-size map/no Cityworks form) 

 Minimized (map not visible/ full-size Cityworks form)  

 Split Window (splits the screen vertically so both the form and the map are visible).  

NOTE: Minimized is the default setting for the Server map default starting position. 

46. Server map scale bar large scale display units—Use the dropdown selection for Feet (default), 

Meters, Miles, or Kilometers to select the units desired for when a small area of the map is 
viewed.  

47. Server map scale bar small scale display units—Use the dropdown selection for Feet, Meters, 

Miles (default), or Kilometers to select the units desired for when a large map area is viewed.  

48. Server map scale bar switch display units threshold value—The scale ratio used to switch 
from the large to small display units (from Feet to Miles if the defaults are used). The default 

setting is 6000 (1:6000 ratio).  

NOTE: The scale ratio 1:5280 is where 1 foot = 1 mile. (1:63360 for 1 inch = 1 mile). 

49. Server maximum number of records returned through search query—Set the maximum 
number of records returned through a search query. The user receives a warning that the maximum 

results have been reached so they know they may not have accessed all the records. 

50. Server default layout folder—Enter the name of the folder which stores the modified .xml files 
when customizing the interface. 

51. Server paging rows per grid—Specifies how many rows show up in a grid page when searching 

for items. The default setting is 100 per page. 

52. |keyword=laborServer request tree text display—Select from Code (default), 
Code~Description, or Description to determine the hierarchy view for requests.  

53. Server equipment tree text display—Select from Code (default), Code~Description, or 

Description to determine the hierarchy view for equipment. 

54. Server material tree text display—Select from Code (default), Code~Description, or 
Description to determine the hierarchy view for materials. 

https://www.mycityworks.com/KB/KnowledgebaseArticle10630.aspx
https://www.mycityworks.com/KB/KnowledgebaseArticle10630.aspx
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55. Server task tree text display—Select from Code (default), Code~Description, or Description 

to determine the hierarchy view for tasks. 

56. Server Cityworks well known id (spatial reference)—Enter the well known Id (WKID) for the 
map service. This preference is used for printing maps in work order, inspection, and request print 

templates. To find the WKID, open ArcGIS Services Directory and click on the map service being 
used. 

57. Server map image output pixel size—Select from large, medium, or small. 

58. Server map image x buffer distance—number of units from a center point on the X-axis. This 

determines how much of the map is included in the picture. 

59. Server map image y buffer distance—number of units from a center point on the Y-axis. This 
determines how much of the map is included in the picture. 

60. Server work order entity count gis flag—number of entities on a work order that get updated 

GIS values when the work order is opened. The default is 25. If the number of assets on the work 
order is greater than this number, none of the geodatabase values for the assets display on the work 

order. If the number of assets on the work order is less than this number and are all the same type, 
the geodatabase values for the assets will display on the work order.  

NOTE: If the assets on a work order are not all the same type, none of the geodatabase values display, 
regardless of the number of assets on the work order. 

61. Server use radio buttons in custom inspection observations—Change to Y to use radio 
buttons rather than dropdown menus for both branch and linear models. Default is set to N. 

62. Server gis model—select either GEODATA, REST, or SOE. If GEODATA is selected, the two geodata 

fields are activated in the Map and geocode service definitions section under GIS Services. REST 

and SOE use the same fields under GIS Services. The difference is that REST will look for GIS data 
through the various service URLs entered in GIS Services, and if the entity is not found, it will also try 

the SOE, if available. SOE skips all the REST entity search logic and goes straight to the SOE to look 
for GIS data.   

63. Server Max New Page Open Work Activities—enter the number of open work activities to 

display when a user creates a new work order or inspection. Only work activities with the same 
description will be displayed. The default is 10.  

Email Settings Tab 

The Email Settings tab sets up the automatic and manual email information for Cityworks to send internal 

email to designated employees within the organization and external email to callers. The emails can be sent 
at certain times, such as when service requests or work orders are created or closed, when a Submit To or 

Dispatch To person is changed, or when a work order is sent to the Print Queue. Internal emails are sent 
to both the Submit To and Dispatch To personnel set on the request or work order templates.  

TIP: If using the internal email option for WO Print Queue as the event, the number set for the Days 
before Projected Start Date set on the Printing tab of Work Order Templates determines when the 
Submit To person receives email notification that the work order is in the Print Queue and is ready for 
printing. 

To email callers, the customer’s email address must be listed with the caller information on the request. It 

can be typed into the Email field (or if available may be stored in the CustomerAccount table so it loads 
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with the rest of the customer account information). Work order information can also be sent to a caller if a 

work order is created to resolve the problem.  

NOTE: If an email address is found in the CustomerCall table and external emails selected as part of the 
Preferences settings, an email with the subject listed will be automatically generated and sent to the caller. 

 

Default email templates are found in the Cityworks > Templates directory with these names: 

SRInternal.doc, SRCaller.doc, WOInternal.doc, and WOCaller.doc. Associated request information 
populates on internal and caller work order emails. If desired, the administrator may create customized email 

templates for internal and/or external service requests and/or work orders. For Cityworks Desktop, edit and 
save the existing default templates. The four Custom Email Template fields on the Email Settings tab 

apply only to Cityworks Server AMS. Set up these custom email templates in MS Word and save as .doc file 

type (rather than usual .dot template file) in the Cityworks > Templates directory. The name must be 8 
characters or less. The Description can be up to 35 characters. To have information load with data from the 

database, type the field name in square brackets into the template where the information is wanted.  

NOTE: See Customizing Print or Email Templates for more information.  

The .doc file combines a macro to replace keywords with database values and saves it as an .htm file so it 
can be embedded into the email. Hence, the Templates directory will contain both a .doc and .htm file for 

each template following the initial email. 

NOTE: Custom Email Templates fields apply only to Server users. 

1. Switch to the Email Settings tab and select the desired domain. 

NOTE: A brief description of the fields found in the Account Settings section can be found in the shaded 
panel on the right.  

2. Type the reply to address in the From field.  

NOTE: The From field must be a valid email account on the client’s email server. 

3. Type in the address of the email Server for the organization’s IP or network location of the email 
server.  
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4. Enter the number for the SMTP (Simple Mail Transport Protocol) Port on that server that accepts 
outgoing email connections. 

5. Type in the portion of the email address entered in the From which comes before the @ in the User 

field from which emails are to be sent. 

6. Enter the corresponding Password (for the User) for Cityworks to use to connect to the email 
server. 

7. For external emailing: Check the box for Use Authentication. Not checking this box only allows 

internal emailing as the User and Password are not passed to the email server. 

8. Check the box for Enable SSL (Secure Sockets Layer) to encrypt communications with the server.  

NOTE: SSL is required by most servers. 

9. In the sections for Service Request Emailing and Work Order Emailing, double-click in the 
Email Subject field for each Event where an email is wanted to open the Enter an Email Subject 

box.  
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NOTE: Double-clicking in the Email Subject field automatically checks the box in front of the Event so it is 
included. 

10. Type in the text for the Subject line of the email and click OK to load the Email Subject field.  

NOTE: If data from a request or work order is wanted on the subject line, type the field name in square 
brackets to fill in the space with data from the database. For service requests, use [REQUESTID], 
[PROBADDRESS], [PROBCITY], [PRIORITY], [PROBZIP], [DESCRIPTION], [PROBLEMCODE], or 
[STATUS]. For work orders, use [WORKORDERID], [WOADDRESS], [DESCRIPTION], [PRIORITY], 
[LOCATION], or [STATUS]. 

 

11. Custom email template fields for Cityworks Server AMS users only: To use custom email templates: 

Double-click in the Custom Email Template field to open a Codes box. Enter the custom template 
name and a Description of 35 characters or less. Click the Save button to save the code and click 

the Select button to load the code on the Email Settings tab.  

NOTE: If the Custom Email Template is left blank, Cityworks uses the default email templates.  
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The Email Word Templates may also be populated in Others > Codes > EMAILTMP.  

 

12. Click the Save button to save the information.  

The tabbing sequence moves from left to right and top to bottom. For the Emailing panes, the cursor moves 

to the last Email Subject field in the list. Pressing the space bar opens the Enter an Email Subject box 
and checks the box in front of the Event. Type in the subject line, tab to the OK button, and press the 

Enter key to close the box and load the field. Use the up arrow key to move to the next Email Subject 

field. When the Email Subject fields are complete for the section, tab to the Custom Email Template field 
at the top of the section. Press the space bar if using a custom template to open the Codes box for defining 

and selecting the Code. Tab to the next set of Email Subject fields. From the last Custom Email 
Template field for the Work Order Emailing: Custom Email Template field for Caller, tab to the Save 

key and press Enter to save the information. 

Holidays Tab 

The Holidays tab sets up a holiday schedule to avoid having cyclical work orders start on a holiday. Holiday 
schedules are defined by domain. Add all holidays to be skipped for cyclical work. The work orders are 

scheduled for the following work day.  

1. Switch to the Holidays tab and select the domain.  
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2. Select a date by clicking on the dropdown arrow at the end of the Select a Holiday field to open 

the calendar. 

3. Type in the Description.  

4. Click the Add button to list the holiday. 

5. Add all holidays for the domain.  

Update the holiday list each year.  

TIP: Once a holiday is in the list, the same holiday can easily be added for the next year. Double-click on the 
holiday in the list to reload the fields, click on the year to access the up/down arrows, change the year, and 
click the Add button. 

The organization may choose to keep the entire holiday schedule intact or may wish to delete holidays after a 

certain amount of time has elapsed. To delete, select the holiday(s) and click the Remove button.  

I/I Quantity Matrix for Smoke Testing 

Define the categories for Light, Medium, and Heavy smoke amounts if custom values are wanted for 

smoke testing the inflow and infiltration defects found in wastewater and stormwater assets. If no custom 
values are entered for the Leak Categories, the default values are used on the Smoke Test.  

The Leak Categories are found under the Code: SLEAKCAT in Others > Codes > Asset Group: SEWER 

or STORM when the Code Format is set to Descriptions and Scores.  

NOTE: The Description and Score fields may be modified as desired by clicking on the desired 
Description to load it into the fields, making the changes, and clicking the Save button. New ones may also 
be added and old ones deleted as desired to meet the needs of the organization. 
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1. Select the Leak Type from the dropdown list. 

 

2. Select the Leak Category from the dropdown list.  

TIP: You can type in the first letter and use the arrow keys to navigate through the list. 
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3. Type in the custom values for the ratings Light, Medium, and Heavy.  

4. Click the Save button to save the information to the database and list it on the lower pane.  

NOTE: To delete a Leak Category from the list, select it and click Delete. 

5. Repeat steps 2-4 for each set of custom values needed for the selected Leak Type. 

6. Repeat steps 1-5 for each Leak Type. 

I/I values may be updated by double-clicking the item in the list to load the information back into the fields, 
making the changes, and clicking the Save button. Click Yes when the confirmation box opens to save the 

changes in the database.  

Map Layers and Fields 

Define layer names and associated fields within the layer which can be used to assign Submit To, Dispatch 

To, or capture other data according to the location of the request. This information is automatically populated 
when the address is geolocated.  

The map layer must be defined in ArcMap and may have a field containing an employee name used for 

Submit To or Dispatch To fields. The name format must be <Last Name>, <First Name> <MI>.  

NOTE: These layers must exist in the map document. 

1. Type in the Layer Name.  

TIP: SDE users should only enter the feature class name, such as POTHOLE (not the fully qualified name, 
e.g., SDE.POTHOLE). 
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2. Type in the Field Name. 

3. Click the Save button to list and save the information in the database. 

Customer Accounts 

Customer account with its related address and personal data can be set up to populate the request data 

fields associated with a customer call. This information is accessed by typing in part or all of the Last Name, 
Address, or Account Number on the request. 

Edit/Add Customer Account Tab 

The Edit/Add Customer Account tab tracks customer data and can be used to add new customer data as 

well as update existing information. Use a query to open the existing records and update the information. 
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A search may be performed prior to entering a new customer to verify that the customer is not already in the 

database. 

To add a new customer, follow these steps:  

1. Type in the Account number.  

NOTE: Account is a required field. However, the gray AcctSID (Account System ID) field cannot be entered 
or edited as it is system-generated when the information is saved. 

 

2. Select the Account Type from the popup Codes box.  
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3. Check the box for Mr. and/or Ms. 

4. Enter the First Name, middle initial, and Last Name. 

5. Enter the Address, Apt. number, City, State, Zip code, and District (if applicable). 

6. Enter the Email address.  

7. Enter the Home Phone, Work Phone, Cell Phone, Other Phone, and/or Fax. 

8. Enter any Comments about the customer that may be helpful.  

NOTE: Public records may be requested by a number of sources, including the individual customer, so keep 
that in mind when adding Comments. 

9. Click the Save button.  

10. Click Yes when the confirmation box opens to add the new account. 

Customer details may be updated by doing a search and changing or adding the applicable information.  

To edit a customer’s information, follow these steps:  

1. Enter the desired search parameters in any of the fields and click the Search button. The number of 
records matching the query is listed to the right of the Comments field unless there are a large 

number of matching records. Then a message box opens telling how many records there are. Only a 

1000 will load at a time.  

NOTE: A progress bar is found at the bottom of the tab. 
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Wildcard searches are also allowed if only part of the information is known.  

 

2. Double-click on a record in the list to populate the fields, update the fields as needed, and click the 

Save button. 

3. When the confirmation message opens, click Yes to update the account listed. 

Import Customer Accounts Tab 

The Import Customer Accounts tab imports existing customer data from a delimited text file where the 
first row lists the field names and loads the information into the CustomerAcct table in the Cityworks 

database. Using this function allows the organization to use an existing file to load the data, rather than 
having to add each customer in one at a time.  
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IMPORTANT: Any row with a blank ACCTNUM (Account Number) field will not be saved to the Cityworks 
database as this is a Not Null field. ACCTNUM is the only required field. 

Multiple files may be added using the same steps; however, each file must be loaded into the list for viewing 
and then saved to the database using the Save button at the bottom of the form before loading another list. 

Saving the list clears the fields so it’s ready to import another file. Any existing list is cleared when the Load 

button is clicked to import another file so there’s no way to append files together before saving.  

If a file has already been imported, it will add additional records to the Cityworks database for each row 
containing an account number, even if the information is identical to the information already there.  

TIP: Use the Edit/Add Customer Account tab to search for records to see if a file has already been 
imported. 

 

1. Click in the Import File field to open the box for browsing to the file. 

2. Navigate to the desired file and click Open to load the path in the Import File field. 
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3. Select the radio button option for Delimited By. See the description under Importing Data. 

 Comma 

 Tab 

 Other 

4. Click the Load button and wait while the data loads into the fields. A progress bar displays at the 
bottom of the window. 

5. Verify each record contains an ACCTNUM value or the row will not be saved to the Cityworks 

database.  

NOTE: Any row missing an ACCTNUM value is ignored when saving information to the database and that 
customer will not be added. 

6. Optional: Select any record(s) not wanted for importing into the database and click the Remove 

button to remove them from the list.  

NOTE: The Clear button clears all the information from the list. 

7. Optional: Uncheck the box for Delete all records from CustomerAcct table before adding 
these accounts? to keep the data that already exists in the CustomerAcct table. 

IMPORTANT: If the checkbox for Delete all records from CustomerAcct table before adding these 
accounts? is checked, all current information in the Cityworks CustomerAcct table is deleted before adding 
the new information from this list. This process may take some time depending on the number of records 
being deleted and then added. To append the new information to the existing information, this checkbox 
must be unchecked. 

8. Click the Save button to add the information to the CustomerAcct table in the Cityworks database 
and clear the list.  

Import Street Names Tab 

Before using the Import Street Names tool, delete any existing records in the StreetCode table from the 
Cityworks database. This eliminates the possibility of duplicate and extraneous data when records are loaded 

through Designer.  

NOTE: It is not necessary to delete existing records in the table if there is a script which appends only new 
streets to the table. 

The Import Street Names tab imports existing street data from a delimited text file with these fields:  

 StreetName 

 Code 

 City 

 Zone 

 District 

 State  
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To create the list, export the street name list from the GIS database into a delimited text file (comma, tab, or 
other). The StreetName and Code fields must be populated. The other fields allow null values; no place 

holders are needed for them in the file and they can be blank in the list.  

If there are multiple files containing street information, these must be loaded on the form one at a time 

where all the rows can be viewed and then saved to the database using the Save button at the bottom 
before navigating to another file and loading new information.  

IMPORTANT: Attempting to load a new file when information is already loaded but not yet saved, 
overwrites the current information with the new information. 
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1. Double-click in the Import File field to open the box for browsing to the file.  

2. Navigate to the desired file and click Open to load the path in the Import File field.  

3. Select the radio button option for Delimited By: Comma, Tab, or Other.  

4. Click the Load button and wait while the data loads into the fields.  

5. Verify a StreetName and Code are populated for each record or the row will not be saved to the 
Cityworks database. An error message opens to alert the user that either the StreetName or Code 

is required.  

NOTE: Any row missing a StreetName and/or Code is ignored when saving information to the database 
and that customer will not be added. 

6. Optional: Select any record(s) not wanted for importing into the database and click the Remove 

button to remove them from the list.  

NOTE: The Clear button clears all the information from the list. 

7. Click the Save button to add the information to the StreetCode table in the Cityworks database and 
clear the list. 

8. Click the Save button to add the information to the CustomerAcct table in the Cityworks database 

and clear the list.  
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CU Material Groups 

CU Material Groups are used by the Miner & Miner Designer application for in-house assembly of materials 
with various parts. These material groups, referred to as “favorites,” are defined here and the assemblies can 

be stored together or the parts used separately.  

Groups Tab 

The Groups tab sets up the names and descriptions for groups in each asset group. 

 

1. Select the Category from the list on the left pane. 

2. Type the Group Name in the Add/Modify field at the bottom of the right pane, 20 characters 

maximum. 

3. Type in the Description, up to 250 characters. 

4. Click the Save button to add the group to the Existing Groups list on the right pane and to the 
database.  

NOTE: To delete a group, double-click on it in the list to load the fields, click Delete, and click Yes when the 
confirmation box opens. 

5. Repeat steps 2-4 for any additional groups in the selected Asset Group. 

6. Repeat steps 1-5 for groups in other asset groups. 

Materials Tab 

The Materials tab is used to place the materials into the groups. 
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1. Switch to the Materials tab. 

 

2. Select the Category Code from the top left pane to load the associated Group Name pane. 

3. Select the Group Name. 

4. Select the Search by field from the dropdown selection on the top right pane: Keyword, Name, or 

Hierarchy.  

5. Select the material from the list. 

6. Type in the Quantity needed to build the assembly. 

7. If the material is the primary part of the assembly, check the box for Is Primary Material.  

8. Click the Add button to list the material. 

9. Repeat steps 4-7 for each additional material that belongs to the same assembly until each material 
is added. 

10. Repeat steps 1-8 to define each group of materials. 

Macro Manager 

The Macro Manager function copies the macros, in this case the printing instructions, for custom templates 

for email, requests, or work orders when a new version of Cityworks is installed where the macros were 
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changed. New macros are read from the new Cityworks template and applied to the selected custom 

templates so the data loads correctly.  

NOTE: Macros are a list of commands Cityworks uses to perform a series of actions for emailing and printing 
requests or work orders which link the stored data to variable fields. 

1. Load the fields to select the files to copy the macros from (source file) and to (destination file). 

 

 Browse to the desired file(s) in Program Files > Cityworks > Templates and drag to load 

either the source file or destination file.  
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 Double-click in the source file field or click Add Files to open the box for navigating to the file. 

Select the desired file(s) and click Open (or double-click on the desired file) to load the file.  

NOTE: Multiple templates may be selected as destination files by using the Shift or Ctrl key. 

2. Verify that the source and destination files are either request or work order files and remove any 

unwanted file(s) by selecting and clicking the Remove button.  

NOTE: Different macros are used for requests than for work orders. Do not copy macros from a service 
request template to a work order template or vice versa. 

3. Click the Update button to copy the macros to the fields. 

4. Click Yes when the confirmation box opens to update the macros for the selected files. The progress 

displays in the space below the buttons path until the update is complete.  

The Destination File(s) are removed once the macros are updated and the message in the space below the 
buttons and above the Destination File(s) list changes to read Update Complete. 

Record Lock 

The Record Lock function is a convenient way for the Cityworks domain administrators to remove locks on 
service requests and/or work orders. It links directly to the PwRecordLock table in the Cityworks database, 
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listing information about requests and/or work orders that are currently open. Removing the lock allows 

another user to open and edit a record. This function allows locked records to be opened for processing and 
closed.  

NOTE: Be sure not to remove locks from work orders that are currently being accessed by a user to prevent 
changes from being made by another user at the same time. The date/time of the lock is included to see 
which records may have been left open. 

IMPORTANT: Requests and work orders currently checked out using DataPump are listed in the LockedBy 
column as the user name followed by _dp and should not be deleted as the records will not be able to be 
checked back into the production database.  

1. Select the Current Domain from the dropdown selection. 

 

2. Select the service request(s) and/or work order(s) to remove from the table and allow users to 
access them, using <Shift + click> or <Ctrl + click> for multiple selections. 

3. Click the Unlock button to remove the lock.  

NOTE: Unlock does not delete the record; it only removes it from the PwRecordLock table. 

4. Click Yes when the confirmation box opens to unlock the selected record(s) and remove them from 
the list.  

NOTE: The Refresh button can be used to refresh the list without having to log in to Designer again as it 
goes back to the PwRecordLock table to list all the requests and work orders currently being used. 

Other System Codes 

Other System Codes allows the administrator to relate a Code and up to two descriptions from another 

system, like 311, to a Cityworks request template. The mapping may be done by entering the information or 

importing a file. 

The import file may contain up to three fields for the other system codes: its Code, Description 1, and 

Description. The corresponding Cityworks Request Template Code may be added as a fourth field or it 

may be quickly added to the imported information on the window selecting from the dropdown list. A 1:1 
correspondence is required so each Cityworks request template may only be used once. Each Code, 

Description 1, and Description 2 combination must be unique. 
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1. If importing a file, select the radio button for the Delimiter used in the import file. 

 Comma 

 Tab 

 Other—Specify the delimiter in the box that opens when this option is selected. A semi-colon is 

the default.  

2. Use the Load dropdown Load File option to open a browser. 

 

3. Navigate to the file when the Select Other System Code File box opens. 

4. Click on a Code in the list to load the information into the fields at the top or type in the Code along 
with up to two descriptions (Description 1 and Description 2).  

TIP: If the imported information already contains the Cityworks Request Template Code, select the 
desired codes in the File Codes list (or select the ones to remove and use the Remove From List option in 
the Load dropdown to eliminate any codes not needed first) to transfer to the Defined Codes list on the 
right pane and use the Save Code option in the Load dropdown to save the Defined Codes. Skip the 
remaining steps if using this option. 
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5. Select the Cityworks Request Template from the dropdown list for where to link the fields.  

NOTE: A defined code set may also be added to a request template on the Request Template Edit form 
by selecting from the dropdown for Other System Code. 

6. Click the Save button to save the information to the right pane.  

NOTE: Once a Request Template has been saved, it is removed from the dropdown list. All mapped fields 
are listed on the right pane and can be reloaded into the fields if changes occur. 

The Clear button clears all the information on the left pane. The Delete button can be used to delete any 

records selected from the Defined Codes list and opens a confirmation box before deleting the selected 

code(s). 
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Cityworks Data Template 

The Cityworks Data Template is a specialized Excel interface that links directly to the Cityworks database for 

editing multiple values. It is ideal for setting up a new Cityworks database or editing an existing one.  

NOTE: Since request and work order templates require much more setup than can be done on the 
ProblemLeaf or WOTemplate tables, most editing will need to be done in Designer. 

Logging into the Database 

The Cityworks Data Template is found on the ftp://ftp.cityworks.com/ site. Contact Azteca Systems Inc. client 

support staff for login instructions. Only Cityworks domain administrators or superusers can log in to this 

application.   

1. Download a copy of the Cityworks Data Template from the ftp site.  

2. Double-click on the CityworksDataTemplate in the saved location to access the Cityworks Login 

dialog box.  

NOTE: Once the Cityworks Data Template is open, the Cityworks Login screen can be accessed from the 
Load Cityworks Table Menu option found in the context menu which opens by right-clicking in a cell, 
allowing the user to switch tables. 

 

If a Security Warning box opens instead of the login screen, click Enable Macros.  

NOTE: If the Cityworks Login screen doesn’t open, refer to No Login Screen for how to change the Macro 
> Security setting. 

3. Enter the User ID and Password . Domain administrators may access all the tables. A superuser 

can only access the employee table. If a superuser tries to open another table, a Login Error opens. 
Clicking OK returns the superuser to the login screen.  

4. Select the Cityworks Database from the dropdown listing the computer’s available ODBC 

connections.  

ftp://ftp.cityworks.com/


 

250    Cityworks Data Template Designer 2013 Guide 

 

5. Select the desired Table from the dropdown list of predefined Cityworks tables that the template is 
designed to access. 

 ContractorLeaf 

 Employee 

 EquipmentLeaf 

 MaterialLeaf 

 ProblemLeaf 

 TaskLeaf 

 WOTemplate 

NOTE: The columns, field types, number of characters, and other instructions are listed for each template in 
Appendix 2: Cityworks Data Template Fields. 

6. Optional: For more advanced login options, check the Advanced box to enable the additional SQL 
query options for Where and Order By. Type the query in the Where field and the desired 

column(s) for sorting the results in the Order By field. 

7. Click the OK button to log in and load the information from the selected table or data matching the 
advanced SQL query into Excel. 
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8. Enter, review, update, or delete data as discussed in the following sections. 

Menu Options 

There are six menus associated with the Cityworks Data Template. Right-clicking in a cell opens this context 
menu for these four options.  

 Load Cityworks Table   

 Import From Data Sheet 

 Export to Data Sheet 

 Clear Excel Data 

 

The other two options are accessed by first highlighting the information to update or delete and then right-

clicking to open another context menu. 

 Update Cityworks Record(s) 
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 Delete Cityworks Record(s) 

 

Load Cityworks Table 

The Load Cityworks Table menu allows access to the Cityworks Login screen to switch between the 

Cityworks tables.  
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IMPORTANT: Loading a table removes any previous table data from the template. Make sure all changes 
are updated in the database before loading another table. See Update Cityworks Record(s) for more 
information.  

1. Right-click in any cell and select the Load Cityworks Table option from the context menu. 

2. Enter the Password when the Cityworks Login screen opens.  

NOTE: The cursor is set in the Password field on the login screen when the Load Cityworks Table option 
is selected. 

3. Change to the desired Table.  

4.  Click OK to open the new table. 

Import From Data Sheet 

A copy of the template can be made and exported to a data sheet to allow other users to make updates to 

the information without changing the information in the Cityworks database. These data sheets can then be 
imported back into the Cityworks Data Template using the Import From Data Sheet menu option. Any 

changes are displayed in green text so the domain administrator can review the information and commit the 
changes to the database or discard them. See the following section, Export To Data Sheet, for information on 

how to create the data sheet.  

1. Right-click in a cell and select the Import From Data Sheet option from the context menu.  

NOTE: If opening the template, click Cancel on the Cityworks Login screen to avoid having to log in 
twice. 

2. Select the desired radio button option for the data sheet to import from the Select Data File to 

Import list.  

NOTE: Only data sheets located in the same directory as the template are listed. When receiving the data 
sheets back, store them in the Cityworks directory with the Cityworks Data Template file. 
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3. Enter the User ID, Password, and Database to log in into the main Cityworks database when the 

Cityworks Login screen opens. The Table and Advanced checkbox are grayed out as they are 
based on which data sheet was selected. 

 

4. Click OK to load the table data. As the data loads, each cell is checked against the data sheet for 

changes. Cell values changed in the data sheet are displayed in green, unchanged cells remain black, 
and any row in another font color retains that font color. 

NOTE: New records are added after the last entry in the data sheet. 
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5. Review the data and edit current values directly. If records need to be deleted, highlight the 

record(s) in a font color other than blue, red, green, or black.  

6. Select the desired changes to add to the database, holding down the Shift or Ctrl key to make 

multiple selections.  

NOTE: Use <Shift + click> for consecutive selections or <Ctrl + click> for individual selections. 

7. Right-click to open the context menu and select the Update option to update the Cityworks database 

with the selected information.  

8. Review the data and select any items for deletion and use the right-click context menu to select the 

Delete option to delete the selected data from the database. See Delete Cityworks Record(s) for 
more information.  

NOTE: Perform update changes to the database before deletion changes. 

Export To Data Sheet 

The Export To Data Sheet function creates a static copy of the data displayed in Excel for allowing the 
Cityworks domain administrator to permit any user to edit the data without altering the actual Cityworks 

database.  

1. Load the desired table into the template.  

2. Right-click in a cell to open the context menu and select the Export To Data Sheet option.  

3. An Excel file <TableName>.xls is created in the same directory as the template containing the 
current information in the data template.  

NOTE: The table name, SQL query used to extract data from the main database, validations, lists, and codes 
from the template are saved with this data sheet. 
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Once the file is created, a message opens to inform the user, unless a data sheet has already been created. 

Then another message box opens to ask if the user wants to replace the current file. Click Yes to save the 
most recent data template or one with a different SQL query. 

If a SQL query was used to create the data sheet, it is listed at the top of the data sheet. 

 

4. Send the data sheet to the desired user(s) to update the data with instructions to return it after 
making the necessary changes. 

5. When the data sheet is returned, the Cityworks domain administrator imports the data and commits 

the desired changes to the actual tables. See the section Import From Data Sheet for more 
information. 

Clear Worksheet 

The Clear Excel Worksheet clears the Excel spreadsheet of any data preparatory to importing a table. 

Right-click in any cell to open the context menu and select the Clear Worksheet option. 

Update Cityworks Record(s) 

To update records from a data sheet, see the section Import From Data Sheet.  

NOTE: Charts for each of the data templates can be found in Appendix 2: Cityworks Data Template Fields. 

1. To add, update, or delete Cityworks data, enter data into the desired cell. An input message box 

displays information to aid data entry. NULL means that the field may be left blank; NOT NULL 
fields must have a response entered.  

NOTE: Data validation occurs for each cell as data is entered. 

 Text—Provides requirements for entering varchar (varying-character or alpha-numeric) text with 

the maximum number of characters listed in parenthesis. 

 

NOTE: If a number is inserted into a varchar field, a triangle is inserted into the corner of the field by Excel, 
indicating that Excel wants to format the field as a numeric field. The data loads correctly into the Cityworks 
database. 
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 Numeric fields—The first number in parenthesis lists the possible number of places to the left of 

the decimal point and the second number lists the number of decimal places.  

 

 Select from list— Select from the list of valid values.  

 

If the selection lists numeric codes which are not recognized, scroll ten columns past the last column of the 
main body of the spreadsheet to view the user-defined lists with their associated values.  

 

IMPORTANT: Do not change this information as it is listed for the user’s information only. These fields are 
defined in Designer. 

 For dropdowns with just a few options, the options are listed in the box.  

   

 Date Time—Use a standard date notation. 

 KEYWORDS—Enter desired keywords, separated by a comma and a space.  



 

258    Cityworks Data Template Designer 2013 Guide 

 

 Must use Designer—This field must be populated using Cityworks Designer.  

 No longer used by Cityworks—These fields may contain information from older versions of 

Cityworks that have changed in more recent versions of Cityworks. 

 

 Required for new entries—Must populate this field. 

 Do not alter/add values—Unique ID and SID fields cannot be edited as they are consecutive, 

system-generated, numbers and are automatically populated with the appropriate values when 

the new information is added.  

NOTE: MaterialUID and EquipmentUID must be assigned unique IDs; for example, use a different ID for 
each battery size. 

 

2. Select the entire row(s) of desired data to add to the Cityworks database. 
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3. Right-click the mouse in the highlighted region to open this context menu. 

4. Select the option Update Cityworks Record(s). The template cycles through each cell in each 
selected row, updating existing data and inserting new data. New cell values committed to the 

database without any errors are displayed in blue. Cell values with errors are shown in red. Unaltered 

values are black.  

 

Delete Cityworks Record(s) 

Deleting a record removes the items from the specific table as well as all related data in related tables. 

However, it does not delete existing work order or service request data. See Associated Table Deletions for all 
related table deletion information. 
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5. Select the entire row(s) of data to delete.  

6. Right-click in the highlighted region to open this context menu. 

7. Select the option Delete Cityworks Record(s) to open the confirmation box.  

8. Click Yes to confirm the data deletion and delete the selected rows. 

Associated Table Deletions 

The associated tables where data is deleted when deleting records from the various templates include the 

following. 

WOTemplate 

 WOTempAttachment 

 WOTempComment 

 WOTempGroupRight 

 WOTempInstruction 

 WOTempTask  

Employee 

 CwCustField  

 EmployeeAttachment 

 EmployeeSkill 

 EmpModule 
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 GroupUser 

 RelEmpToField 

 StoreGroupUser 

ProblemLeaf 

 ProblemAttachment 

 ProblemComment 

 ProblemGroupRight 

 ProblemKeyword 

 ProblemMapLayer 

 ProblemNode 

 ProblemQuestion 

ContractorLeaf 

 ContractorNode 

 CwCustField 

EquipmentLeaf 

 EquipmentNode 

 CwCustField 

MaterialLeaf 

 MaterialNode 

 CwCustField 

TaskLeaf 

 TaskNode 

 CwCustField 

Inserting New Data 

New data may be entered using the template or using a data sheet. See Import From Data Sheet for 
information on that option. 

1. Scroll to the first empty row at the bottom of the table.  
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2. Skip the cell in the first column (SID value) since new records added to the database are 

automatically assigned the appropriate SID value.  

IMPORTANT: Do not populate the SID (system ID) value for new entries or alter it for any existing records. 

3. Enter the new information in the row, completing all required data fields for the new record(s). 

4. Select all new records and right-click in the highlighted area to open the context menu.  

 

5. Select the Update Cityworks Record(s) option near the bottom to commit the new record(s) to 

the database.  

New cell values displayed in blue have been committed to the database. Cell values with errors are red. 
Unaltered values are black.  

 

IMPORTANT: When copying data from another worksheet, use the Excel Paste Special command from the 
Excel Edit menu to paste only the cell values. If Paste Special is not used, all validation checks on the 
destination cells are removed. 
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Cityworks Custom Data Fields 

The template works with Custom Data Fields (not the same as Custom Categories) defined in Designer. 
When custom fields are detected for the desired table, the fields are loaded in the spreadsheet at the end of 

the standard table fields, right before the Keywords column if Keywords is part of the selected template.  

Custom fields must first be defined in Designer in order for them to appear in the template. If the custom 
fields use codes, those codes are loaded into the template as a selection list. 

 

If new records have required fields with a default value, this value is entered automatically. Required fields 
with no default value have a temporary value assigned in the field, such as Value Required. The 

administrator should add the information.  
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Troubleshooting 

The most common errors when accessing the Cityworks Data Template are having no login screen open, a 
missing or incorrect list selection, and a password prompt when closing. Please call Azteca Systems Inc. 

Customer Support if additional help is needed. 

No Login Screen 

 If no login screen appears after opening the CityworksDataTemplate.xls file, check the Macro Security 
setting. Macro security set to Very High or High disables the macros.  

NOTE: A dialog box may open after logging in where the user may select Enable Macros to open the 
Cityworks Data Template (if the setting is set to Medium). See the image at the end of this section. 

1. Using the Tools menu in Excel, select Macro > Security.  

 

2. Set the Security Level to Medium or Low. 
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NOTE: The LOW setting allows macros to always run. 

Setting the security to MEDIUM prompts the user to enable or disable the macros each time the file is 
opened.  

 

Missing or Incorrect List Selection  

Selection list values are loaded into the spreadsheet from the database into columns not used by the 

template. They can be viewed by scrolling to the top record, then scrolling ten columns past the last 
Cityworks field. These values must not be altered, deleted, or overwritten. 
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Pasting data without using the Paste Special command may override these cell values. The only way to 

repopulate these lists is to reload the table. 

Password Prompt When Closing 

 A bug in Google Desktop search is responsible for a password prompt appearing when closing the template. 
This happens because Google desktop tries to index the macros but can’t because the macros are password-

protected.  

 

The fix requires changing a registry key value from 2 to 3 (2 is the default value). 

1. Open the registry editor and search for this key: 

HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\Office.Desktop.Google.

com\ 

2. Change LoadBehavior value from 2 to 3. 

3. Close the registry editor. 

4. Cancel the CityworksDataTemplate Password message. 

5. Exit out of the Cityworks Data Template. 
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Cityworks Customization 

Cityworks can be customized to an organization by modifying the text, labels, and colors of fields in Cityworks 

and creating or modifying print templates. 

Cityworks Customize Form 

 The Cityworks domain administrator may choose to customize the Cityworks service request and work order 

forms. These modifications are effective for all users in the domain. The ability to customize the layout of 
these forms allows the organization to designate mandatory fields for their users to fill in through color-

coding and change text captions to reflect the organization’s nomenclature to facilitate data entry or for non-
English users to view the text in their own language. However, changing the layout of the form does not 

affect the backend of the Cityworks database which retains the original names. 

Customization may include changing the text on buttons or field labels; hiding a field; italicizing, bolding, or 
underlining; adding a border; and modifying the text color or background color. A Preview box shows a 

sample of the selections so they can be viewed before applying them.  

However, not all options are available for all items. For example, the only thing that can be changed on a 
Tab, Toolbar, or Toolbar Menu is the Caption; therefore, the Preview box and color dropdowns are 

black with the checkboxes grayed out, leaving only the Caption field active. Hide is also grayed out for 

some functions for items which cannot be hidden. 

 

Service Request Customize Layout 

1. Log in to Cityworks Desktop or Standalone.  

2. Open the service request form and select Customize Layout from the Tools dropdown menu to 
open the Customize box. 
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3. Select the radio button which is best suited to the task. 

 View By Layout—Use for changing the field labels, colors, or backgrounds by pane. 

 View By Control—Use to change the layout of all buttons, checkboxes, data entry areas, labels, 

lists, options, tabs, toolbars, and toolbar menus.  

NOTE: View By Control lists the pane where the item is found in parenthesis following the name. 

 

4. Double-click on the icon in the list to display the contents inside, clicking on the plus sign if needed to 

display the individual items.  
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TIP: The items are displayed in alphabetical order. 

   

5. Select the item(s) to change, using Ctrl or Shift for multiple selections.  
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6. Check the desired checkboxes.  

 Hide—Use to hide the field, leaving an empty space matching the background color instead of 

the item.  
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 Bold—Use to draw attention to an item.  

TIP: When bolding text, verify there is enough space to read the text on the form. If there is not enough 
room, not all of the text will be visible. 

 

 Italic—Use to italicize the text.  

TIP: Italics require more space than regular text so verify the selected fields are still visible once the change 
is made.  

 

 Underline—Adds a line under the text in the same color as the text.  

 

 Border—Adds a black box around a button, data field, or label.  

NOTE: Border does not apply to checkboxes.  

 

7. Optional: Change the Caption by typing the new text in the box.  

NOTE: Field captions must be changed one at a time. 

TIP: A caption may be changed to incorporate the terms used by the organization and with which the 
employees would be more familiar with, e.g., changing Shop to Service Area.  

8. Click the Save button to change the layout. 

Click the Default button with the item(s) selected to restore the default settings or check the box for Reset 

all controls to default to restore all default settings.  

IMPORTANT: To add a hidden item back on to the form, select it and uncheck the Hide box. Click Save 
and exit out of the service request form. This will automatically close the Customize form. Open the request 
window to refresh the form which adds any hidden items that have been unchecked. 

Work Order Layout Manager 

Work orders are customized in the same manner as service requests. Open any work order template using 
Standalone or ArcMap and select Layout Manager from the Tools dropdown menu to open the Customize 

form and follow steps 3-8 under Service Request Customize Layout. In addition to having a Layout 
Manager for work orders, there is a separate Layout Manager option on the Work Order Search window 

(see Work Order Search Layout Manager) and a Form Layout button on each Cityworks inspection form that 
opens a Customize window for each inspection.  
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Work Order Search Layout Manager 

A separate Layout Manager is available for the Work Order Search window and is accessed in the 

Search dropdown menu. This Customize form works the same as the others.  
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Customizing Print or Email Templates for Desktop 

Print or email templates may be customized by the organization to contain the information needed in the 
format desired for requests, work orders, inspections, and emails. Different print templates may be created 

for each request or work order type or the default template may be modified and used for all requests or 
work orders. Enter the print template name in Designer. For requests, use Cityworks Setup > Request 

Templates > General Info tab > Word Template field. For work orders, go to Cityworks Setup > 

Work Order Templates > Printing tab > Microsoft Word Template field.  

NOTE: Custom inspections can also be created but must be saved with the default template name since 
there is no field for pointing to a custom template. 

Email templates can be created for customers and internal emails which can be sent automatically when 

requests or work orders are created, closed, etc. Specify custom email templates under Others > 
Preferences > Email Settings tab.  

All Cityworks print templates must be located in the Templates folder. If customized templates are used, 

also store a copy in another location to facilitate updating Cityworks software so they can be retrieved and 
updated using the Macro Manager function. The macros are a set of instructions that are carried out before 

printing to populate the designated field values. Azteca Systems Inc. recommends not editing macros.  

TIP: When upgrading Cityworks, Cityworks must first be removed and then reinstalled. Therefore, all custom 
print or email templates are lost unless they have also been stored in another location. Beginning with 
Cityworks 4.5 sp 4, print templates are not automatically installed with the setup. 

The files called SRAllfields and PWAllfields contain a list of all the Cityworks fields that can be used on a 
service request or work order template. Similar Allfields files also exist for each inspection type. Field names 

are listed in square brackets and are replaced with the field values before printing.  
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When the Print button is clicked, the values are written to a key in the registry. The key is created the first 

time it prints. The last loaded values remain on the key. The macro is used to retrieve the field values and 

place them in the designated location on the form.  

1. Right-click on the desired default template found in the Cityworks directory > Templates folder 

and select Properties.  

TIP: It may be easier to begin with the corresponding AllFields.dot file and delete any fields that are not 
needed. 

 

 Work orders—PW.dot file.  

 Service requests—SR.dot file. 
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 Inspections—the remaining .dot files as shown in the table.  

 

 Emails—SRCALLER.doc, SRINTERNAL.doc, WOCALLER.doc, or WOINTERNAL.doc file. 

2. Uncheck Read-only under Attributes and click OK.  
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3. Right-click on the template and click Open or open from Microsoft Word by browsing to the location.  

NOTE: If the file is opened by double-clicking on it, it will be a read-only file which may not contain the 
attached macro. 



 

278    Cityworks Customization Designer 2013 Guide 

 

4. Move current fields to the desired locations and delete any information that is not needed. 

5. Type in information labels with database fields in the desired location. Any Cityworks field found in 

the accompanying AllFields.dot file, such as PWAllFields.dot for work orders or SRAllFields.dot 
for requests, in the Templates directory of Cityworks may be added to a template.  

NOTE: Fields that have associated information coming from the Cityworks database may not be added to 
headers or footers. 

TIP: Be sure to leave enough room for the data as it will wrap to the next line if it is too long. 

Add information in tables when the information may require multiple rows to keep it lined up correctly. Long 
field values wrap to the next line and expand the columns downward to accommodate the additional 

information. If there are multiple field values, such as entities or callers, place the information in a table with 

the first row listing the desired column names and the second row the Cityworks field name to provide a 
separate line for each value when loading the information. When adding multiple asset types to a single work 

order template, each asset type must be in a separate table with a header row and the tables must be placed 
at the bottom of the print template. Other Cityworks fields do not need to be in tables.  
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Geodatabase fields may be added to a work order template but must be added in a separate table with the 

label on the first row and key word [FEATURENAMEFIELDNAME] on the second row, such as 
[SGRAVITYMAINFACILITYID]. They must also be set to Printable in Designer under GIS Setup > 

Asset Form Configuration for the values to load into the fields.  

   

6. Save and close the new template if replacing the default template or save with a code name of 8 
characters or less as a .dot file for requests and work orders (or as a .doc file for emails) in the 

same file directory. The default location is Program Files > Cityworks > Templates.  

 

NOTE: Inspection templates must retain the default name. 

TIP: When replacing a default template, save the original in another location or with another name. After 
verifying that the data loads correctly, this template can be deleted. 

7. Right-click on the file in the Templates directory, select Properties, and check the Read-only box 

so the template cannot be changed by a user viewing a print preview. See image with step 2. 

8. For defining custom email or work order templates: Go to Others > Codes, select the Current 
Domain and Others as the Asset Group, and either the Email Word Templates or Work Order 

Print Template and populate the Code and Description for each custom template. 
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9. Open to the applicable location and add the template name. 

 Requests—Type the template name in the Value column under Request Templates > 
General Info tab > Word Template field (multiple requests may be done at the same time) or 

Request Template Edit window for the desired request > General tab > Word Template 

field.  

 Work Orders—Open the desired Work Order Templates for the desired asset (multiple work 

order templates may be selected for the asset) and switch to the Printing tab. In the Template 

Settings box, double-click in the Microsoft Word Template field and select the template from 
the Codes box. 

 Emails—Select from the Codes box by double-clicking in the Custom Email Template field 

under Others > Preferences > Email Settings tab > Service Request Emailing or Work 

Order Emailing box > Internal or Caller.  

10. Verify that the information is loading correctly and that the layout is acceptable by opening a request, 

work order, or inspection that uses the newly created template and clicking Print Preview, Print, or 
Email.  

If the form loads without inserting the specific field information, go to Designer under Others > Macro 

Manager, select the existing Cityworks template as the source file from which to apply the macros and 
the template(s) to copy them to as the destination files and click the Update button to apply the macros.  
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11. Make a backup copy of all custom templates in another location so they can be copied back into the 

Templates folder when uninstalling and reinstalling Cityworks. 

Updating Cityworks Print Templates 

Beginning with Cityworks 4.5 sp 4, the setup comes with a separate folder of print templates so it will no 
longer automatically install new print templates and overwrite custom templates which have the same name. 

Two methods are available for Cityworks domain administrators to handle updating print templates.  

 Manually copy the updated print templates to the user’s Templates folder. 

 Update using a network location.  

Manually Adding Custom Print Templates 

 Follow these steps each time a new Cityworks service pack contains a separate folder for print templates. 

1. Move custom print templates with the default file name to another location before running the install.  

NOTE: Custom print templates which have been renamed may be left in the Templates folder and updated 
from there. 

2. Install the service pack. 

3. Copy the Templates folder contained in the service pack to the Cityworks folder. 

4. Update the macros on the custom templates using Cityworks Designer > Others > Macro 
Manager. 
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5. Copy the updated custom print templates back into the Cityworks Templates folder.  

Using the Network Updating Function 

Using the network updating function allows the print templates to be stored in a centralized location which 
can be accessed by each user. The Cityworks domain administrator is responsible for following these steps 

each time a new service pack is installed which contains changes to the print templates.  

1. Copy the Templates folder from the service pack.  

 

2. Place it in the desired network location. 

3. Log in to Cityworks Designer > Others > Preferences > General tab and scroll down to the 
Print Templates - network location option. 
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4. Double-click in the field (or press the spacebar) to open the Browse for Folder navigation box. 

 

5. Browse to the network location and click OK to load the file path (or double-click). 

6. Check the box for ‘Update Print Templates - last update.’ to current date/time (next to the 
Save button) and click the Save button to populate the current date into the Print Templates - 
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last update field. The software uses this date to compare the dates of the templates, adding a date 

to the older file name.  

IMPORTANT: This checkbox must be checked each time a new service pack containing new templates is 
installed to refresh the date. 

7. Update the macros on all custom templates using Cityworks Designer > Others > Macro 

Manager. Skip to step 9 if using only the Cityworks default print templates.  

 

8. Place the custom templates in the network Templates folder.  

9. Start up ArcMap or Standalone. The first time Cityworks is accessed by each user after the update, 

the software searches the network folder for newer versions of the print templates. If it finds any, it 
copies the template(s) into the user’s Cityworks Templates folder, automatically updating it to 

match the Templates folder in the network location.  

Renaming and Linking Custom Print Templates 

 A default template can be customized, renamed, and stored in the Cityworks Templates folder with a new 
name to avoid the problem of figuring out which template is the custom one. Cityworks Designer allows 

adding a custom print template to multiple requests or work orders at the same time so it’s quick and easy to 
link the custom templates to the desired requests or work orders. 

1. Create the custom print templates. 

2. In Designer under Others > Codes on the Add/Modify tab, populate the code type for 

REQPRINT/Request Print Templates and WOPRINT/Work Order Print Templates with the 
custom names. 
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3. On the Request Templates/General Info tab under Cityworks Setup, select the request 
templates from the Existing Templates list on the right pane and select the Word Template from 

the dropdown list.  

TIP: Sorting the list by Category (or another applicable column header) before selecting the templates may 
make it easier to find the desired templates. 
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4. Under Work Order Templates, select the work order templates for each asset from the General 
tab, switch to the Printing tab, click in the Microsoft Word Template field to open the selection 

box, double-click on the desired template, and save. 
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5. Update the macros on all customized templates using Cityworks Designer > Others > Macro 

Manager. 

Customizing Server Print Templates 

NOTE: The print templates in Server no longer have macros. Macro Manager is only used or needed on 
Desktop print templates. 

Server AMS print templates are located in the PrintDocx folder at 
<install_drive>/inetpub/wwroot/<site_alias>/WebSite/PrintDocx. The files called InspAllfields.docx, 

SRAllfields.docx, and PWAllfields.docx contain a list of all the Cityworks fields that can be used on an 
inspection, service request, or work order print template. The inspection, request, and work order default 

print templates are titled Insp.docx, PW.docx, and SR.docx. 

1. Copy the InspAllfields.docx, SRAllfields.docx, or PWAllfields.docx template to a new location so you 
are not editing the original.  

2. Edit the copied template to delete any fields that are not needed.  

3. Replace the appropriate default templates (Insp.docx, PW.docx, and SR.docx) with the edited copy. 

4. Make a backup copy of all custom templates in another location so they can be copied back into the 

PrintDocx folder when uninstalling and reinstalling Cityworks. 
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Map Images Print Template Configuration 

 

Beginning with Cityworks Server 2011 B2 sp1, Cityworks Server users can generate map images for printing. 

When a work order, request, or inspection is created, a map using the X,Y coordinates is stored at 
<install_drive>/inetpub/wwroot/<site_alias>/WebSite/WorkManagement/Printing/Media with the work order, 

request, or inspection unique Id number.  

To generate map images, ensure the Map Placeholder Image field (on the last page) is copied to the 
default print template from the InspAllfields.docx, SRAllfields.docx, or PWAllfields.docx print template.  

NOTE: To print asset printable fields, ensure the !AssetPrintFields! field is copied to the default print 
template. 

Designer Configuration 

To configure Designer to print map images, go to Others > Preferences. Scroll to the bottom of the list of 

preferences on the General tab. 
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 Server Cityworks well known id (spatial reference)—Enter the well-known ID (spatial 

reference) for your map service. To find the well-known ID, open ArcGIS Services Directory, click 
on the map server being used, and scroll to the spatial reference. 
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 Server map image output pixel size—Double-click in the value field and select from small, 

medium, or large pixel sizes. 

o Small = 240 x 320 pixels 

o Medium = 480 x 640 pixels 

o Large = 720 x 960 pixels 

 Server map image x buffer distance—Enter the number of units from a center point on the 

X-axis. This determines how much of the map is included in the picture.  

 Server map image y buffer distance—Enter the number of units from a center point on the 

Y-axis. This determines how much of the map is included in the picture.  

The X and Y buffer values define the size of the image bounding box by subtracting and adding the buffer 

distances, in map units, to the X,Y coordinate stored within the Cityworks record (Request, Inspection or 
Work Order). Save all changes and exit Designer. 
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Appendix 1: Cityworks Codes 

The required Code Types for each Asset Group can be found on www.mycityworks.com to assist the 

Cityworks domain administrators in knowing which Codes to populate. Predefined asset groups include:  

 Electric (E) 

 Park (P) 

 Sewer (S) 

 Storm (D)  

 Street (R) 

 Traffic (T) 

 Water (W) 

 Others (A)—Add custom codes here. 

The default values are listed in this appendix for the Others code tables as this group of codes applies to all 

Cityworks users. Following those tables are the codes used in predefined Cityworks inspections and tests. 

Others Codes and Descriptions 

If using the Cityworks Storeroom add-on, populate the ACCOUNT code type with the desired values 

(numbers, work descriptions, departments, etc.) so when the user clicks in the Account or Account # fields 

for Issue and Receive, the options will be available to them.  

Code Type Description Code Description Location 

ACALLTYP Caller Type   Service Request/Caller pane/Type field 

ACCOUNT Storeroom 
Accounts 

  

Storeroom/Issue/Details tab/Account field  

Storeroom/Issue/Search tab/Account field 

Storeroom/Receive/Details tab/Account# 
field 

Storeroom/Receive/Search tab/Account# 
field 

ACITYCOD Code for City 
Name 

  
Cityworks Server AMS 

ACODEMAP Code Mapping 

 

CLOSED Closed IMPORTANT: These codes are not found 
as selection lists or boxes in Cityworks. They 
update Status on SR, WO, and Tasks. Do 

not delete these default codes. Descriptions 
may be modified. 

COMPLETE Complete 

CURRENT Current 

PENDING Pending 

ACREWCAT Employee Crew 
Category 

  
Cityworks Server AMS 

ACTGCODE ActPerf Mgt Unit 
Description 

  
Designer/Work Order Templates/Budget 
Plan tab/ Unit Description field 

ACTPAVDP ActPerf Avg 
Daily Production 

  
Designer/Work Order Templates/Budget 
Plan tab/ Avg Daily Production field 
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Code Type Description Code Description Location 

ACTPCODE ActPerf Code 
  

Designer/Work Order Templates/Budget 
Plan tab/ Activity Code field 

ACTPELEV ActPerf Effort 
Level 

  
Designer/Work Order Templates/Budget 
Plan tab/ Effort Level field 

ACTPINVT ActPerf 
Inventory 
Description 

  
Designer/Work Order Templates/Budget 
Plan tab/ Inventory field 

ACTPMGTU ActPerf Mgt Unit 

  

Designer/Work Order Templates/Budget 
Plan tab/ 

Management Unit field 

ACTPPRGC ActPerf Program 
Code 

  
Designer/Work Order Templates/Budget 
Plan tab/ Activity Program field 

ACTPWKQD ActPer Work Qty 
Description 

  
Designer/Work Order Templates/Budget 
Plan tab/ Work Qty field 

ACUCAT CU Category 
  

Designer/Materials/Material Edit 
form/General tab/CU Category field 

ADISTRCT District   Cityworks Server AMS 

AEMPSKIL Employee Skill 
Sets 

  
Designer/Employees/Skills tab/Defined Skills 
frame 

AMATACT Material Work 
Activity 

  
Designer/Materials/Material Edit/Labor & 
Equipment tabs/Activity field 

AORGCODE Organization 
Codes 

  
Designer/Employees/Employees tab/General 
Information box/Organization field 

APRIORIT Priority 
1 High 

Service Request/Management pane/Priority 
field  

2 Medium High 
Service Request/Search/Status tab/Priority 
field  

3 Medium Work Order/General tab/Priority field 

4 Medium Low 
Work Order/Attachments tab/Service 
Requests/ Priority column 

5 Low 
Search Work Orders For/General tab/Priority 
field 

APROBCAT Request Problem 
Category 

  
Service Request/Management 
pane/Category field  

  
Service Request/Search/Status tab/Category 
field  

APSOURCE Permit Source 
  

Work Order/Define a Permit form/Source 
field 

ATSKSTAT Task Status COMPLETE COMPLETE Work Order/Tasks pane/Status field 

CURRENT CURRENT Search Work Orders For/Tasks tab/Status 
field 

PENDING PENDING 

AUDITINT Material Audit 
Interval 

ANN ANNUAL Designer/Materials/Material Edit 
form/General tab/ Audit Interval field 

M Monthly 

Q Quarterly Storeroom/Materials/Details & Search 
tabs/Audit Interval field 

UNK Unknown/Not 
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Code Type Description Code Description Location 

Specified  

W Weekly 

AWOCAT Work Order 
Level 

  
Work Order /Work Order form (create new)/ 

    Category field 

  
  

Search Work Orders For/Facilities/Activities 
tab/ 

    Category field 

CONSTAT Contract Status   Cityworks Server AMS 

CONTFUND Contract Fund 
Source 

  
Cityworks Server AMS 

CONTTYPE Contract Type   Cityworks Server AMS 

EMAILTMP Email Word 
Templates   

Designer/Preferences/Email Settings 
tab/Custom 

Email Template fields 

GLACCOUNT General Ledger 
or Financial  

  
Service Request/Labor pane/Account field 

 Account 
Numbers 

  
Work Order/Details tab/Account field 

  
  

Work Order/Labor pane/Employee radio 
button option/Account field 

GLACCOUNT General Ledger 
or Financial 
Account 
Numbers 
(continued) 

  

Work Order/Labor pane/Contractor radio 
button option/Account field 

    Work Order/Material pane/Account field 

  
  

Work Order/Material pane/Contractor 
Material Cost box/Account field 

    Work Order/Equipment pane/Account field 

  
  

Work Order/Equipment pane/Contractor 
Equipment box/Account field 

    Work Order Search/Details tab/Account field 

  
  

Designer/Work Order Templates/General 
tab/Account field 

INSPPRINT Inspection Print 
Templates 

  
Designer/Custom Inspection 
Templates/Print Template field 

INSPRESO Inspection 
Resolution 

  
Cityworks Server AMS 

INSPSTAT Inspection 
Status 

CANCEL Cancel 
Cityworks Server AMS 

  CLOSED Closed  

PADDTYPE Address Type   Cityworks Server AMS 

PMTSTAT Work Permit 
Status 

ACT Active Work Order/Define a Permit form/Status 
field 

CLOSED Closed Permit 
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Code Type Description Code Description Location 

UNK 
Unknown/Not 
Specified 

V Valid 

PMTTYPE Work Permit 
Type 

  
Cityworks Server AMS 

PRJTSTAT Project Status C Completed Service Request/Project form/Project 
tab/Status field 

IP In Progress 

NS Not Started 

UNK 
Unknown/Not 
Specified 

REQPRINT Request Print 
Templates 

  
Designer /Request Templates/General Info  

    tab/Word Template field 

  
  

Designer /Request Templates/Request 
Template  

    Edit form/General tab/Word Template field 

SHOP Maintenance 
Shop or 
Department 

  

SR/GIS Information pane/Shop field  

Service Request/Search/Status tab/Shop 
field 

Work Order/Details tab/Shop field 

Search Work Orders For/Details tab/Shop 
field 

SRRESO Request 
Resolution 

  
Cityworks Server AMS 

SRSTATUS Service Request 
Status 

CANCEL Cancel 
Service Request/Management pane/Status 
field 

  
CLOSED Closed 

Service Request/Search/Status tab/Status 
field 

STORERM Storeroom Name   Work Order/Material pane/Storeroom list  

  
  

Designer/Materials/Material Edit 
form/General tab/  

    Storeroom field    

    Storeroom/Issue/Details tab/Storeroom field 

    Storeroom/Issue/Search Results tab/Source  

    (Storeroom) field 

  
  

Storeroom/Receive/Details tab/Storeroom 
field 

  
  

Storeroom/Receive/Search tab/Destination 
field 

  
  

Storeroom/Materials/Details tab/Storeroom 
field 

  
  

Storeroom/Materials/Search tab/ Storeroom 
field 

    Storeroom/Transfer/Search tab/Source &  
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Code Type Description Code Description Location 

Destination fields 

    Storeroom/Audit/Search tab/Storeroom field  

UACCDESC Units 
Accomplished 
Description 

  
Work Order/General tab/right of Units 
Accomplished field 

  
  

Designer/Work Order Templates/General 
tab/Unit Accomplished Description field 

UNITMEAS Material Quantity 
Unit of Measure 

EA EACH 
Work Order/Material pane/Unit of Measure 
column 

M Metric 
Designer/Materials/Material Edit 
form/General tab/Unit of Measure 

UNK 
Unknown/Not 
Specified 

Storeroom/Materials/Details tab/Unit of 
Measure field 

WOPRINT Work Order Print 
Template 

  
Designer/WO Templates/Printing 
tab/Microsoft Word Template field 

WORESO Work Order 
Resolution 

  
Cityworks Server AMS 

WOSTATUS Work Order 
Status 

CANCEL Cancel 
Work Order/General tab/Status field 

  
CLOSED Closed 

Search Work Orders For/General tab/Status 
field 

 

Code Types Needed for Cityworks Inspections & Tests 

Populate all codes in Designer under Others > Codes by selecting the corresponding Asset Group and 
Code Format. Codes that begin with the letter D are populated under the Storm, E under Electric, P 

under Park, R under Street, S under Sewer*, and W under Water.  

NOTE: The TV Inspection and Tree Inspection are the only ones which use the Code Format of Codes, 
Descriptions, and Scores. The Code Type of STVOBSRV is used for the TV Inspection unless the 
organization is utilizing PACP codes. (Be sure to change the Use CCTV Codes option under Preferences to 
Y.) PTREEOBSRV is on the Tree Inspection. 

*These Sewer codes can also be populated under Storm. 

Asset 
Group  

Inspection or Test Form 
Codes and Descriptions Descriptions and Scores 

Code Type Field Code Type Field 

ALL Custom Inspection (Inspection) No defaults  No defaults  

 General Test SGENTYPE  Test Type None  

  SGENUNIT  
Unit of 
Measure 

  

Storm or  Dye Test SDIAM  Diameter SGRNDCND*  
Ground 
Conditions  

Sewer  SSURFC  Surface SLEAKCAT * Leak 
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Asset 
Group  

Inspection or Test Form 
Codes and Descriptions Descriptions and Scores 

Code Type Field Code Type Field 

Category/Le
ak Type 

  STVOBPOS* Position SLEAKSRF * 
Surface 
Cover 

    SLEAKTYP * 
Leak 
Category/Le
ak Type 

    SPRECIP * 
Precipitation 
Type 

    SUTSC * 
Unable to 
Complete 
Due to 

 Inlet Inspection DCBNMT Basin SBSNCND  
Basin 
Condition 

  DFRAMEMT Frame SFLOW * Flow Type 

  DGRATE Grate Type SFRMCND * 
Frame 
Condition 

  DINLFEAT Sub Type SINLTCND  
Inlet 
Condition 

  DLIDMT Lid  SLIDCND * 
Lid 
Condition 

  DSTATUS Status SPRECIP * 
Precipitation 
Type 

 Manhole Inspection SACCESS  Access SFLOW *  Flow Type 

  SBNCHMT  Bench SGRNDCND *  
Ground 
Conditions 

  SBRLMT  Barrel SMHCOND  Condition 

  SCHANLMT  Channel SMHLKCAT  
Leak 
Category 

  SCONEMT  Cone SMHLKTYP  Leak Type 

  SDIAM  Diameter SPIPECND * Condition 

  SFRAMEMT  Frame SPONDCND * Ponding 

  SLIDMT  Lid SPRECIP * 
Precipitation 
Type 

Storm or  Manhole Inspection (continued) SMHPART  
Structural 
Parts 

(dropdown) 

SSPOT * Spot 

Sewer  SMHTYPE  Sub Type   

(continued
) 

 SPIPEDIR *  Direction   

  SPIPEMT  Material   

  SRING  Ring   

  SSTEPMT  Steps   

  SSURFC  Surface   
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Asset 
Group  

Inspection or Test Form 
Codes and Descriptions Descriptions and Scores 

Code Type Field Code Type Field 

  STSTMTHD  Test Method   

  STVOBPOS * Position   

 Smoke Test SDIAM  Diameter SGRNDCND * 
Ground 
Conditions  

  SMBOMBTY  
Type Smoke 
Bombs Used 

SLEAKCAT * 
Leak 
Category 

  SSURFC  Surface SLEAKSRF * 
Surface 
Cover 

  STVOBPOS * Position SLEAKTYP * Leak Type 

    SPRECIP * 
Precipitation 
Type 

    SUTSC * 
Unable to 
Complete 
Due to 

 TV Inspection SDAREA  
Drainage 
Basin 

SDETERIO  
Deterioratio
n 

  SDIAM  Diameter SGRNDCND *  
Ground 
Conditions 

  SJOINT  Joint Type SPRECIP * 
Precipitation 
Type 

  SLMETHOD  
Lining 
Method 

SSPOT * Spot 

  SPIPEMT  Material   

  SRSTAT * 
Rehab 
Status 

  

  SSURFC  Surface   

  STVOBPOS * 
Clock 
At/From  

  

  STVREASN * 
Reason for 
Inspection 

  

  SVTRFMAT  VTR Format   

Electric Battery Inspection None  None  

 Substation Relay Inspection  ESWITCH Sub Type None  

 (Induction Overcurrent Relays) ESWMODEL Model   

  EWSMANUF 
Manufacture
r 

  

 Meter Changeout None  None  

 Overhead Facility Inspection EPOLCLSS Class None  

Electric  Overhead Facility Inspection EPOLHGT Pole Height   

(continued
) 

(continued) ETRNMAK 
Manufacture
r 

  

 Substation Inspection ESSITYPE 
Inspection 
Cycle 

None  
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Asset 
Group  

Inspection or Test Form 
Codes and Descriptions Descriptions and Scores 

Code Type Field Code Type Field 

 Automatic Reclose Operations 
(Substation Reclose Operations) 

ERCCAUSE Cause None 
 

 

 Underground Facility Inspection ETRNMAK 
Manufacture
r 

None  

Park Tree Inspection None  None  

Street 
Estimate - Crack Sealing  

(Crack Seal Estimate) 

None  RSEALMAT Sealant 
Material & 
Crack Size 
Factor 

 Pavement Inspection  RSIZUNIT 
Sample Unit 
(dropdown) 

  

 (Road Inspection) RSMPTYPE 
Sample 
Type 
(dropdown) 

  

  RSRFMTRL 
Surface 
Type 
(dropdown) 

  

Water Hydrant Flow Test None  None  

 Hydrant Inspection WDEVSTAT Status None  

  WHYCLASS Flow Class   

  WHYDRNT 
Hydrant 
Type 

  

  WHYDWAT 
Water 
Condition 

  

  WHYMK 
Manufacture
r 

  

  WHYVALV Valve Type   

 Meter Changeout None  None  

 Meter Test WDEVSTAT Status None  

  WMETER Sub Type   

  WMTMAKE 
Manufacture
r 

  

 Valve Inspection WDEVSTAT Status None  

  WDIRECT 
Direction to 
Close 

  

  WJOINT Joint Type   

  WPOSIT 
Operation 
Mode 

  

  WVLLEAK Location   

  WVLFUNC Function   

  WVLMAKE 
Manufacture
r 

  

  WVLTYPE Sub Type   



 

Designer 2013 Guide Appendix 2: Cityworks Data Template Fields    299 

Appendix 2: Cityworks Data Template Fields 

Each Cityworks Data Template is listed in the dropdown order with the column headers, field type, number of 

characters, and other information found in the tips for each field to provide at-a-glance information for 
administrators.  

 

ContractorLeaf 

Column Header Field Type Length Null Other Instructions 

ContractorSID    Do not alter/add column values 

ContractorName text 35  Not null  

ContractorNumber text 15 Null  

Description text 50 Null  

RateType   Not null A = Hourly 

B = Fixed 

C = Per Unit 

Rate numeric (8,2) Null  

OvertimeFactor numeric (3,2) Null  

EmergencyFactor numeric (3,2) Null  

OverheadType   Not null A = Hourly 

B = Fixed 

OverheadRate numeric (7,2) Null  

ProviderType    000 = Nome 

001 = Labor Only 

010 = Material Only 

001 = Equipment Only 

011 = Material and Labor 

101 = Equipment and Labor 

110 = Equipment and Material 

111 = All 

Licensed   Null Y or N 

LicenseExpireDate DateTime  Null  

LicensedWork text 250 Null  

Address text 256 Null  

City text 50 Null  

State text 50 Null  
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Zip text 20 Null  

CellPhone text 50 Null  

OfficePhone text 50 Null  

Email text 256 Null  

LocallyBased  
 

Null 1 = true 

0 = false 

Comments text 256 Null 
 

ContactName text 100 Null 
 

Viewable (Visible in Server) 
  

Null 1 = true 

0 = false 

MWBE (Minority/Women 
Owned Business Enterprise) 

  
Null 1 = true 

0 = false 

FederalTaxId text 50 Null 
 

FMSNo text 50 Null 
 

PIN text 50 Null 
 

RegistrationDate Date Time  Null 
 

OtherPhone text 50 Null 
 

Fax text 50 Null 
 

LiabiltiyInsCertificate text 50 Null 
 

LiabilityInsEffectDate DateTime  Null 
 

LiabilityInsExpireDate DateTime  Null 
 

LiabilityInsAmount numeric (12,2) Null 
 

WorkersCompCertificate text 50  Null 
 

WorkersCompEffectDate DateTime  Null 
 

WorkersCompExpireDate DateTime  Null 
 

WorkersCompAmount numeric (12, 2) Null 
 

AutomobileInsCertificate text 50 Null 
 

AutomobileInsEffectDate DateTime  Null 
 

AutomobileInsExpireDate DateTime  Null 
 

AutomobileInsAmount numeric (12,2) Null 
 

GeneralLiabilityCertificate text 50  Null 
 

GeneralLiabilityEffectDate DateTime  Null 
 

GeneralLiabilityExpireDate DateTime  Null 
 

GeneralLiabilityAmount numeric (12, 2) Null 
 

Custom Data Fields    
 

Keywords    Enter a comma-delimited list 

 

Employee 

Column Header Field Type Length Null Other Instructions 

EmployeeSID    Do not alter/add column values 
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EmployeeID text 15   Null Required for new entries 

FirstName text 15 Null  

MiddleInitial text 2 Null  

LastName text 30 Not null Required for new entries 

Title text 40 Null  

Pager text 24 Null  

WorkPhone text 24 Null  

Email text 256 Null  

Login Name text  30 Null  

Hourly Rate numeric (5,2) Null  

OvertimeFactor numeric (3,2) Null  

HolidayFactor numeric (3,2) Null  

OverheadType    Percent, Fixed 

OverheadRate numeric (7,2) Null  

Custom1-5    Retired fields 

OvertimeType    Percent, Fixed 

OvertimeRate numeric (5,2) Null  

HolidayType    Percent, Fixed 

HolidayRate numeric (5,2) Null  

BenefitType    Percent, Fixed 

BenefitRate numeric (5,2) Null  

StandbyType    Percent, Fixed 

StandbyRate numeric (5,2) Null  

ShiftDiffType    Percent, Fixed 

ShiftDiffRate numeric (5,2) Null  

OtherRateType    Percent, Fixed 

OtherRate numeric (5,2) Null  

EmailReq text 1 Null  

DomainID    Select from list 

Organization    Select from list 

DefaultImgPath text 250 Null  

Password    Must use Designer 

IsActive    Y or N 

MapServiceID numeric (10,0) Null  

Custom Data Fields     

 

EquipmentLeaf 

Column Header Field Type Length Null Other Instructions 

EquipmentSID    Do not alter/add column values 
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EquipmentUID text 20   Not null Required for new entries 

Description text 56 Null  

Manufacturer text 20 Null  

Model text 15 Null  

RateType   Not null A = Hourly 

B = Fixed 

UnitCost numeric (7,2) Null  

WarranteeDate DateTime  Null  

Custom1-5    Retired fields 

ForCheckout   Null Y or N 

DefaultImgPath text 250 Null  

Viewable (Visible in Server) 
  

Null 1 = true 

0 = false 

Custom Data Fields      

Keywords    Enter a comma-delimited list 

 

MaterialLeaf 

Column Header Field Type Length Null Other Instructions 

MaterialSID    Do not alter/add column values 

MaterialUID text 20   
Not 
null 

Required for new entries 

PartNumber text 20 Null  

Description text 56 Null  

Manufacturer text 20 Null  

Supplier text 20 Null  

Model text 15 Null  

MinQuanity numeric (5,0) Null  

UnitCost numeric (11,2) Null  

CostType 

  

 A = Weighted Average 

B = Current/User Defined 

LIFO 

FIFO 

Detail text 150 Null  

UnitMeasure    Select from list 

AuditInterval    Select from list 

Custom1-5    Retired fields 

DefaultImgPath text 250 Null  

GDBTableName text 50 Null  

CUCategory    Select from list 

GDBSubtype text 8 Null  

Viewable (Visible in Server)   Null 1 = true 
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0 = false 

Custom Data Fields      

Keywords    Enter a comma-delimited list  

 

ProblemLeaf 

Column Header Field Type Length Null Other Instructions 

ProblemSID    Do not alter/add column values 

ProblemCode text 20   
Not 
null 

Required for new entries 

Description text 50 Null  

Priority    Select from list 

SubmitTo    Select from list 

ProbCategory    Select from list 

Custom1-5    Retired fields 

AutoClose    Y or N 

DomainID    Select from list 

ReqCustFieldCatID    Select from list 

Cancel    Y or N 

DispatchTo    Select from list 

Duration numeric (7,2) Null  

DurationUnit 
  

 H = Hours 

D = Days 

SRPrintTmpt text 50 Null  

Printer text 100 Null  

ForPublicSite   Null True or False 

DefaultProject    Select from list 

OtherSysCodeCWID numeric (10,0) Null  

DefaultProjectSID numeric (10,0) Null  

QAModel text 10 Null  

Keywords    Enter a comma-delimited list 

 

TaskLeaf 

Column Header Field Type Length Null Other Instructions 

TaskSID    Do not alter/add column values 

TextName text 20   
Not 
null 

Required for new entries 

Description text 50 Null  

AssignedTo    Select from list 

Shop    Select from list 
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Duration numeric (4,0) Null  

DomainID    Select from list 

Cancel    Y or N 

AssignedToName    Select from list 

NotifyMM   Null Y or N 

ResponseLabel text 11 Null  

Comments text 250 Null  

Keywords    Enter a comma-delimited list 

 

WOTemplate 

Column Header Field Type Length Null Other Instructions 

WOTemplateID    Do not alter/add column values 

Description text 60   
Not 
null 

 

ApplyToEntity    Select from list 

Priority    Select from list 

CreateDate DateTime  Null  

NumDaysBefore (Printing) numeric (3,0) Null  

MapTemplateName text 250 Null  

WOMapExtent    Must be ‘A’ 

WOMapScale numeric (6,0) Null  

WOOutput 

  

 Print Options 

A: WO Only 

B: Map Only 

C: Both 

WOCategory    Select from list 

AccNum text 20 Null  

Shop    Select from list 

WOPrintTmpt text 50 Null  

WorkMonth 

  

 12 characters of 1’s and 0’s, one 
char. per month 

1 = Work Month 

0 = No Work 

CycleType 

  

 A = Never Repeat 

B = Repeat Once 

C = Repeat on Cycle 

CycleIntervalNum numeric (4,0) Null  

CycleIntervalUnit 

  

 D = Day 

W = Week 

M = Month 

Y = Year 

CycleFrom    Actual Finish Date or Projected 
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Start Date 

DomainID    Select from list 

WOCustFieldCatID    Select from list 

DaysToComplete numeric (5,2) Null  

Cancel    Y or N 

AutoCreateTask    Y or N 

Printer text 100 Null  

Stage 
  

 Actual 

Proposed 

ExpenseType 
  

 Maint (Maintenance) 

CIP (Capital Improvement) 

CycleIncludeWeekends text 1 Null  

DefaultProject    Select from list 

WarrantyDuration numeric (10,0) Null  

WarrantyDurationUnit text 20 Null  

UnitsAccompDesc text 40 Null  

UnitsAccompDescLock text 1 Null  
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Appendix 3: Cityworks Desktop Administrator 

Cityworks Desktop Administrator is a Cityworks form used to manage the connections to the 

geodatabase and the Cityworks database. The geodatabase connection must be set for each computer that 
uses Cityworks and can be accessed by any Cityworks user. However, the Cityworks database connection can 

only be accessed by the Cityworks domain administrator and must be set up per user on the user’s machine.  

1. From the Cityworks menu, select Configuration and then Administrator to open the login 
screen.  

 

2. Log in as the Cityworks domain administrator (or any Cityworks user) to open the Cityworks 

Desktop Administrator form.  

NOTE: Any user may set the Cityworks geodatabase connection (through step 6); however, only the 
Cityworks domain administrator can access the Cityworks database connection information. 

 

3. Click on the Cityworks Geodatabase Connection button to open the Configure Cityworks 

Geodatabase form.  

 

4. Select the radio button option for the Geodatabase Type to use with Cityworks. 

 Access Personal Geodatabase 

 File-based Geodatabase 

 ArcSDE Geodatabase 
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5. Click in the field at the bottom of the form and browse to the desired geodatabase or geodatabase 

connection to load it in the field.  

NOTE: For questions, contact the GIS administrator. 

6. Click the Save Geodatabase Connection button and close the form.  

NOTE: The Save GeoDatabase Connection button is grayed out next time the form is opened until either 
the Geodatabase Type or path is changed as this just needs to be done once per computer unless a 
change is made. 

 

7. Click on the Cityworks Database Connection button to open the Define Cityworks Database 

Connection form for setting up the Cityworks database login configuration.  

NOTE: The Cityworks Database Connection button is only active for the Cityworks domain administrator. 

 

8. Fill in the information to set the Cityworks database connection and logins.  

NOTE: The Define Cityworks Database Connection form is completely blank the first time it is opened. 
Checking some of the boxes activate other fields as shown below. 
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 My database login is different from Cityworks user ID checkbox—Check if the user logs in 

with a different login and password than is used to log in to the Cityworks database. Type in the 

Cityworks User ID and Password and the DB Login and DB Password.  

NOTE: The Cityworks User ID and Password and the DB Login and DB Password is a 1:1 relationship 
so a DB Login cannot be used more than once. 

 

 Database field—Select from the dropdown selection of ODBC data sources which have been 

configured on each computer.  

 Pass Windows User to Database for login (for Windows Authentication only) 

checkbox—Check if using Windows authentication for passwords.  
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 Suppress login dialog checkbox—If there is only one user per computer, the Cityworks login 

screen may be bypassed. Suppressing the dialog box activates the checkbox for Access 
GeoDatabase from Standalone and Designer.  

NOTE: Suppressing the login dialog box only allows access to one Cityworks database. However, users 
cannot access the functionality on the login screen, such as changing the Cityworks database, viewing the 
Version Information which may be helpful during troubleshooting, or accessing the geodatabase when 
logging in to Cityworks Standalone or Designer.   
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 Access Geodatabase from Standalone and Designer—Check this box if the Suppress 

login dialog is being used but the geodatabase needs to be accessed from Standalone (for 

searching the asset inventory) or Designer (to use the Asset Setup functionality).  

 I have an ArcGIS License checkbox—Check on each computer that is running Cityworks with 

ArcGIS Desktop or ArcGIS Engine. When checked, Cityworks utilizes the existing license for any 

ArcGIS application running on that computer which has already been checked out from the 
license manager. If the box is not checked, a new ArcGIS license is checked out.  

9. Click the Test Login button at the bottom of the form to verify that the ID and password work for 

logging into the Cityworks database.  

 

A message box confirms if the login was successful. Click OK to close the message. 

If the login is unsuccessful, a message box opens to tell the user that the login to the Cityworks database 

failed. Click OK and reconfigure the settings until the login is successful. 

10. Optional for computers running DataPump: Select the Remote Database created to use out in the 

field with DataPump from the dropdown selection of available databases.  

 

The box for Suppress DSN choices for DataPump login may be checked to prevent the user from 

changing the databases on the DataPump login screen. If the box is unchecked, both database fields will be 
available to the user. 

 

11. Click OK to close out of the Define Cityworks Database Connection form.  
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Glossary of Terms 

.mxd 

The file extension used for a GIS project file or ArcMap document. A map document can be printed or utilized 

by other software programs, such as in Cityworks Anywhere. 

access rights 

Privileges or permission for user groups to view, add, update, delete, and view cost for request and work 

order templates to provide security to Cityworks.  

add-on 

A separate application designed to complement another product with which it integrates or shares common 

data by giving it additional capabilities. It works in conjunction with a primary software application and has 
no value without it. 

address locator 

A dataset in ArcGIS for storing the address, attributes, associated indexes, and rules that define the process 
for translating nonspatial descriptions of places, like street addresses, into spatial data that can be displayed 

as features on a map. It contains the reference data used for geocoding and parameters for standardizing 
addresses, searching for match locations, and creating the output. Address locator files have a .loc extension 

and the file must be loaded into the .mxd for geocoding to work in ArcMap. 

API  

An application programming interface is a set of calling conventions, functions, or procedures by which an 

application program accesses the operating system and other services. An API is defined at the source code 

level to ensure the portability of the code between the application and other privileged utilities. An API can 
also provide an interface between a high-level language and lower-level utilities and services written without 

consideration for the calling conventions supported by compiled languages. The API’s main task in that case 
is to translate parameter lists from one format to another and interpret the call-by-value and call-by-

reference arguments in one or both directions. 

application 

A software program or group of programs that can run independently to help a user carry out a task, such as 

word processors, spreadsheets, database management systems, Cityworks, etc. 

ArcCatalog 

Esri’s GIS desktop application for managing spatial data, organizing geographic data, recording/viewing 

metadata (data about data), creating geodatabases to store feature datasets and feature classes, creating 
address locators, and distributing GIS data to an existing map in ArcMap. 
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ArcEditor 

An Esri license for ArcMap that contains all the functionality of ArcView plus advanced editing capabilities to 

update attributes in the geodatabase. ArcMap utilizes CAD editing tools that can construct features quickly 
and easily while maintaining the spatial integrity of the geodatabase. 

ArcGIS 

Esri’s integrated collection of GIS software products for building a complete GIS. Their three desktop 
applications consist of ArcCatalog, ArcMap, and ArcToolbox (for geoprocessing). 

ArcInfo 

An Esri license designed for advanced GIS users which adds advanced geoprocessing functionality to the 
ArcEditor capabilities. 

ArcMap 

Esri’s ArcGIS desktop application for composing and publishing professional maps as well as creating, 
viewing, editing, querying, and analyzing geographic data and associated tables. ArcMap is used for all 

mapping, editing tasks, and map-based analysis (which places tabular data on the map in hopes it will reveal 
spatial patterns, relationships, or trends). Esri has three levels of licensing for ArcMap: ArcView, ArcEditor, 

and ArcInfo. 

ArcSDE 

A gateway to a commercial RDBMS which serves as an open, high-performance spatial data server that 

employs client/server architecture to perform efficient operations and manage large amounts of shared 

geographic data. 

ArcView 

An Esri read-only license for ArcMap which provides comprehensive mapping and analysis tools with some 

simple editing and geoprocessing tools. 

assembly 

A material assembled from multiple materials which groups the required parts and can include the associated 

labor and equipment costs for use in Miner & Miner’s Designer application.  

asset group 

A collection of specific groups of features and related objects in ArcGIS and Cityworks. 

assets 

Property or inventory stored in the geodatabase as features or related objects that have associated 

maintenance activities. 
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attribute 

A characteristic or quality of an object, such as its name, measure, or identifier. An attribute is stored as a 

column or field in a database. 

attribute domain 

A valid value table that stores available characteristics, qualities, or numeric ranges for an object; e.g., 

measurement, count, classification, category, condition, type, or other identifier. 

call-level interface 

A programming interface designed to support SQL access to databases from off-the-shelf application 

programs with a set of client-server tools that can easily access databases through dynamic link libraries 
(DLL).  

CCTV 

Closed-circuit television; a CCTV system uses a special remote-controlled camera to videotape systems that 
are too small or too dangerous for people to get into, including stormwater/wastewater/water systems, 

treatment plants, electrical conduit, etc. The condition can then be assessed by viewing the video.  

CCTV Interface for PACP 

A Cityworks add-on product that exports Cityworks work order data to a blank PACP exchange database to 

populate the pipe segment IDs and other mapped fields to any third-party database to perform a TV 
inspection. The TV inspection data is then imported into the Cityworks TV Inspection form associated to the 

work orders. 

checkbox 

A square box which clicks on/off as indicated by a checkmark. Any or all options may be selected. 

Cityworks 

A GIS-centric, location-based software application for creating service requests and work orders and tracking 
maintenance history. This AMS (Asset Management Solution) is configurable for any geodatabase asset model 

and can be used for managing infrastructure for public works and utilitieswater, wastewater, stormwater, 

electric, streets, traffic, plants, etc. 

Cityworks database administrator 

The person in charge of establishing and maintaining the Cityworks database structure and creating the 
domains. 
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Cityworks Designer 

A Cityworks database administrative tool for configuring and customizing Cityworks. This application allows 

the Cityworks database administrator and Cityworks domain administrators to set up domains, materials, 
equipment, employees, user groups and rights, request and work order templates, tasks, custom inspections, 

preferences, and security. 

Cityworks domain administrator 

The person responsible for the majority of the Cityworks configuration and overseeing a domain with full 

access rights to requests and work orders.  

Cityworks Server AMS 

A state-of-the-art, browser-based asset management solution which has been built on Esri’s ArcGIS Server 

technology which allows a high level of customization capabilities and the ability to support loose coupling to 
other systems. Users need a browser (Azteca uses and recommends Firefox) and Microsoft Word Viewer 

installed on their computers. Generally, at least two servers are required: one for the web, ArcGIS, and 

Cityworks and another server for the ArcGIS geodatabase and the Cityworks work management data. Three 
different deployment options are available: full, service requests only, or read-only. In November 2010, the 

name was changed from Cityworks Server MMS (Maintenance Management System) to Cityworks Server AMS 
(Asset Management Solution) to reflect its nature as a true asset management solution. [NOTE: Azteca 
recommends that users employ the Firefox browser when using Server because it has adhered to the W3C 
(World Wide Web Consortium) guidelines. The use of another browser will cause the Server to render more 
slowly and images may be lost.] 

Cityworks Server PLL (Permits, Licensing, and Land) 

A GIS-centric community development software that is fully integrated with Cityworks Server AMS, allowing 
permit, license, and land data to be viewed in the same environment as the GIS asset data, work orders, 

and/or service requests. It enables agencies to track permits, planning and development applications, 
engineering construction processes, business licenses, code enforcement cases, and land development work, 

from initiation to closure. The built-in workflow engine efficiently tracks all applicable tasks, beginning with 

the initial application or customer call through the complete process of departmental plan reviews, planning 
commission meetings, issuance, inspections, signoffs, abatement, hearings, applications, renewals, fee 

calculations, payments, tasks, and more. It can track land, such as parcels, street segments, or any land 
object, along with the associated data, or cases which store transaction data for permits, applications, and/or 

code enforcement processes.  

class 

A set of similar objects where each object has the same set of attributes. A class is stored as a table which 

consists of a matrix of rows that represent objects and columns that represent attributes. 

data 

A collection of related facts usually arranged in a particular format and gathered for a particular purpose. 
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data model 

A representation of something in the real world. 

database 

A logical data model constructed to represent the objects of interest through the use of related tables for 
data entry and transfer to a computer application. 

DataPump 

A check-out system for Cityworks which saves service requests and/or work orders and related inspections to 
a SLQ Server 2005 Express database on a PC notebook for field access and updating. Checked-out items can 

still be viewed by any Cityworks user but can only be updated by the user who has checked them out. The 
central database is updated at check-in. DataPump is designed for users who don't have a wireless WAN 

(wide-area network). 

dataset 

A named collection of logically-related data items arranged in a prescribed manner. 

delimiter 

A symbol or character used to separate or indicate the beginning or end of data items, character strings, 
words, or fields in a database, source code, or text file. A blank space, comma, tab, semicolon, or other 

symbol may serve as a delimiter.  

device 

A term in ArcView 3x for related object. 

Dig-Smart 

A software program that uses Esri’s ArcGIS to provide an all-encompassing, geospatial solution for one-call 
ticket management to service all public and private sector utilities with a call-before-you-dig requirement. The 

core product, Dig-Smart Enterprise, was developed to help utilities manage their daily excavation requests. 
Dig-Smart, LCC (Limited Liability Corporation), is NASGC-certified. Cityworks provides a Dig-Smart Interface 

which generates requests for underground pipe and cable locating. See their website for more information at 

www.dig-smart.com.  

DLL 

Dynamic Link Library; a collection of executable functions or data used by a Windows application to provide 

one or more particular functions which are accessible through either a static link (remains constant during the 
program’s execution) or dynamic link (created by the program as needed).  

 

[NOTE: DLL files usually end with these extensions. 
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• .dll—Dynamic Link Library (Windows 3.x – OS/2) 

• .exe—directly executable program (DOS) 

• .drv—device driver, such as for a printer 

• .fon—font file (Windows 3.x font library)] 

domain 

A distinctive group with shared work activities and resources, such as a department or multiple departments. 

Cityworks uses domains to set up its work management system and security.  

end user 

A user who runs an application program. In Cityworks, an end user has access to the Cityworks work 

management system as defined by the group rights specified in Designer. 

entity 

In Cityworks, entity is considered the same as an asset.  

Equipment Manager 

A Cityworks add-on product for checking out, returning, reserving, and tracking equipment as well as keeping 

a history of equipment and employee usage. 

Esri 

Environmental Systems Research Institute, Inc.; a company established as a consulting firm specializing in 

land use analysis projects and currently is the largest worldwide research and development organization 

dedicated to designing software and developing GIS technology. For more information, see their website at 
www.Esri.com. 

export 

To take data out of one application in a format that can be used in another application. 

extension 

A program which extends an application by increasing its functionality and broadening its capabilities, such as 

when Cityworks Desktop is used in conjunction with ArcMap. Extension can also refer to a file extension 
which is a short character suffix following the period (dot) after the filename or root name indicating the type 

of information stored in the file.  

 

Examples of file extensions include: 
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 .com indicating it is a command file 

 .exe for an executable program 

 .mxd for an ArcMap document or GIS project file  

 .txt for a text file 

 .doc or .docx for a Microsoft Word document file 

 .xls or .xlsx for a Microsoft Excel file 

 .jpg for a JPEG (Joint Photographic Experts Group) image 

 .tif for a tagged image file 

 .bmp for a Windows Bitmap image 

feature 

A discrete object on a map that has geometric shape (point, line, or polygon); a spatial object that can exist 

above or below ground and typically remains in one location during its lifespan, such as a mainline, manhole, 

or pump station. 

feature class 

A database table for storing spatial objects that uses a geometry field to keep the shape (point, line, area, or 

annotation) and location of the features. A feature class may have subtypes and attribute rules. An object 
class becomes a feature class when the geometry is added.  

feature dataset 

A collection of feature classes that shares the same spatial reference which enables them to participate in 

topological relationships, such as geometric network, linear network, or topology. 

FIFO 

A cost type for use in the Cityworks Storeroom add-on which utilizes the “first in, first out” inventory method 

of using the older unit costs first for parts distributed until the older inventory is gone and then uses the 

newer unit costs for the newer inventory. 

geocoding 

The process of creating geometric representations for locations of point data from descriptions of locations, 

such as addresses, intersections, x-y coordinates, etc. 
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geodatabase 

A geographic database hosted inside an RDBMS for managing geographic data. This collection of complex 

geographic data includes spatial, topological, and attribute information for a set of objects and features with 
their relationships which allows for geographic data storage, referential integrity constraints, map display, 

feature editing, and analysis functions.  

 

A geodatabase contains:  

 

 feature classes 

 feature datasets 

 object classes 

 relationship classes 

 attribute domains 

geoprocessing 

An operation which is performed on an input dataset to return the result as an output dataset which defines, 
manages, analyzes, and manipulates the information stored in a GIS for formulating decisions. Geographic 

feature overlay, feature selection and analysis, topology processing, and data conversion are common 
geoprocessing operations. 

GIS 

Geographic Information System; a data system which collects, processes, stores, manages, retrieves, 
analyzes, manipulates, displays, and reports spatial data for phenomena on, above, or below the earth’s 

surface. GIS links information or data to a geographic location. 

GIS workspace 

An Esri ArcGIS programming object created by the software which is used to open the connection to the 

geodatabase when Designer accesses the geodatabase. 

hierarchy 

A data structure for storing information in folders and subfolders; similar to an electronic filing system. 

Cityworks uses tree and hierarchy interchangeably in the software, even though hierarchy generally implies 

ranks or graded elements. These structures are user-defined and elements may be placed in multiple 
locations or groups to facilitate data entry for the end user. 
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import 

To bring in data from an existing file which was produced by another application. Importing data is important 

in software applications because it allows one application to complement another application and reduces the 
need for additional data entry.  

initialize 

Process of starting up or opening a program where all of the general settings and forms needed are loaded. 

interface 

A link which passes data between two databases or programs by changing data in one format to what the 

other system requires. There is no communication between the actual applications. 

keyword 

A reference point for finding information. In Cityworks, a user-defined word or abbreviation end users can 

enter to access information. Keywords can be set up for request templates, tasks, employee groups, 
contractors, materials, equipment, etc. 

LIFO 

A cost type for use in the Cityworks Storeroom add-on which utilizes the “last in, first out” inventory method 
of using the most recent costs first when distributing parts until the newer inventory is gone and then uses 

the older unit costs when the older inventory is distributed. 

login 

A user name and password typed into a network environment to allow the user to execute or access the 

program and thereby protect against its unauthorized use. 

macro 

A series of commands, actions, or keystrokes that perform a whole series of actions. A macro is executed in 

the same order each time it is run. Cityworks uses macros for its print and email templates. The macro 
variable points to another variable where the data is actually stored. 

NASSCO 

National Association of Sewer Service Companies established as a not-for-profit trade association by a small 
number of sewer service contractors who recognized the benefits of establishing industry standards for the 

pipeline rehabilitation industry. They are the leading resource for specification guidelines, industry practices, 

inspector training, and new technology know-how for sewer system rehabilitation. See their website at 
www.nassco.org for more information. 
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network 

A collection of computers and other devices that have been connected to share data, hardware, and software 

which requires a login to protect against unauthorized users. 

object 

A basic element representing an entity, such as a building, river, tree, sign, or customer. An object is stored 

in a row in an object class within the database. 

object class 

A collection of objects in the geodatabase that have the same behavior and the same set of attributes. All 

objects in the geodatabase are stored in object classes. A table in the database for an object becomes an 
object class when geodatabase intelligence is added to it, such as an object ID or class ID. 

ODBC 

Open Database Connectivity; serves as a standard software API method for accessing different database 
systems by providing an interface between an application which submits statements to ODBC which then 

translates these statements to what the database understands, independent of programming language, 
database system, or operating system. ODBC is based on call-level interface with interfaces for Visual Basic, 

Visual C++, and SQL and drivers for Access, Paradox, dBase, Text, Excel, and Btrieve databases.  

PACP 

Pipe Assessment and Certification Program implemented by NASSCO to standardize sewer pipe condition. 

Because of the standard PACP format which defines fields, formatting, and valid entries, Cityworks CCTV 

Interface for PACP can be used to create the PACP database for exchanging information between the two 
systems. 

program 

A set of variables and detailed, step-by-step instructions that tells a computer how to use the variables to 
solve a problem or carry out a task. 

radio button 

A round option button which allows only one selection to be made for the group. 

RDBMS 

Relational Database Management System, such as SQL Server or Oracle; a database management system 

with the ability to access data organized in tabular files that can be related to each other by a common field. 
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related object 

An object from an object class not usually displayed on a map but related to a mapped feature at some n-

level in the geodatabase. A related object is associated with a feature through a relationship class defining 
which related objects belong to the feature, such as a pump station (feature) containing pumps, motors, and 

valves (the related objects). Related objects may move to different locations in the network during their 
lifespan but their maintenance history can be tracked through Cityworks. Related objects are stored as 

tabular entries with no graphic representation. Cityworks requires that an object is related to a feature at 

some n-level. ArcView 3x uses the term device for related object. 

relationship 

An association or link between two or more objects in a geodatabase, such as features in feature classes or a 

feature with its related objects. Relationships are stored as rows in a table or as a foreign key field in the 
dependent object class. 

relationship class 

A table that stores relationships or dependencies between features or objects in two feature classes or tables. 

role 

A classification for user groups assigned in the database to control access to the resources based on the 

predefined access rights for the group. Each user is assigned to one or more roles and each role is assigned 
to one or more privileges. A role provides the ability to give database rights to multiple users by including 

them in the role. All Cityworks users must have the Create View right, which is provided by adding them to 
the PWDB_USER role.  

SDE 

Spatial Database Engine; provides an enterprise-wide repository for spatial and attribute data within the 
RDBMS. Its client/server architecture and built-in spatial analysis and query tools allow efficient access, 

management, storage, and distribution of spatial and attribute data throughout a network. See Esri’s website 

at www.Esri.com for more information. 

SID 

A system-generated ID field (numeric field of up to 10 characters) in Cityworks used for identifying 

employees, contractors, request problems, work order tasks, permits, projects, materials, equipment, assets, 
and entities. The SID fields are frequently used as links between the various Cityworks tables. 

software 

A set of statements or instructions and associated data used directly or indirectly by a computer that specifies 
how to process data and accomplish a task. Computer software may include more than one computer 

program. 
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SQL 

Structured Query Language; provides basic syntax constructs for defining and manipulating tables of data for 

creating, updating, and querying RDBMS. 

Storeroom 

A Cityworks add-on product for tracking materials and managing multiple storeroom locations, including work 

vehicles. It handles functions from requisitioning to distributing materials and performing audits with special 
search capabilities to help maintain the desired stock on hand. 

superuser 

A login for Cityworks Designer with access to both the Cityworks database administrator and domain 
administrator functions. However, since a superuser cannot be a member of any domain group, this login 

cannot access the Cityworks work management system (as an end user must belong to a group with 
specified rights). 

table 

A set of non-spatial data elements that has a horizontal dimension (rows) and a vertical dimension (columns) 
in an RDBMS (database). A table has a specified number of columns but can have any number of rows. In 

ArcGIS, table often refers to an object class without geometric shape; a row in the table is referred to as a 

related object or asset. 

task 

A definite and specific act of work. Tasks in Cityworks are set up by the organization outlining the steps that 

must be followed to complete a work activity and track related costs. 

template 

An electronic file predesigned to generate the desired information including the location and length of fields 

to display that link to data that can be filled in and used to generate forms for printing or emailing. Cityworks 
uses templates to print service requests and work orders as well as email callers and employees. Default 

templates are available or custom forms may be created and used as long as they are stored in the 
Templates file of the Cityworks directory. Template is also used in Cityworks Designer to refer to the 

predefined settings for each type of request or work order. 

topology 

Relationships between connected features in a geometric network or shared borders between features. 

tree 

A data structure for organizing computer storage where the elements are interconnected and the trunk 
represents the root directory, branches are folders and may be split into smaller branches or subfolders, and 
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leaves represent the individual files or parts. While it differs from a hierarchy because its organization lacks 

ranks or graded elements, the terms are used interchangeably in Cityworks. 

UID 

A user-defined ID field (a variable character field of 17, 20, 35, or 40 characters) used in Cityworks to identify 

entities, devices, materials, equipment, suppliers, and sections. The UID can also be used as a field for linking 
Cityworks tables. 

URL 

Uniform Resource Locator provides the global address of documents or other resources on the web. 
Attachments in Cityworks may be loaded with paths to websites or documents on a local network. 

user 

Any individual who uses a computer. In the database, a user is assigned to a role or multiple roles which 
allows the user’s login to access the information and use the software. 

weighted average 

A cost type for use in the Cityworks Storeroom add-on which totals all the costs for the selected material 
divided by the number of units on hand to calculate the cost of an item. 
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CW database before gdb sync 178 

blue text (CW data template) 256 
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branch (Q/A model) 55, 137, 140, 217 

branch Q/A model (request) 137 

budget plan tab 91 
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build tree 14 
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call taker questions 60 

cancel 
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task 132 
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